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User's Guide

I n d 1 gO terminal emulator

Indigo Terminal Emulator is the premier terminal emulation software for the Windows platform. Indigo Terminal
Emulator is a powerful terminal based communication software for telnet and serial terminal communications. Indigo
offers many tools and features that are unmatched in other terminal software solutions. These features include the
ability to display received data in multiple byte representation formats such as ASCIl, DECIMAL, HEXADECIMAL,
OCTAL, BINARY, or a user defined custom format. Indigo supports VT100 and Linux terminal emulation protocols
as well as a raw data view for non-terminal emulation connections. Indigo supports scripting and simultaneous
connected terminal sessions. Indigo is a complete replacement for TELNET and HYPERTERM ®. Please visit the
features page for more details on what Indigo has to offer.

Related Weblinks

shadeBlue WebLinks Indigo Weblinks

® shadeBlue Website * |ndigo Download Page
® shadeBlue Helpdesk Portal ® |ndigo Product Page

® shadeBlue Bug Tracker Portal ® |ndigo Purchase Page
® Frequently Asked Questions ® |ndigo Release Notes

Table of Contents

Getting Started

This section describes the minimum hardware requirements, lists the supported operating systems, and
guides the user through the installation and licensing activation of Indigo Terminal Emulator.

Please select from one of the following help topics:

Version & Edition Comparison


http://www.shadeblue.com
http://support.shadeblue.com
http://bugs.shadeblue.com
http://faq.shadeblue.com
http://www.shadeblue.com/indigo-download
http://www.shadeblue.com/indigo
http://www.shadeblue.com/indigo-buy
http://download.shadeblue.com/indigo/beta/readme.txt

This section provides a comparison between the Standard and Professional editions of Indigo Terminal
Emulator.

Indigo V3 Professional Edition provide the following primary feature sets in addition to all the features offered in the
Standard Edition.

Support for TCP Server (Listener Socket)

Support for UDP Connections (Listener and Sender)
Support for Modem Dial-Up Connections

Support for Serial File Transfer Protocols

Support for Hi-Speed Serial Communication

The tables below will provide an in-depth feature-by-feature comparison between versions/editions of Indigo
Terminal Emulator.

TCP Communication Features

UDP Communication Features

Serial Communication Features

Telephone / Modem Communication Features
Terminal Emulation Protocols

Serial File Transfer Protocols

Data Conversion Formats

Data Display Modes

TCP Communication Features

Feature Indigo Version 2 Indigo V3 Standard Indigo V3 Professional
RAW-TCP-Client
RAW-TCP-Server (Listen
er)

Telnet
SSH Auto
SSH 1
SSH 2
SSH Username/Password
Authentication

SSH Private Key Authenti

cation



SSH Fingerprint
Validation & Caching

UDP Communication Features

Feature

RAW-UDP (Listener &
Sender)

Indigo Version 2

Serial Communication Features

Feature

Serial RS-232

Serial RS-422

Serial RS-485

Support for COM Ports
above 16

Auto-detect available
COM Ports

User-defined COM Ports

Refresh available COM
Ports

Support for Baud Rates
up to 115,200

Support for Baud Rates
up to 921,600

User-defined custom
BAUD Rates

Support for Built-in COM
ports

Support for Bluetooth
serial ports

Indigo Version 2

Indigo V3 Standard

Indigo V3 Standard

Indigo V3 Professional

Indigo V3 Professional

< R < R < I <.

<]



Support for Virtual COM L
ports

Support for USB COM 1
ports
Support for PCMCIA COM 1
ports
Support for Serial Port

Expansion Cards
(ISA, PCI, PCI-Express)

Support for Muliserial
Boards

( 1 Limited Support)

Telephone / Modem Communication Features

Feature Indigo Version 2 Indigo V3 Standard Indigo V3 Professional
Support for modem

dial-Up

Support for Hayes

compatible modem

Support for TAPI
compatible modem

Support for USB modem

Support for GSM/GPRS

modem

Terminal Emulation Protocols

Feature Indigo Version 2 Indigo V3 Standard Indigo V3 Professional
ANSI

VT100

Linux




Serial File Transfer Protocols

Feature

ASCII

X-Modem

X-Modem 1K

X-Modem/CRC

Y-Modem

Y-Modem-Batch

Y-Modem-Batch-G

Z-Modem

Z-Modem/Save

Kermit

Data Conversion Formats

Feature

ASCII

ASCII with Control Codes

Hexadecimal

Hexadecimal with Control
Codes

Mixed ASCII &
Hexadecimal

Decimal

Octal

Binary

Byte Analysis

Indigo Version 2

Indigo Version 2

v

(< N < N < I <

<]

(< R < N < B <.

v

Indigo V3 Standard

Indigo V3 Standard

v

(< N < N < I <

<]

(< R < N < B <.

v

Indigo V3 Professional

(< [N < I < N < I < B <.

8B a3

(< <]

Indigo V3 Professional

(< N < I < B <

(<]

(< R < I < I <.



User-Defined Custom
Format

Data Display Modes

Feature Indigo Version 2 Indigo V3 Standard Indigo V3 Professional

Terminal Emulation Mode
(Direct)

Raw-Data Mode
(Standard)

© Pricing

Pricing information can be found here: http://www.shadeblue.com/indigo-buy

System Requirements

This section describes the minimum hardware/system requirements. Please review these requirements
to ensure that your target system meets the minimum set.

® Standard Edition
* Professional Edition

Standard Edition

Minimum hardware requirements:

® 1 GHz Processor (Intel/AMD x86/x64)
® 50 MB Available Hard Drive Space
®* 1 GB RAM (Memory)

Optional hardware for TCP/IP and UDP communication

®* Network Interface Card

Optional hardware for serial communication:

Built-In (Embedded) Serial Port

USB Serial Port Adapter

Bluetooth Serial Port Adapter

Serial Port Expansion Cards (ISA/PCI/PCI-Express)
Terminal Server Serial Ports (RDP)

Virtual Serial Ports

PCMCIA Serial Ports

Serial Signaling / Wiring Standards:
* RS-232


http://www.shadeblue.com/indigo-buy

Professional Edition

Minimum hardware requirements:

® 1 GHz Processor (Intel/AMD x86/x64)
® 50 MB Available Hard Drive Space
®* 1 GB RAM (Memory)

Optional hardware for TCP/IP and UDP communication

® Network Interface Card

Optional hardware for serial communication:

Built-In (Embedded) Serial Port

USB Serial Port Adapter

Bluetooth Serial Port Adapter

Serial Port Expansion Cards (ISA/PCI/PCI-Express)
Terminal Server Serial Ports (RDP)

Virtual Serial Ports

PCMCIA Serial Ports

Serial Signaling / Wiring Standards:

* RS-232
® RS-422
®* RS-485

Optional hardware for modem communication:

® TAPI Compatible Modem
® Hayes Compatible Modem

Operating System Compatibility

This section describes the supported operating systems. Please review this list to ensure that your target
system is running one of the supported operating systems.

® Desktop Operating Systems
® Server Operating Systems

Desktop Operating Systems

®* Windows XP Home Edition
® Windows XP Professional Edition

Windows Vista Home Basic Edition
Windows Vista Home Premium Edition
Windows Vista Business Edition
Windows Vista Ultimate Edition

Windows 7 Starter Edition

® Windows 7 Home Premium Edition
® Windows 7 Professional Edition

®* Windows 7 Ultimate Edition



0 Note

Indigo is known to be working on older versions of Windows desktop operating systems including
Windows 98, Windows 2000 workstation; however these operating systems are not longer
officially supported or tested for compatibility.

Windows 8 Support

We are actively testing Indigo Terminal Emulator - Version 3 with Windows 8 Beta - Consumer
Preview Edition and plan on having full support available with the launch of Windows 8 which is
expected later this year.

Server Operating Systems

Windows 2003 Server Web Edition
Windows 2003 Server Standard Edition
Windows 2003 Server Enterprise Edition
Windows 2003 Server Datacenter Edition
Windows Small Business Server 2003

Windows 2008 Server Web Edition
Windows 2008 Server Standard Edition
Windows 2008 Server Enterprise Edition
Windows 2008 Server Datacenter Edition
Windows Small Business Server 2008

O Note

Indigo is known to be working on older versions of Windows server operating systems including
Windows 2000 server; however these operating systems are not longer officially supported or
tested for compatibility.

Installation

This section describes the installation and uninstall procedures for Indigo Terminal Emulator. .

Download Indigo Installer

Install Indigo
Uninstall Indigo
Command Line ArgumentsAdvanced Installation Information

Download Indigo Installer

If you have not already done so, please download the Indigo Installer from the shadeBlue website:

wl

Download Indigo Terminal Emulator

Install Indigo



http://www.shadeblue.com/indigo-download

© Screencast

A screencast of the installation procedure is available. Click here to see the video.

Indigo Terminal Emulator is packaged into an easy to use Windows Installer (MSI).
After downloading the installer file (Indigolnstall.msi) double-click the file to launch the Windows Installer.

The first dialog displayed is the Welcome screen.
Here you can verify the installation version in the title bar and click Next to continue.

rﬁ! Indigo Terminal Emulat@ E“E”El

Welcome to the Indigo Terminal

The version to be Emulator Setup Wizard
installed is always

dipslayed in the

setup title bar.

The Setup Wizard will install Indigo Terminal Emulator on your
computer. Click Next to continue or Cancel to exit the Setup
Wizard.

Next the End-User License Agreement dialog is displayed.

Please read this agreement carefully and if you agree and wish to proceed with the installation, you will need to
confirm by checking the | accept the terms in the License Agreement check box.

After confirming the agreement, click Next to continue.



rﬁ! Indigo Terminal Emulater (3.0.135) = B |3

End-User License Agreement
Please read the following license agreement carefully shadeBlue

a6 ftwarae

m | »

[¥]1 accept the terms in the License Agreement

Print ] [ Back ]I Mext I [ Cancel

Next the installation destination dialog is displayed.
It is recommended to leave the default path defined here; however if you wish, you can click the Change button to

define an alternate installation directory.
After selecting the desired installation directory, click Next to continue.

44 Indigo Terminal Emulator (3.0.135) = = &]ﬂ

Destination Folder
Click Mext to install to the default folder or dick Change to choose another. shadeBlue
o T

T W B Fr @

Install Indigo Terminal Emulator to:

rred
IC:\ngram Files (x56)\shadeBlue\Indign’, ﬁ;‘;?lt;:i:::ep ath

Back ][ Mext ] [ Cancel

Next the installation ready confirmation dialog is displayed.



At this point the Windows Installer has collected all the necessary information and is ready to begin installing files on
the system.
Click the Install button to begin installing Indigo on the file system.

ﬁ Indige Terminal Emulator (3.0.135)

Ready to install Indigo Terminal Emulator

Click Install to begin the installation. Click Back to review or change any of your
installation settings. Clidk Cancel to exit the wizard.

J [ Cancel

While Indigo is installing a status dialog is displayed to illustrate the installation steps and progress.
Please wait until the installation is complete.

-

ﬁ Indige Terminal Emulator (3.0135)

o] = s
Installing Indigo Terminal Emulator :D
shadeBlue

Flease wait while the Setup Wizard installs Indigo Terminal Emulator,

Status: Starting services




When the installation is complete and Indigo is ready to use the completed dialog will be displayed.

In the bottom corner there is a check box option that you can enable if you want to automatically launch the Indigo
Terminal Emulator software when this dialog is closed.

Click the Finish button to complete the installation and close this final dialog.

13! Indige Terminal Emulator (2.0.135) o @ ([

Completed the Indigo Terminal Emulator
Setup Wizard

Click the Finish button to exit the Setup Wizard.

Uninstall Indigo

If you wish to uninstall Indigo Terminal Emulator from your system, please to to the Windows Control Panel and
select the following applet:

®* Add Remove Programs (Windows XP / 2003)
® Programs & Features (Windows Vista / 7 / 2008)

Once the programs listing is loaded, you can search for "Indigo Terminal Emulator” in the list and use the Uninstall
option to remove the program.

Note

Indigo will remove all of the program files from the file system but it will not remove any data files.
Data files include: program preferences, terminal sessions, macros files, script files, library files,
custom data formats, etc.

If you want to remove all data files you will need to manually delete the Indigo data directory.
More information on the data directory can be found here: Indigo Data Directory

Command Line ArgumentsAdvanced Installation Information

Indigo is packaged with a Windows Installer and there are a number of command line options that can be used to
perform more advanced installations.

To see a list of command line arguments, from the system shell console, enter the following command:



.....................................................................................................................................................................................

The following dialog will be displayed listing all the Windows Installer command line arguments and their usage.

-

Windows Installer @

Windows @ Installer. V 5.0.7600.16385 -

msiexec /Option <Required Parameter: [Optional Parameter]

m

Install Options
</package | /iz <Product msiz
Installs or corfigures a product
/a «Product . msix
Administrative install - Installs a product on the netw
Aj=ulm <Product. msi [/ <Transform List>] [/g <Language |D
Advertises a product - m to all users, u to cument use
</uninstall | A <Product msi | ProductCode:-
IUninstalls the product

Diisplay Options
Jquiet
Quiet mode, no user interaction
/passive
IUnattended mode - progress bar only
fqinbirf]
Sets uger imtedface level
n - Mo LI
b - Basic L
r- Reduced Ul
1 ] 3

- —

Windows Installer command line options are also listed on this web page:
http://msdn.microsoft.com/en-us/library/aa367988(v=vs.85).aspx

Silent Installation

If you wish to perform a silent installation of Indigo Terminal Emulator using all the default installation options you
can use the following command line on the system shell console.
A silent installation will solicit any user input and will not display any dialogues or progress to the user.

.....................................................................................................................................................................................

Passive Installation

Another "near" silent method is to use the passive installation option.
Passive mode will display an installation progress bar but will not solicit the user for any input.


http://msdn.microsoft.com/en-us/library/aa367988(v=vs.85).aspx

.....................................................................................................................................................................................
1

nei exec / package "I ndi golnstall. nsi
/ passi ve

-

Indige Terminal Emulator

| Please wait whils Windows configures Indigo Temninal Emulator

Time remaining: 10 seconds

Administrative Installation

The Windows Installer supports a network based installation option known as Administrative Installation.
More information about administrative installations can be found here:
http://msdn.microsoft.com/en-us/library/aa367541(v=vs.85).aspx

The following command line will perform the administrative installation.

.....................................................................................................................................................................................

nsi exec /a "Indigolnstall. nsi

Licensing

This section describes the licensing terms for Indigo Terminal Emulator and the licensing
activation/registration and transfer procedures.

® Licensing Terms
® | icense Registration / Activation

® QOption 1: Online Registration
® QOption 2: Manual Registration

Licensing Terms


http://msdn.microsoft.com/en-us/library/aa367541(v=vs.85).aspx
http://msdn.microsoft.com/en-us/library/aa367541(v=vs.85).aspx

Indigo Terminal Emulator is licensed to each computer it is installed on.

A single license may only be installed on a single computer.
License transfer is available for hardware replacement and/or system upgrades.

License Registration / Activation

© Screencast

A screencast of the licensing and activation procedure is available. Click here to see the video.

A quick and easy online registration method is included in Indigo.
Upon purchasing Indigo, an email will be automatically sent that includes a license key.
Once licensed, Indigo will provide full functionality and web update capabilities.

Indigo provides two options for activating your license:

® Online Registration
® Manual Registration

Option 1: Online Registration

The easiest method is to use the online registration with license key option.
When prompted, select the first licensing option:
"Activate software license with license key"

Indigo Terminal Emulator
Version 3.0.145 (BETA)

shadeBlue shadeBlue, LLC,

s o ft ware Copyright © shadeBlue, LLC 2011
Register:
How would vou like to register your Indigo license?

{* Activate software license with license key
This license key is provided at time of purchase.
(reguires Internet connection)

(" Enter manual license activation code

Ise this option if you have obtained a license
activation code from shadeBlue Support.

Exit

hitp.diw wewe . shadeblue.com

Press Continue to proceed.

Next, enter the email address used when purchasing the license, the provided license key, and optionally a
company name.



Indigo Terminal Emulator
Version 3.0.145 (BETA)

shadeBlue _ shadeBlue LG
s oftwarae Copyright © shadeBle, LLC 2011
—Register:

Email Address: (required

|jnhn.dne@cnmpany.cnm |

License Key: (required
|FFBEZ?C2—C1A3—42bc—9989—2DA5903EICEAE |

(This license key is provided at time of purchase.)

Company Mame: [optiona

|M',-'Cc| mpany |

hitp:ifwwerw . shadeblue.com

The Continue to perform the license registration.

Indigo will contact the licensing registration server via the Internet and complete the necessary licensing
registration.

Indigo Terminal Emulator

Version 3.0.145 (BETA)
shadeBlue, LLC,
Copyright © shadeBlue, LLC 2011

Please wait ... activating license key.

hitp.ifwerw . ghadeblue.com

Once the license has been registered successfully, a confirmation message prompt will be displayed.



P 1

Registration Successful £

3 1 License registered successfully!

The application must be restarted to apply the new license,
Do you want to restart Indigo now?

Yes Mo

You will need to restart Indigo to complete the licensing registration.

Option 2: Manual Registration

If the target system does not have an Internet connection or your received a license activation code from shadeBlue
Support, then use the manual license registration option.
(Note: If you need to obtain a license activation code, please contact shadeBlue Support)

When prompted, select the second licensing option:
"Enter manual license activation code"

Indigo Terminal Emulator
Version 3.0.145 [BETA)

shadeBlu ) o shadeBlue, LLC.

s o ft warae Copryri

Reqgister:
How would you like to register your Indigo license?

(" Activate software license with license key
This license key is provided at time of purchase.
(requires Internet connection)

{* Enter manual license activation code

|Ise this option if you have obtained a license
activation code fram shadeBlue Support.

hitpeiiw ww . shadeblue.com Exit

Press Continue to proceed.

Next, enter (copy and paste) the license activation code received from shadeBlue Support.



Indigo Terminal Emulator
Version 3.0.145 (BETA)

shadeBlue ]
s o ftwarae Copyright & sh
Reqister:

License Activation Code: |

LHSRDYSG-FUTAAI7D-CTYRN2CP-
FLO7RYSP-SPHOMGYO-AD3RHAYZ2-
6PFTRGPA-JGHHBYGP-E4ADSSHH-
CDSUHH]G-BHZBS7PY-Y(56WDY2-
G6PURRGPA-JPJOYAQH-DPGFTYIT-
FLOU3TPY-SUEGHKZC-GAW]EFCL-
FEADS7SH-S77UMTo4-FYY JYHYS-
FHFI4HYC-CUAJIWG6-JTRAYKBF -
0AK442(G-HGWH3IHZF-S60QKLHH

asie Acovanon Lode ne

hitp:/hw ww shadeblue.com Continue Exit

Click Continue to submit the license activation code.

Once the license has been registered successfully, a confirmation message prompt will be displayed.

P "

Registration Successful EZ

"-.I License registered successfully!

The application must be restarted to apply the new license,
Do you want to restart Indigo now?

Yes Mo

You will need to restart Indigo to complete the licensing registration.
Getting Started / Next Steps

Now that Indigo has been installed you are ready to create your first terminal session (connection).

Create A Terminal Session

The following sections of this help documentation may be helpful to get started creating a terminal session and
getting it connected to your device or host:

® Create a New Terminal Session
® Select Connection Type & Configure Connection Settings

Indigo Essentials



The following sections explore a few of the essential concepts and features of Indigo.

Session Manager
Terminal Emulation
Session View Modes
Session Command Bar
Session Context Menu
Quick Connect Toolbar
Pause Incoming Data
Local Echo

Session Data Logging

Web Update

Indigo Intermediate Features

The following sections explore a few of the intermediate concepts and features of Indigo.

Split Data Window

Session Timestamps
Session Data Formatting
Command Macros
Multi-Command

Data Converter

Command Libraries

Auto Reconnect

Keep Alive

ASCII Charts

Window States

Transmit Serial Break Signal
Transmit Control Codes
Command Prefix & Suffix
Automated Send Commands
Transmit File Contents

Indigo Advanced Features

The following sections explore a few of the advanced concepts and features of Indigo.

Command Broadcasting

Variable ManagerCommand Variables
Command Repeater

Custom Reboot Sequence

Advanced Send Command Syntax

Syntax Coloring
Internal Commands

Custom Data Formatting
Character & Line Delay
Serial File Transfers
Serial Pass Mode

Scripting

Indigo Video Screencasts



The following screencasts are available to help visually demonstrate various features and concepts in Indigo.

Indigo Installation Screencast

Licensing Screencast

Data Logging Screencast

Web Update Screencast

Data Converter Screencast

Advanced Send Commands Screencast
Terminal Emulation Screencast

Quick Connect Screencast

Split Data View Screencast

Session Data Byte Representations

Indigo Users Manual

This section describes the general application features and guides the user through the basic
functionality of Indigo Terminal Emulator.

Please select from one of the following help topics:

User Interface (Layout)

Indigo User Interface Layout

You can move your cursor around the image below to highlight various user interface elements that make up the
Indigo application.
(Click on a user interface element to obtain more information. Note: Adobe Flash Player required.)

Menus

This section describes the application menus available in Indigo Terminal Emulator.

H| Indige Terminal Emulator EI@

File Edit View Toolz Session Macra Window  Help

Please select from one of the following help topics:

File Menu
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Telnet Session

S5H (Auto) Session

Serial (R5-232) Seszion
Serial (R5-422) Session
Senal (R5-485) Seszion
Dial Up (Modern) Session

Other Terminal 5ession = =
Web URL Shortcut

& Open Session File Ctrl+0
i Close Current Session Ctrl+L
Close All Sessions Ctrl+Q
& Save Data Ctrl+5
[H Save Data As
Save Session As ..
& Print... Ctrl+P
Recent Sessions 2
> Exit Alt+F4
File Menu

The File menu consists of the following options:

Name

Ne

Open

Close

Close All

Save Data

Save Data As

Description

Opens a sub-menu with options to create new terminal
sessions.

Opens a file browser dialog to manually select an
Indigo terminal session file on the file system.

Closes the current terminal session window currently in
focus.

Closes all open terminal session windows.

Saves the terminal session data received on screen to
a file.

If the data has not previously been saved to a file, a file
browser dialog will be displayed to allow you to select
the location and file name.

If this option has been previously used, then the
existing file will be overwritten and you will not be
prompted for the file again.

Saves the terminal session data received on screen to
afile.

This menu option will always display a file
browser dialog to allow you to select the location and
file name to save to.



Save Session As

Print

Recent Sessions

Exit

File / New Sub-menu

Saves the current terminal session window
configuration to a new Indigo session file.

Prints the received data on screen from the current
terminal session window to an installed printer.

Opens a sub-menu listing the recently accessed Indigo

sessions.

Selecting one of the listed sessions will immediately

open the session.

Close and terminates the Indigo Terminal Emulator

application.

The File / New sub-menu consists of the following options:

Name

Telnet Session

SSH (Auto) Session

Serial (RS-232) Session

Serial (RS-422) Session

Serial (RS-485) Session

Dial-Up Modem Session

Other Terminal Session

Description

Open the new session wizard with
the default options for creating a
telnet connection.

Open the new session wizard with
the default options for creating a
SSH connection.

Open the new session wizard with
the default options for creating a
serial RS-232 connection.

Open the new session wizard with
the default options for creating a
serial RS-422 connection.

Open the new session wizard with
the default options for creating a
serial RS-485 connection.

Open the new session wizard with
the default options for creating a
dial-up connection.

Open the new session wizard with
and select from a listing of available
connection types.

Pro Edition






Telnet
Serial:
RS232
Serial:
RS422
Serial - Pr
ofessional
Edition
Only
Serial:
RS485
Serial - Pr
ofessional
Edition
Only
TAPI
Modem /
Dial-Up -
Professio
nal
Edition
Only

SSH Auto
SSH1
SSH2
REXEC
RSH
RLOGIN
ECHO
DAYTIME
CHARGE
N

RAW
TCP
Client
RAW
UDP
Client /
Listener -
Professio
nal
Edition
Only
RAW
TCP
Server - P
rofession
al Edition
Only




Web URL Shortcut Allows user to create a URL
bookmark/shortcut to a web page.

Edit Menu

CIH;. Cut

Copy

E Paste

E Paste To Session Alt+V

dh Find Ctrl+F

# . Find Next F3

,_!_" Find Previous Shift+F3

M Select Al Ctrl+A
Goto Line Ctrl+G
Prograrn Preferences

Edit Menu
The Edit menu consists of the following options:

Name Description

Cut Copies any selected text to the system clipboard and
then deletes the selected text.
(If the selected text cannot be removed, then only a
copy is performed.)

Copy Copies any selected text to the system clipboard.

Paste Pastes text from the system clipboard to the current
cursor location.

Paste To Session Pastes text from the system clipboard directly to the
connected session in the active session window.

Find Prompts the user for text to search for in the session
data window.
After submitting the text query, Indigo will search for the
text within the data.

Find Next Attempts to find the next occurrence of the user
provided search query text.

Find Previous Attempts to find the previous occurrence of the user
provided search query text.



Select All

Goto Line

Program Preferences

View Menu

Session List Bar
Status Bar

Session Manager Ctrl+F1
Command Library Ctrl+F2
Data Conwverter Ctrl+F3
Repeater Ctrl+F4
Variable Manager Ctrl+F5

Quick Connect Toolbar

Recent Sessicns Toolbar

Windu:uw States Toolbar

Macros Toolbar

Find / Search Teoclbar

Line Mumbers Ctrl+I
Line Highlight Ctrl+T

View Menu

The View menu consists of the following options:

Name

Session List Bar

Status Bar

Session Manager

Command Library

Data Converter

Highlights all text in the session data window.
(Only available in Standard Terminal Mode)

Prompts the user for a line number and then jump the
cursor directly to that line number.
(Only available in Standard Terminal Mode)

Open the Indigo Terminal Emulator global application
settings dialog.

You can configure global application settings using this
option.

Description
hides / shows the Session List toolbar

hides / shows the session Status toolbar

hides / shows the Session Manager widget

hides / shows the Command Library widget

hides / shows the Data Converter widget



Repeater hides / shows the Command Repeater widget

Variable Manager hides / shows the Variable Manager widget

Quick Connect Toolbar hides / shows the Quick Connect toolbar

Recent Sessions Toolbar hides / shows the Recent Sessions toolbar

Window States Toolbar hides / shows the Window States toolbar

Macro Command Toolbar hides / shows the Macro Commands toolbar

Line Numbers hides / shows line numbers in the standard terminal
mode

Line Highlight hides / shows line highlighter in the standard terminal
mode

Tools Menu

Tools

@ Edit Custorn Data Conversion Format
A ASCH Chart F12
1|

Syntax Color Editor

| Window States P| n Windows State 1
B send/Upload File ... alteCirles | B Windows State 2
=¥ Receive/Download File ... Ak+Ctri+r | EV Windows State 3

&) Windows State 4

EP Transmit Text File (A5CT BY LIMNE)
E Windows State b

E‘F Transmit Raw File (BINARY)

Transmit Raw File (THROTTLE) cti+R | [l Save Window State
Refresh fvailable Com Ports Shift+F12
Refresh fAvailable Modems Ctrl+F12
Tools Menu

The Tools menu consists of the following options:

Name Description Pro Edition
Edit Custom Data Conversion Opens the custom data format

Format editor

ASCII Chart Opens the ASCII chart window

Syntax Color Editor Opens the Syntax Color editor



Window States

Send / Upload File

Receive / Download File

Transmit Text File (ASCII By Line)

Transmit Raw File (BINARY)

Transmit Raw File (THROTTLE)

Refresh Available Com Ports

Refresh Available Modems

Window States Sub-Menu

Name

Window States
(1-5)

Save Window State

Session Menu

Opens the Windows States
sub-menu

Opens the File Upload transfer tool

Opens the File Download transfer
tool

Opens the Text File line transfer
tool

Opens the Binary File transfer tool

Opens the Throttled Binary File
transfer tool

Forces Indigo to query the system
and refresh the list of available
serial ports

Forces Indigo to query the system
and refresh the list of available
modems

Description

Activates the selected window state (position & size)

Opens the Window State save dialog
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Connect
Disconnect

Reconnect

Auto Reconnect

Session

@ Connection

Terminal Emulation Mode

E Repeat Last Transmission

W Selected Text

& Clear Session Data

™" Clear Data Above Selected Line
T Clear Command Buffer

IE Data Format

E:} Reboot

4=_’ Pazs Mode

[Q] Broadcast Send Commands
E Log Data To File

B Lecal Echeo

1l PauseIncoming Data
[ Transmit Break Signal

## Transmit Control Code

(Ctrl+Break)

Syntax Color Filter
Session Properties

Alt+F2

Ctrl+5pace

F5

F6

»

»

Session Menu

The Session menu consists of the following options:

Name

Connection

Standard Terminal Mode

Terminal Emulation Mode

Repeat Last Transmission

Selected Text

Clear Session Data

F1 CTRL-@  MULL (null)
F2 CTRL-A  SOH (start of heading) Ctrl+Shifts A
F4 CTRL-B  STX (start of text) Ctrl+Shift+B
7 E Send to Active Session Ctrl+D CTRL-C  ETX (end of text) Ctrl+Shift+C
B2 Send to All Open Sessions CTRL-D EOT (end of tranmission) Ctrl+Shift+D
—} BE Send to Command Bar Ctrl+B CTRL-E  ENQ [enquiry) Ctrl+Shift+E
BE] Send to Data Converter CTRL-F  ACK (acknowledge) Ctrl+5Shift+F
3| Add 1o Command Macros CTRL-G  BELL (bell) Ctrl+Shift+G
Add to Command Library CTRL-H BS (backspace) Ctrl+5Shift+H
> :_IEI“ Add to Command Repeater CTRL-1 TAB (herizontal tab) Ctrl+ Shift+I
CTRL-J  LF (linefeed) Ctrl+Shift+)
[B] Ascii CTRL-K VT (vertical tab) Ctrl+ Shift+K
[B] Ascii w/ Control Codes CTRL-L  FF (form feed) Ctrl+ Shift+L
H Headecimal CTRL-M  CR (carriage retum) Ctrl+Shift=M
> [H] Hexw/ Control Codes CTRL-N 50 (shift out) Ctrl+Shifts N
O] Decimal CTRL-O Sl (shift in) Ctrl+Shift+0
[@] Octal CTRL-P  DLE (data link escape) Ctrl+ Shift+P
Binary CTRL-Q DL (go) / XON Ctrl+Shift+Q
[ Mixed Ascii/Hex CTRL-R  DC2 Ctrl+Shift+R
[€] custom CTRL-S DC3 (stop) / XOFF Ctrl+Shift+S
[¥] Byte Analysis CTRL-T DC4 Ctrl+Shift+T
CTRL-U  MAK (negative acknowledge) Ctrl+Shift+U
I CTRL-V  SYN (synchronous idle) Ctrl+Shift+V
P Mone CTRL-W ETB (end transmission block)  Ctrl+Shift+ W
Ny Custom Syntax Color CTRL-X CAN (cancel) Ctrl+Shift+X
B yrtax Color Editor CTRL-Y EM (end of medium) Ctrl+ Shift+Y
CTRL-Z SUE (substitute / suspend) Ctrl+Shift+Z
CTRL-[ ESC (escape)
CTRL-\  FS5 (field separator)
CTRL-] G5 (group separator)
CTRL-" RS (record separator)
CTRL-DEL  US {unit separator) Ctrl+ Shift+Delete
Description

Opens the session connection sub-menu.

Applies the standard view mode to the active session.
(Note: Do not use this view mode when attempting to
connect to a session that requires terminal emulation
such as VT100.)

Applies the terminal emulation view mode to the active
session. Use this option for VT100, Linux, or ANSII
terminal emulation.

Re-transmits the last command/data issued to the
active session.
Opens the selected text sub-menu.

Removes all data from the data window in the active
session.



Clear Data Above Selected Line

Clear Command Buffer

Data Format

Reboot

Pass Mode

Broadcast Send Commands

Log Data To File

Local Echo

Pause Incoming Data

Transmit Break Signal

Transmit Control Code

Syntax Color Filter

Session Properties

Removes all data from the data window above the
cursor position.

(Note: This option is only available in the Standard
Terminal Mode.)

Removes all buffered / cached commands from the co
mmand bar in the active session.

Opens the data format sub-menu.

Transmits the custom reboot command sequence
configured for the active session.

The session connection will be disconnected and a
based on a configured delay, the session will attempt to
re-establish its connection.

Opens the pass mode configuration dialog allowing to
configure and enable serial pass mode.

(Note: This option is only available when connected via
serial: RS232, RS422, RS485.)

If this option is enabled all commands transmitted in the
active session are also broadcast and transmitted to all
other open sessions.

Opens the session logging tool to configure and start
data logging for the active session.

If enabled, this option will print (echo) any data
commands transmitted to the data window in the active
session.

Pauses all inbound data from the connection on the
active session window.

(Note: This option does not buffer data, while paused,
any data received will be ignored.)

Transmits a BREAK signal to the configured serial port
in the active terminal session.

(Note: This option is only available when connected via
serial: RS232, RS422, RS485.)

Opens the control code sub-menu. The selected control
code will be transmitted to the active session.

Opens the syntax color filter sub-menu

Opens the session properties configuration user
interface for the active session.



Selected Text Sub-Menu

Name

Send to Active Session

Send to All Open Sessions

Send to Command Bar

Send to Data Converter

Add to Command Macros

Add to Command Library

Add to Command Repeater

Session Connection Sub-Menu

Name

Connect

Disconnect

Reconnect

Auto Reconnect

Session Date Byte Format Sub-menu

Name

Description

Transmits the selected text to the current active
terminal session.

Transmits the selected text to all open terminal
sessions.

Copies the selected text to the command bar in the
current active session window.

Sends the selected text to the data converter tool
where it will get converted into the selected data
format.

Copies the selected text and add the text as a new co
mand macro.

Copies the selected text and add the text as a new co
mand library command entry.

Copies the selected text and add the text as a new co
mand repeater command entry.

Description

Attempts to establish a connection in the active session
window.

Attempts to disconnect an open connection in the
active session window.

Attempts to disconnect and then immediately
re-establish a connection in the active session window.

If this option is enabled, then when a session detects
the loss of connectivity it will automatically attempt to
re-establish the connection.

(Note: Serial-based connections cannot determine the
loss of connectivity.)

Description



ASCII

ASCII w/ Control Codes

Hexadecimal

Hexadecimal w/ Control Codes

Decimal

Octal

Binary

Mixed ASCII/Hex

Custom

Byte Analysis

Byte Grouping

Syntax Color Filter Sub-Menu

Name

None

Filter Files

1-..)

Applies the selected data byte formatting to the active
session.

Applies the selected data byte formatting to the active
session.

Applies the selected data byte formatting to the active
session.

Applies the selected data byte formatting to the active
session.

Applies the selected data byte formatting to the active
session.

Applies the selected data byte formatting to the active
session.

Applies the selected data byte formatting to the active
session.

Applies the selected data byte formatting to the active
session.

Applies the selected data byte formatting to the active
session.

Applies the selected data byte formatting to the active
session.

Sets the byte size representation (BYTE, WORD,
DWORD) for displaying bytes in the following formats:

Decimal
Hexadecimal
Octal

Binary

Description

Removes any selected syntax color filter from the
active session window.

Applies the selected syntax color filter to the active
session window.



Syntax Color Editor Opens the syntax color editor tool.

Macro Menu

Macra

1. Date

2. Time

3. IP Info

4, LS

5. P5

6. Test Command 1
7

8

9

Macro
Commands

. Test Command 2
. Test Command 3
. Test Command 4
10. Test Cornmand 5
test

'}@ Edit Macros Ctrl+ M

Window Menu

The Window menu consists of the following options:

Name Description

Macro Commands A series (up to 20) of macros commands.

(1-20) Click the command menu item to send it to the active
session.

Edit Macros Opens the macro editor

Window Menu

Window

M Tile Vertically Fg

B Tile Horizontally F10

D Cascade F11
Maximize Ctri+Up
Mormalize Ctrl+Down
Minimize

B Split Herizontal

B split Vertical
Next Ctrl+Right
Previous Ctrl+Left

Window Menu



The Window menu consists of the following options:

Name

Tile Vertically

Tile Horizontally

Cascade

Maximize

Normalize

Minimize

Split Horizontal

Split Vertical

Next

Previous

Help Menu

Help
@ About

Indige Online Documentation Shift+F1

Visit shadeBlue Online
Check For Updates (Web Update)
% License Registration & Information

Help Menu
The Help menu consists of the following options:

Name

About

Online Documentation

Description

Tiles multiple session windows in the vertical
orientation

Tiles multiple session windows in the horizontal
orientation

Cascades multiple session windows

Maximizes the current session window in focus
Normalizes the current session window in focus
Minimizes the current session window in focus

Splits the current session data window into two data
regions on the horizontal axis

Splits the current session data window into two data
regions on the vertical axis

Advances to the next open session window

Retards to the previous open session window

Description

Displays program version and authoring information

Opens the Online Indigo User's Guide in the user's web

browser



Visit shadeBlue Online Opens a web browser to www.shadeblue.com

Check For Updates (Web Update) Connects to shadeBlue update servers and check to
see if any newer application updates are available.

License Registration & Information Displays licensing information and provides dialog to
enter/submit a new license key

Toolbars

This section describes the toolbars available in Indigo Terminal Emulator.

Indigo Terminal Emulator includes a number of toolbars that bring convenience and quick access to many of the
sophisticated features provided in Indigo.
All application toolbars are optional and can be enabled/disabled by the user.
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J & Serial (RS-232) ~ COM1  + 115200 + N+ 8 « 1 = None - ) J Recent Sessions  ~ J Window States  ~
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.
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83 1+<QCs C1115200,N81 -8 X
<QC= C1,115200,M,8,1 : <R5232= COM 1, 115200, NONE, 8, 1 y-
Indigo Toolbars & Topics:

Show & Hide Toolbars

Show / Hide Toolbars

All toolbars in Indigo Terminal Emulator can be displayed and hidden via the View Menu.


http://www.shadeblue.com

Session List Bar

Status Bar
Session Manager Ctrl+F1
Comrmand Library Ctrl+F2
Data Converter Ctrl+F3
Repeater Ctrl+F4
Yariable Manager Ctrl+F5

Quick Connect Toolbar »

Recent Sessions Toolbar

Window States Toolbar

Macros Toolbar

Find / Search Toolbar )

Line Mumbers Ctrl+1
Line Highlight Ctrl+T

Session List Toolbar

Session List Toolbar

The Session List Toolbar is located at the bottom of the Indigo application window and is used to display the
currently open session windows.

5:] 1 Telehack 2 Test Sezzion 3 Localhost Session 4 <0C> C3115200,M.8.1

You can click on any of the named session tabs to switch focus to that session instance.
Options for minimize, maximize, and close session are available on this toolbar.
|ﬁ | 1 Telehack | 2 Test Session 3 Lozalhost Session 4 <QC: C3.115200,M4.8.1 - B X

Status Toolbar

Status Toolbar



The Status Toolbar is located at the bottom of the Indigo application window and is used to display the session
connection setting for the currently open and active session window.
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Quick Connect Toolbar

Quick Connect Toolbar
© screencast

A screencast demonstration the quick connect feature is available. Click here to see the video.

The Quick Connect Toolbar is provided to allow a quick and convenient method for creating one-off / impromptu
terminal session connections.

The Quick Connect Toolbar is located at the top of the Indigo application under the menu bar.
The Quick Connect Toolbar can be turned on and off via the View menu.

File Edt “ew Tools Session Macro  Window  Help

%= Telnet + telehack.com = MNone ~ P | Maco: - [l EH E B E B E
Session Manager o x|
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Quick Connect Toolbar Anatomy

The Quick Connect Toolbar consists of the following parts:

Connection Connection Settings Terminal
Type Emulation  “0nnect

/\/’—\m/

# Serial [(R5-232) ~ COM3 = 115200 - - - * Mone =

Connection Connection Settings Terminal .
Type Emulation -onnect
3= Telnet = telehack.com * Mone =
Connection Type A drop-down selection of the most popular connection
types.

Select the desired connection type from the listing.

Connection Settings Based on the selected connection type, a list of
connection options will be displayed.
Please note that not all connection settings are
available in this toolbar.
Some advanced settings and more complex
configurations cannot be configured from the Quick
Connect Toolbar.

Terminal Emulation Select a terminal emulation type if needed.
This selection will setup the default session emulation
properties and apply the appropriate default session vie
w mode.

Connnect The right arrow button can be used to launch the quick
connect terminal session based on the selected
connection type, connection settings, and terminal
emulation settings.

If using the Quick Connect Toolbar with Telnet or SSH
connection options, you can also press the ENTER key
in the host address field to initiate the connection.

Quick Connect Examples

The Quick Connect Toolbar supports convenient access to the most popular connection options.



% Telnet = telehack.com * Mone - }

3 Telnet

B21 55H [Auta)

£ Serial [R5-232]
£ Serial [R5-422)
£ Serial [R5-455]
Dial Up [Madem)

Based on the selected connection type, the Quick Connect Toolbar will display additional connection specific
configuration options.

Example: Quick Connect Toolbar for Serial RS-232

& Senal [F5-232) » COM3 = 115200 + N » 8 v 1 + None « P

Example: Quick Connect Toolbar for Telnet

3= Telnet = telehack.com * Maone - }

Quick Connect Session Persistence

Quick Connect created session are not automatically persisted in the Session Manager.
These are intended for impromptu terminal session connections. Permanent sessions should be created via the
Session Manager.

However, if you would like to permanently persist a quick connect created session instance, while the session
window is open, click the File > Save Session As menu option.

You will be prompted with a file save dialog, enter a session name and click Save.

The session should now be available in the Session Manager.

Macro Command Toolbar

Macro Command Toolbar

The Macro Command Toolbar is provided for quick access to execute and/or edit command macros.
More information on macro commands can be found here.
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The Macro Command Toolbar can display up to 10 icons for the top ten macros.
However, you can use the drop down button to access up to 20 macros as well as the Macro Editor.

Macros - EIEEEEHEEEBEEBDOE

Date
Timne
IP Info
LS

PS

Test Command 1

Test Command 2

Test Command 3

w oo ~omm o L

. Test Cammand 4
10. Test Command 5

'}@ Edit Macroz Chrl+t

You can use the mouse pointer and hover over a macro button to see the tooltip that revels the macro name.

hacros *IIEEEEE
2. Timel

© Macro Toolbar Buttons

Each macro command button on the toolbar is only displayed if you have a macro defined for its
position.

Recent Sessions Toolbar

Recent Session Toolbar

The Recent Session Toolbar is provided for quick access to re-open recently used terminal sessions.
Simply click the session hame from the listed recently used terminal sessions to re-open that session instance.
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Window States Toolbar

Window States Toolbar

The Windows States Toolbar is provided for quick access to restore the Indigo Terminal application window to a
stored size and position on screen.
More information on window states can be found here.

File Edit “iew Toolz Session Macro ‘Window Help

J = Telhet = telehack. com = MNone [+ P J Window States -

Session Manager [ x] 0 indows Sate

'ﬁ “Wiew ol Groups - B YWindows State 2
Wind State 3

E@ Sezsions fn s alate
== ciustom sonpt session andows State 4
B2 Localhost Session B windows State 5

Hol Mac-05% S5H BB 5ave window State
Telehack

£ sepesuog eiEQ

=';] Test Session

Find / Search Toolbar

Find / Search Toolbar

The Find/Search Toolbar is provided for quick access search for text in the session data window.
The toolbar includes a text entry to provide the search text, find next, and find previous buttons.



Find ,# Text

Terminal Sessions

Please select from one of the following help topics on terminal sesisons:

New Terminal Session

Overview

To begin using Indigo to connect to devices or remote hosts, the first thing you need to do is create Terminal
Sessions. Terminal Sessions are basically the configuration context along with all connection settings and user
configured options for each connection that Indigo needs to establish. Terminal Sessions also provide the user
interface window where data received and transmitted is displayed.

Indigo include the following options for creating new terminal sessions.

® via File Menu
® via Session Manager

® via Quick Connect Toolbar

File > New > Session

To create a new terminal session via the File Menu, select the File main menu and then New menu item. A popup
menu will be displayed with the most popular connection types. Select the desired connection type if it is displayed;
otherwise, select the Other Terminal Sessions option to select from the more comprehensive list of connection types
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Next you will be prompted with the New Terminal Session dialog.

Creating a New Terminal Session

When prompted with the New Terminal Session dialog, please provide a new unique session name to apply to this
terminal session.

(You can optionally select a specific session folder if you have defined nested session folders in the Session
Manager.)

Add Mew Terminal Session =

Please Select Session Folder:
|[Sessiuns] ﬂ

Please Enter Session Mame:
Iy Seszion Mams

Dioes this connection session require a Terminal Emulation Protocol?

{* Mo Terminal Emulation
{~ WT100 Terminal Emulation
(" Linux Terminal Emulation
(" AMSI Terminal Emulation

OK Cancel

If the device or host you are connecting to requires a terminal emulation protocol such as VT100 or Linux, select the
emulation option here.

Selecting a terminal emulation option here will configure the terminal emulation configuration properties and apply
the appropriate default session view mode.
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Tip

If connecting to network routers or other network appliances, usually VT100 is the recommended
terminal emulation option.

If connecting to a Unix, Linux, or Apple server/workstation, usually the Linux Emulation option is
the recommended terminal emulation option.

If connecting to an embedded device, usually no terminal emulation is needed.

Click the OK button to create the new terminal session instance.

Next you will be prompted with the Terminal Session Properties dialog.
Here you can configure the specific connection properties and any other user preferences for this terminal session.




Session Properties - ]
Connection l Proxy | Terminal | Formattng | Seftings | Send Commands
— Connection Protocol
| TELNET ~| ¥ AUTO CONNECT
— TELMET Settings
TELMET Host myhost. company.com
TELNETPort  [23 :II (defaultis 23)  Active Telnet Negotiation v
— Authentication
Authentication Method: I-DISABLED— j
Wiait for Prompt: |
UzerName: I
Password: |
Private Key: (OpenSSH, Putty) | |
Key Passphrase: |
oK | Cancel |

(More information about the various connection types and properties can be found here.)
(More information about other session properties can be found here.)

Click the OK button to save the terminal session properties.

The new terminal session instance will be displayed in the Session Manager.
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To load this new terminal session in Indigo, double-click the named session in the Session Manager.

Connection Types

Terminal Session Connection Types

Indigo supports the following connection option for communicating with devices, servers, workstations, appliances,
control systems, and other hosts.
Please note that the Professional Edition of Indigo supports a few additional connection types.

Feature Indigo V3 Standard Indigo V3 Professional
Serial (RS-232)
Serial (RS-422)
Serial (RS-485)
Dial-Up (Modem)
Telnet
Secure Shell (SSH1, SSH2, SSH
Auto)

RLOGIN
REXEC
RSH



ECHO
DAYTIME
CHARGEN
RAW-TCP-Client
RAW-TCP-Server (Listener)
RAW-UDP (Listener & Sender)

Please select a connection type above to learn more about the configuration options available for each connection
type.

Terminal Emulation

Indigo Terminal Emulation Protocols

© Screencast

A screencast demonstrating the terminal emulation capabilities is available. Click here to see the
video.

Indigo supports the following terminal emulation protocols:

Terminal Emulation Protocol

None

ANSI

VT100

Linux

Depending on the device or server/host that you may be connecting to, it may require a terminal emulation protocol
for the data to be rendered on screen correctly.

Terminal emulation protocols include special instruction commands in the data transmissions that are not intended
to be rendered on screen, but rather control how data should be represented on screen.

Using a terminal emulation protocol may provide an enhanced terminal experience over a raw data emulation.

It is important to note that for Indigo to render the text using a terminal emulation protocol, it must be
configured in the Terminal Emulation View Mode.

The standard view mode will only render the raw data received and will ignore any special control and command
sequences specified in the terminal emulation protocol.

If you select a terminal emulation protocol when creating a new terminal session, Indigo will automatically display
using the Terminal Emulation view mode by default.
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Tip

If connecting to network routers or other network appliances, usually VT100 is the recommended
terminal emulation option.

If connecting to a Unix, Linux, or Apple server/workstation, usually the Linux Emulation option is
the recommended terminal emulation option.

If connecting to an embedded device, usually no terminal emulation is needed.

To configure a session's terminal emulation settings after a session has been created, please edit the Session Prop
erties and and select the Terminal Emulation Settings tab.

Session View Modes

Overview

Indigo includes two distinct session view modes that control how data received from the connected
device/server/host is rendered on the screen.
Each view mode include distinct features and capabilities.

Mode Name Description

Standard Mode @ Standard Terminal Mode (No Screen Emulation)

This screen mode displays raw data received from the
connected device or server/host.

Terminal Emulation Mode Terminal Emulation Mode (Screen Emulation for VT100, Lir

This screen mode displays data received from the
connected device or server/host using a terminal
emulation protocol.

Note

This mode is required to properly
display the data on screen when
using VT100 or Linux terminal
emulation protocols.

Selecting the View Mode

The session view mode can be changed while a terminal session window is open by selecting the Session Menu an
d then choosing either Standard or Terminal Emulation mode menu options.

Seszion

ECD

@ Standard Terminal Mode Alt+F1
Terminal Emulation Mode Alt+F2




The session view mode can also be changed while a terminal session window is open by selecting the View Mode t
oolbar option in lower left corner the session window and choosing either Standard or Terminal Emulation mode
menu options.

(You can also simply click the icon to toggle between the modes.)
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Terminal Emulation Mode (Screen Emulation for YT100, Linux, etc)

Standard Mode

The standard view mode displays raw data in the terminal session window.
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The following Indigo features require the standard view mode:

® Line numbering
® Line highlighting
® Display data formatting in alternate data byte representations




® Syntax color filtering
® Line time stamping
® Line wrapping

In standard mode, you cannot enter command instructions
by directly typing in the session data window, you must
instead enter and submit commands via the command bar a
t the bottom of the session window.

Terminal Emulation Mode
© Screencast

A screencast of the terminal emulation mode rendering data using a terminal emulation protocol
is available here. Click here to see the video.
This screencast demonstrates terminal emulation screen control and character positioning.

The terminal emulation view mode displays data according to the selected terminal emulation protocol.
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In terminal emulation mode, you can enter command instructions by placing the cursor directly in the session data
window and begin typing.
You can also optionally enter and submit commands via the command bar at the bottom of the session window.

If working on a server or host where arrow buttons, tab button, function buttons, or control sequences such as
CTRL-C are needed, you must place the cursor directly in the session data window and enter the keystrokes.

When the cursor is focused in the data window in while in terminal emulation mode, Indigo will display a small finger
pressing keyboard key icon to represents that keystrokes are being redirected to the terminal session.

This means Indigo will listen for any keyboard input and send it directly to the connected session. This means that
normal program hotkeys may not work since the keystrokes are being redirected to the session.



Keyboard input is being redirected to terminal session.

(Program hotkeys may not be functional since keystrokes
for special keys are being sent to the connected terminal session,)
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To stop keyboard redirection you can click the icon or place the cursor focus outside of the data window to a location
such as the command bar.

When keyboard redirection is suspended the icon will disappear and keyboard shortcuts will resume normal
functionality.

Note

This mode is required to properly display the data on screen when using VT100 or Linux
terminal emulation protocols.

Session User Interface (Layout)

Indigo Session User Interface Layout

The following features and user interface elements make of the Indigo session.



ﬁ <QC> telehack.com E@ o
o o
c - ©
o E Connected to TELEHACK port 54 5 3
C O Y »
4 E It is 1:28 pm on Sunday, May 27, 2812 in HMountain Ui 8 o
=] There are 25 local users. There are 24414 hosts\on t =] 5
= W
Type ?* for a command list.
Type HELP for a more detailed command listing. -
7 o
3 - <
=
e 1 I &=
May the command line live forever. =
E Command, one of the following:
S - ac basic cal calc ch
w= __| dir eliza factor figlet fi
H = help hosts ipaddr joke lo
w2 .-E newuser notes octopus phoon pi
= rand score starwars telnet tr
units uUsers uupath Zrun
5§ b
2_0 _:@""l”cnmﬁndt}ar j”@’@"
Qo O
L x O o ;IJ %
s & Command Bar / S gea
= —
= o Command Buffer 2 Mmoo
= ol 0 Qo = 3
L] = 3 3
a Z © 3 8o
2 g - -1
O o 5 W
Q
Session Options Description
Line Numbering If using the Standard View Mode, you can display line
numbering in the left margin of the session data
window.
You can enable and disable line number using the View
Menu.
Session Data Window This is the session data window where data send and
received is rendered to the screen.
You can right-click anywhere on the session data
window to display the session context menu.
Session Toolbar The session toolbar is located at the bottom of the

session windows by default.

(This toolbar can be relocated to the top of the session
window by using the mouse cursor to grab the toolbar
and drag it to the top of the session window.)



View Mode

Prefix & Suffix

Command Bar/Buffer

Session Status Icons

Switch between session session view modes using the
drop down selection. Or click the icon to toggle
between view modes.

) v|
@ Standard Terminal Mode (No Screen Emulation)
Terminal Emulation Mode (5creen Emulation for YT10(

Enable and disable command prefix and suffix options
using this toolbar button.

4
4|l Command Prefix
|¥ Command Suffix

4|» Enable Command Prefix & Suffix
| Disable Command Prefix & Suffix

You can enter instructions or command in this
command bar and press the ENTER key to transmit
them to the connected session.

command bar -

The command bar includes a drop-down list of
alternate targets to send the entered command.

ﬂ

P2 Send to Active Session

Pi Send to All Open Sessions
PO Send to Data Conwverter
M Add to Command Macros

+[E Add to Command Library
+[E]l Add to Command Repeater

For more information about the command bar,
command buffer, and command send options, click her
e.

Terminal sessions will display any status icons in the
upper right corner of the session data window when
needed.

You can hover over the status icon to display a tooltip
with additional information or click the icon to disable to
display more options for the feature.



Data View Splitter

Session Tools Menu

Pause Incoming Data

Data Format

When using the standard view mode, the session data
window supports a split view where the data window
can be divided in two regions to display different
portions of the received data.

Drag the view splitter to re-size the data window
regions. Drag the view splitter all the way to the top to
hide the split view.

This toolbar button will display the advanced (tools) con
text session menu.

‘E:} Reboot

& Log Data TeFile
bll Local Echo

" Pause Incoming Data

[[jﬂ] Broadcast Send Commands
&# Transmit Control Code 4

Syntax Color Filter r

Edit Session Properties

Clicking this toolbar button will toggle the pause
incoming data feature.

When using the standard view mode , this option will s
witch the data format that data bytes are being
represented in on screen.

[v][A] Ascii

Asciiw/ Control Codes

Hexadecimal

Hex wy Control Codes
Decimal

Octal

Binary

Mixed Ascii/Hex
Custom

Byte Analysis
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Connection

Command Bar / Buffer

Command Bar

This toolbar option displays the current connection
state and allows you to change the connection state.
Clicking the icon will toggle between the connected and
disconnected state.

Clicking the drop-down list allow you to discretely select
between: Connect, Disconnect, Reconnect, or Auto-Re
connect.

. Connect
. Disconnect
E Reconnect

Auto Reconnect

Perhaps one of the more important concepts to understand in Indigo is the command bar!

command bar

=l

Unlike conventional terminal emulation applications where you type keystrokes directly into the data window, Indigo
introduces the concept of sending data via the command bar.

Tip

Indigo does support directly keystroke input in the Terminal Emulation view mode and this is
absolutely needed for interaction with certain connections/hosts.

© Note

If using the standard view mode you must use the command bar to submit commands/data to the
connected terminal session.

The command bar offers many features over direct keyboard input.

Feature

Syntax Correction

Auto-Completion

Description

Type and modify the full command text before
submitting. This means if you make a mistake you can
simple correct the mistake before sending.

Some terminal connection do not adequately handle
backspaces and corrections so this can be a real life
saver.

Indigo supports auto-completion of text in the command
bar if enabled via the Advanced Session Properties.

[cortrmT ~




Easy Copy/Paste

Drag & Drop Text

Command Staging

Command Buffer

Advanced Command Syntax

Internal Commands

Some terminal emulation applications do not handle
simple copy and paste of commands to send.

In the command bar you can use the normal windows
copy (CTRL-C) and paste (CTRL-V) shortcuts to copy
and paste text into the command bar to send.

You can also right-click the command bar and use the
context menu to perform copy,cut, and paste
operations.

The command bar fully supports drag and drop text.
Select text from a document or another application and
drag it to the command bar to stage it.

Since the command bar does not send the command
as it is enters or as it is pasted this leaves the text in a
staged state allowing you to make any additional
modifications needed.

Perhaps you are pasting a portion of a command that
you intend to reuse multiple times but just need to
modify or add some additional text.

Since the command is staged and not immediately
transmitted, the command bar easily facilitates this use
case.

To submit your staged command either press the
ENTER key or use the right arrow submit toolbar next
to the command bar.

The command bar automatically buffers previously
transmitted commands and provides easy access to
re-use a previously sent text.

See the section below for more information on the
command buffer.

Indigo supports an advanced text byte interpreter
feature that can be invoked from the command bar.
Using this feature you can transmit data in multiple byte
representation including HEX, DEC, ASCII, OCT,
BINARY or any combination of these bytes.

Please see advanced send commands for more
information.

Indigo supports an advanced internal command
interpreter feature that can be invoked from the
command bar.

Please see internal commands for more information.

To submit data/text from the command bar you can either press the ENTER key while the cursor is focused in the
command bar text entry field or click the right arrow toolbar button to the left of the command bar.

Command Termination Bytes/Characters

It is important to note that all commands entered into the command bar are automatically appended with command

termination bytes/characters.

The default command termination bytes use in Indigo are CARRIAGE RETURN (0xOD) and LINE FEED (Ox0A).



You can optionally disable or change these termination bytes in the Advanced Session Properties.

© Note

There is one exception where command termination bytes are NOT automatically appended to
the command sent via the command bar: Advanced Send Commands.

When sending an advanced send command, Indigo does not append any termination bytes.

If using and advanced send command it is assumed that you need/want complete control over
the data bytes being transmitted; therefore, Indigo does not append these termination bytes.

Command Buffer

The command bar automatically buffers previously transmitted commands and provides easy access to re-use a

previously sent text.
You can click the drop-down option in the command bar to list and select from the previously submitted command

text.

[ <y -

command Iix

command five
command four
command three

command two
command one

You can also press the UP arrow while the command bar text entry field has focus to access the last transmitted

command text.
The UP and DOWN arrow keyboard buttons allow you to navigate through the command history.

You can enable/disable and define how many command to permanently persist in history for each terminal session
via the Advanced Session Properties.




Session Settings

Muli-Command The command buffer wil automatically
store each command sent to the

Internal Commands _ _
sezsion from the session command

Variable Replacement entry bar. vou can use the up and
Advanced Send Commands down arrow keys to navigate through
[ Force Window Maximized the listing of previous commands or
Command Buffer click the drop-down arrow to display
Reboot Sequence the listing of previous commands.
Terminating Character

[] Auto Line Wirap < Keep Histo |7_|
D Post Processing Script 4 ? v 1o —
[] keep Alive

Character & Line Delay Keep HiS‘tI:Ir.‘f will zavelrecall the

D Timestamp commands in the command buffer each

time the session is closediopened.

Auto Complete Enabled ﬂ

Auto complete will attempt to find and
dizplay the previous command as you

type.

You can purge the command buffer history from the Session menu or the Session context menu using the Clear
Command Buffer menu item.

. Connection r
Terminal Emulation Mode Alt+F2
L' Repeat Last Transmission Ctrl+5Space
MM Selected Text 3
@ Clear Session Data F5
™™ Clear Data Above Selected Line

rET Clear Command Buffer Fia
5 Resume Mew Line Tracking F7
|E| Data Format 3
‘E:} Reboot

D8

Broadeast Send Commands
Log Data To File

Local Eche

Pause Incoming Data

Transmit Control Code k

==K

y
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Syntax Coler Filter k
Session Properties F&

Command Bar Text To Alternate Targets

By default the command bar transmits the command text directly to the connected session device/host.
However, the command bar includes a drop-down list of alternate targets to send the command text.



ﬂ

Mz Send to Active Session
Fi Send to All Open Seszions

MO Send to Data Conwverter

+M Add to Command Macros
+[L Add to Command Library
+[El Add to Command Repeater

Target

Send to Active Session

Send to All Open Sessions

Send to Data Converter

Add to Command Macros

Add to Command Library

Add to Command Repeater

Session Context Menus

Session Context Menu

Description

This option will simple transmit the command text to the
session's connected device/host.

This option will broadcast the command text to all open
Indigo terminal session windows and it will be
transmitted to each of the sessions connected
devices/hosts.

This option will send the command text to the data
converter widget and it will be converted based on the
data format selected in the data converter.

This option will add the command text as a new macro
command.

This option will add the command text as a new
command entry in the current command library.

This option will add the command text as a new
command entry in the current command repeater.

Right-click anywhere in the session data window to display the session context menu.
The context menu items will vary slightly depending on the session view mode.

Standard View Mode

Terminal Emulation View Mode



Disconnect

Repeat Last Transmission
Selected Text

Reboot

Clear Session Data

Clear Data Abowve Current Line
Clear Command Buffer

Copy

Paste

Find

Find Mext

Find Previous

Goto Line
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Data Format
Advanced

Ctrl+5pace

Ctrl+F

Ctrl+G

k

Name

Connect or Disconnect

Repeat Last Transmission

Selected Text

Reboot

Clear Session Data

Clear Data Above Selected Line

Clear Command Buffer

Copy

Paste (to session)

Disconnect

Repeat Last Transmission Ctrl+5pace
Selected Text k
Reboot

Clear Session Data

Clear Command Buffer

Copy

Paste

Eind Ctrl+F
Find Mext

Find Previous

BEEEFOMCGIOE

Advanced k

Description

The Connect or Disconnect option will be displayed
depending on the current session connection state.

Re-transmits the last command/data issued to the
active session.

Opens the selected text sub-menu.

Transmits the custom reboot command sequence
configured for the active session.

The session connection will be disconnected and a
based on a configured delay, the session will attempt to
re-establish its connection.

Removes all data from the data window in the active
session.

Removes all data from the data window above the
cursor position.

(Note: This option is only available in the Standard
Terminal Mode.)

Removes all buffered / cached commands from the co
mmand bar in the active session.
Copies any selected text in the data window to the

system clipboard.

Pastes text from the system clipboard directly to the
connected session in the active session window.



Find

Find Next

Find Previous

Goto Line

Data Format

Advanced

Session Selected Text Menu

Send to Active Session
Send to All Open Sessions

Send to Cormmand Bar

Bf &Ll Bl

Send to Data Converter

*E Add to Command Macros
Add to Command Library
% Add to Command Repeater

Name

Send to Active Session

Send to All Open Sessions

Send to Command Bar

Send to Data Converter

Add to Command Macros

Add to Command Library

Prompts the user for text to search for in the session
data window.

After submitting the text query, Indigo will search for the
text within the data.

Attempts to find the next occurrence of the user
provided search query text.

Attempts to find the previous occurrence of the user
provided search query text.

Prompts the user for a line number and then jump the
cursor directly to that line number.
(Only available in Standard Terminal Mode)

Opens the data format sub-menu.

Opens the advanced (tools) session sub-menu.

Description

Transmits the selected text to the current active
terminal session.

Transmits the selected text to all open terminal
sessions.

Copies the selected text to the command bar in the
current active session window.

Sends the selected text to the data converter tool
where it will get converted into the selected data
format.

Copies the selected text and add the text as a new com
mand macro.

Copies the selected text and add the text as a new com
mand library command entry.



Add to Command Repeater Copies the selected text and add the text as a new com
mand repeater command entry.

Session Data Format Menu

[A] Ascii
|E| Asciiwy Control Codes
|E| Hexadecimal
|E| Hex wy Control Codes
@ Decimal
@ Cictal
Binary
M Mixed Ascii/Hex
@ Custom
|I| Byte Analysis
Name Description
ASCII Applies the selected data byte formatting to the active
session.
ASCIl w/ Control Codes Applies the selected data byte formatting to the active
session.
Hexadecimal Applies the selected data byte formatting to the active
session.
Hexadecimal w/ Control Codes Applies the selected data byte formatting to the active
session.
Decimal Applies the selected data byte formatting to the active
session.
Octal Applies the selected data byte formatting to the active
session.
Binary Applies the selected data byte formatting to the active
session.
Mixed ASCII/Hex Applies the selected data byte formatting to the active
session.
Custom Applies the selected data byte formatting to the active

session.



Byte Analysis

Byte Grouping

Session Advanced (Tools) Menu

‘E:} Reboot
4'=_' Pazz Mode

8 Log Data ToFile

bl Local Echo

" Pause Incoming Data

[T] Broadcast Send Commands
Z] Transmit Break Signal

5® Transmit Control Code

Edit Session Properties

Name

Reboot

Pass Mode

Log Data To File

Local Echo

Pause Incoming Data

Applies the selected data byte formatting to the active
session.

Sets the byte size representation (BYTE, WORD,
DWORD) for displaying bytes in the following formats:

Decimal
Hexadecimal
Octal

Binary

Description

Transmits the custom reboot command sequence
configured for the active session.

The session connection will be disconnected and a
based on a configured delay, the session will attempt to
re-establish its connection.

Opens the pass mode configuration dialog allowing to
configure and enable serial pass mode.

(Note: This option is only available when connected via
serial: RS232, RS422, RS485.)

Opens the session logging tool to configure and start
data logging for the active session.

If enabled, this option will print (echo) any data
commands transmitted to the data window in the active
session.

Pauses all inbound data from the connection on the
active session window.

(Note: This option does not buffer data, while paused,
any data received will be ignored.)



Broadcast Send Commands If this option is enabled all commands transmitted in the
active session are also broadcast and transmitted to all
other open sessions.

Transmit Break Signal Transmits a BREAK signal to the configured serial port
in the active terminal session.
(Note: This option is only available when connected via
serial: RS232, RS422, RS485.)

Transmit Control Code Opens the control code sub-menu. The selected control
code will be transmitted to the active session.

Session Properties Opens the session properties configuration user
interface for the active session.

Split Data Window

© Screencast

A screencast demonstration the split data window feature is available. Click here to see the video

If using the standard view mode you can create split views in the session data window.

Split views allow you to view two separate area of received data simultaneously.

This is especially useful when you want one view to display the stream of newly received data and the other view to
remain fixed to a specific set if previously captured data lines.

If you are familiar with the locked rows concept in Microsoft Excel, this is a similar concept.

Indigo supports both horizontal split views and vertical split view.

To enable a split screen view, first select the splitter drag bar above the vertical scrollbar or to the left of the
horizontal scrollbar and hold down the left mouse button.
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With the left mouse button held down, drag the splitter either down or to the right to create the split window.
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When you have the size of the split window you like, release the mouse button.
(You can re-select the drag bar anytime to re-size the split windows.)
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When data is received it will be displayed in both views of the split window.
You can scroll one of the views to inspect previously received data while new data streams into the other view.
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Whichever split view text area last receives cursor focus is the active view where new data is updated and
automatically brought into view.

You can also use the Split Horizontal or Split Vertical menu options in the Windows menu to automatically split the
data window in equal proportions.

Window

[T Tile Vertically F9

B2 Tile Horizontally F10

D Cascade F11
Maximize Ctrl+Up
Mormalize Ctrl+Down
Minimize

BH Split Horizontal

B split Vertical
|=] Mext Ctrl+Right
Previous Ctrl+Left

Session Status Icons

Terminal sessions may display any status icons in the upper right corner of the session data window when needed.
You can hover over the status icon to display a tooltip with additional information or click the icon to disable to
display more options for the feature.

The listing below are the available status icons.

Status/Name Icon Description



Pause

Pass Mode

Local Echo

Logqin

Rebooting

Line Tracking

Outbound Data Buffering

Pause incoming/received data from
being rendered to the screen.
(While enabled all incoming data
from the connected session is
ignored and not rendered to the
screen.)

Click this icon to resume rendering
incoming data.

This icon is displayed when the seri
al pass mode is enabled.

Click the icon to disable serial pass
mode.

This icon is displayed when the
session's local echo feature is
enabled.

Click the icon to disable the local
echo feature.

This icon is displayed when the
session data is being actively logge
d to a file.

Click the icon to display additional
logging options or to stop logging.

|& View Log File

~ Open Log File Folder

“+3 Stop Legging to File

This icon is displayed when the
session's connection is in a reboot s
eguence.

Click the icon to stop the reboot
seguence.

This icon is displayed when the
cursor is placed in the data window
on a line of data and the session is
not longer actively tracking
(scrolling) to newly received data.
Click the icon to jump to the newest
data line and resume line tracking.
(auto-scrolling)

This icon is displayed when
outbound data is being buffered and
transmitted to the connected
session on a buffered basis.
Outbound data buffering will only be
present when the Character and
Line Delay option is enabled.



Auto Reconnect

Keyboard Redirection

Broadcasting

Client Connected

Session Properties

Open The Session Properties Editor

=1

This icon is displayed when a
session is in the disconnected state
and the auto-reconnect feature has
been enabled.

This icon represents that the
session will attempt to
auto-reconnect on a periodic basis
until a successful connection is
established.

Click this icon to disable the
auto-connect attempt. This will not
disable the auto-connect feature for
the session, just stops the
auto-reconnect on the current
disconnect cycle.

This icon is displayed in the
Terminal Emulation view mode whe
n the cursor is located inside the
data window and keystrokes are
being redirected directly to the
connected terminal session.

Click the icon to disable keyboard
redirection.

This icon is displayed when the
current session is configured to bro
adcast all its outbound command to
all open and connected terminal
sessions.

Click the icon to disable command
broadcasting.

This icon is displayed when the
current session is configured as a T
CP serverl/listener and a remote
TCP client is connected to the
session.

Click the icon to forcefully
disconnect the TCP client.

Once a terminal session has been created, you may need to edit the session properties to configure additional

connection parameters, session customization, or user preferences.
There following methods are available to access the session properties editor.

Location

Description



Session Manager

Session Menu

System Hotkey (F8)

Session Context Menu

Internal Command

In the Session Manager, you can right-click a session
by name and select the Edit Session Properties context
menu option.

With a terminal session open, you can select the Sessi
on Properties menu option under the Session menu.

With a terminal session open, you can press the F8
system hot key to open the session properties dialog.

With a terminal session open, you can right-click the
data window and access the session context menu.
The Edit Session Properties menu item is located
under the Advanced sub-menu.

With a terminal session open, you send the following
internal command to open the session properties
editor.

. properties

All session properties and user configuration options are stored in Indigo session files (*.itf) on the file system.

Session Configuration Options

Please select from the options below for more information on specific session properties.

® Connection Settings

Serial Connection Settings
Dial Up (Modem) Connection Settings

Telnet Connection Settings

SSH Connection Settings

RLOGIN Connection Settings
REXEC Connection Settings

RSH Connection Settings

ECHO Connection Settings
DAYTIME Connection Settings
CHARGEN Connection Settings
Raw TCP Client Connection Settings
Raw TCP Server Connection Settings
Raw UDP Connection Settings

Proxy Settings
Terminal Emulation Settings

Formatting Settings

Advanced Session Settings

Session Send Commands

Connection Settings

Overview

Depending on the connection type you have selected, different connection settings will be available.
Please select a connection type below to learn more about the configuration options and settings.



Serial Connection Settings

Dial Up (Modem) Connection Settings
Telnet Connection Settings

SSH Connection Settings

RLOGIN Connection Settings
REXEC Connection Settings

RSH Connection Settings

ECHO Connection Settings
DAYTIME Connection Settings
CHARGEN Connection Settings

Raw TCP Client Connection Settings
Raw TCP Server Connection Settings

Raw UDP Connection Settings

Serial Connection Settings

Serial Connection Settings

Each of the serial connection options: RS-232, RS-422, RS-485 use the same configuration dialog and settings.

Session Properties -
Connec:tionl Proxy | Terminal | Formattng | Seftings | Send Commands

— Connection Protocol

ISER[AL {R5232) | ¥ AUTO CONNECT

— Serial Settingz

Com Port: |COM1 j Data Bitz: |8 j ¥ DTR
Baud Rate: | 9500 «| StopBits: [1 vI [~ RTS

Parity: NOMNE - I Flowe Ctl MNone

L

- Dial Hayes Telephone Number: .
Compatible Modem | Hayes Setings |
— Authentication

Authentication Method: -DISABLED- 7

Wisit for Prompt: r I

UserName: I

Password: I

Private Key: (OpenSSH, Putty) | |

Key Passphrase: I

oK | Cancel |

(For more information on other session property configuration tabs, please see Session Properties.)

The following serial configuration settings are available to properly setup your device connection and terminal
session.

Setting Description


http://en.wikipedia.org/wiki/Rs232
http://en.wikipedia.org/wiki/Rs422
http://en.wikipedia.org/wiki/Rs485

Auto Connect

Com Port

Baud Rate

If this option is enabled, then the terminal session will
attempt to establish a connection immediately when
opened in Indigo.

Select the com port that is connected to the target
device you wish to communicate with.

This field will list the available serial com ports that
have been detected on this computer.

(If your com port is not listed, you can override Indigo's
automatic detection, please see the Com Ports tab in P
rogram Preferences)

Indigo supports com ports addressed up to 256.

Select the required baud rate for the device you are
connecting to.

If you are not sure what baud rate to select, please
refer to the documentation for the device you are
attempting to communicate with.

(The baud rate in Indigo must match the baud rate that
the connected device expects.)

Indigo supports the following baud rates:

Standard Edition Professional Edition

75 ¢ 128000
110 ¢ 230400
134 ® 460800
150 ® 921600
300

600 (User defined custom baud
1200 rates)
1800

2400

4800

7200

9600

14400

19200

28800

38400

57600

76900

115200

(The serial port hardware and serial drivers must
support the baud rate for Indigo to apply it successfully.

)


http://en.wikipedia.org/wiki/Baud

Parity

Data Bits

Select the required parity for the device you are
connecting to.

If you are not sure what parity to select, please refer to
the documentation for the device you are attempting to
communicate with.

(The parity in Indigo must match the parity that the
connected device expects.)

Indigo supports the following parity options:

Parity
NONE
EVEN
abb
MARK

SPACE

Select the required data bits for the device you are
connecting to.

If you are not sure what data bits to select, please refer
to the documentation for the device you are attempting
to communicate with.

(The data bits in Indigo must match the data bits that
the connected device expects.)

Indigo support the following Data Bit options:

Data Bits
4
5


http://en.wikipedia.org/wiki/Parity_(computer_science)

Stop Bits

Select the required stop bits for the device you are
connecting to.

If you are not sure what stop bits to select, please refer
to the documentation for the device you are attempting
to communicate with.

(The stop bits in Indigo must match the stop bits that
the connected device expects.)

Indigo support the following Stop Bit options:

Stop Bits
1
2



Flow Control

Select the required flow control for the device you are
connecting to.

If you are not sure what flow control to select, please
refer to the documentation for the device you are
attempting to communicate with.

(The flow control in Indigo must match the flow control
that the connected device expects.)

Indigo supports the following Flow Control options:

Flow Control Hardware Software
None

XON XOFF
(Software)l

RTS/ CTS

(Har dwar e) 2

RTS/ CTS and
XON/ XOFF

DTR/ DSR

DTR/ DSR and
XON/ XOFF

CTS/ DSR

CTS/ DSR and
XON/ XOFF

Most modern devices do not use flow control; however,
if you are using a device that required Hardware Flow
Control please make sure that you have the correct
cable connected between the computer's serial port
and the device.

Hardware flow control requires additional connected
pins and may not work with if the proper cable is not
connected. Please consult your device documentation
for details on the cabling required.

1 The most common form of software flow control is the
XON/XOFF option. If your device documentation just
says Software Flow Control, then most likely if is
referring to XON/XOFF.

2 The most common form of hardware flow control is
the RTS/CTS option. If your device documentation just
says Hardware Flow Control, then most likely if is
referring to RTS/CTS.


http://en.wikipedia.org/wiki/Software_flow_control
http://en.wikipedia.org/wiki/Software_flow_control
http://en.wikipedia.org/wiki/RS-232_RTS/CTS#RTS.2FCTS_handshaking
http://en.wikipedia.org/wiki/RS-232_RTS/CTS#RTS.2FCTS_handshaking

DTR

RTS

Dial Hayes Compatible Modem

Telephone Number

If you wish to force the Data Terminal Ready pin to the
ON/OFF state, then you can enable/disable this
configuration setting.

If using hardware flow control option with DTR, then
this override setting may not be applied since DTS is
part of the hardware flow control logic.

If you wish to force the Request To Send pin to the
ON/OFF state, then you can enable/disable this
configuration setting.

If using hardware flow control option with RTS, then
this override setting may not be applied since RTS is
part of the hardware flow control logic.

This feature is only available in the Professional
Edition.

If this option is enabled, then the Indigo Terminal
Session will attempt to communicate to a Hayes
Compatible modem via the serial port to dial a remote
connection using a telephone line.

If enable, then a telephone number must be provided.

If your modem is recognized by Windows as a
TAPI-compliant modem, then using the Indigo Dial-Up
connection may be a simpler method for creating a
dial-up connection terminal session.

This feature is only available in the Professional
Edition.

If the Dial Hayes Compatible Modem option is
enabled then a telephone number must be provided to
establish a modem connection to a remote host.


http://en.wikipedia.org/wiki/Data_Terminal_Ready
http://en.wikipedia.org/wiki/RTS/CTS_(disambiguation)
http://en.wikipedia.org/wiki/Hayes_compatible
http://en.wikipedia.org/wiki/Hayes_compatible

Hayes Settings This feature is only available in the Professional

Edition.

If the Dial Hayes Compatible Modem option is
enabled then this configuration button will be available
to configure custom modem initialization and answer
strings as well as tone versus pulse dialing options.

Hayes Compatible Modem Settings

IModem Init String:

|EIEDL1M".‘IQG‘J1&C1&32551

rezet
Modem Answer iring:
|AIA |

rezet
[ Wvait for dial tone before digling;
{* Tone Dialing
" Pulze Dialing

oK Cancel

(&)

Serial Connection Authentication Options

When using a serial connection, Indigo can provide an option for automated password authentication. Serial
communication does not have an intrinsic support for authentication so this is a complete software implementation

feature.
Authentication
Authentication Method: |F‘asswurd (manual} j
VWait for Prompt: ~ |L|:|gin »
UserName: |r|:u:|t
Password: |”""“""”"’Ht
Private Key: (OpenSSH, Putty) | J

Key Passphraze: |

Setting Description



Authentication Method This option allows you to set the session authentication
method. For serial connections, Indigo supports the
following options:

Authentication Method  Description

None No authentication
method is applied.

Password (manual) Indigo will attempt to
manually send user
credentials based on the
remaining authentication
settings.

(This is a simple
software only
implementation, not a
communication protocol
level authentication
negotiation.

Indigo will send user
credentials at the time of
connection based on the
Wait for Prompt

property.)

Wait for Prompt If this wait for prompt option is enabled, Indigo will wait
until the prompt text is received before sending user
credentials to the connected session.

If this option is not enabled, then Indigo will
automatically attempt to send user credentials when
the connection is established.

Username This is the user name text that Indigo will submit when
attempting to authenticate.

Password This is the password text that Indigo will submit when
attempting to authenticate.

Dial Up (Modem) Connection Settings

Dial Up (Modem) Connection Settings

The screenshot below depicts the Dial Up (Modem) connection settings.



http://en.wikipedia.org/wiki/Modem

Session Properties -

Proxy
Connection Protocol

Dial Up (Modem) -

Dial-Up Settingz

Connection Terminal Formatting Settings

[ AUTO COMMNECT

]

Send Commands

Modem / TAPI Device:  [LL.5. Rabatics V.92 USE Modsm

=]

(" Dial Number: |1-888-5E:3-0000

{+ Listen for incoming calls

Cancel

(For more information on other session property configuration tabs, please see Session Properties.)

The following Dial Up (Modem) configuration settings are available to properly setup your device connection and

terminal session.

Setting

Auto Connect

Description

If this option is enabled, then the terminal session will
attempt to establish a connection immediately when
opened in Indigo.



Modem / TAPI Device The modem with which you wish to use to establish the
connection should be selected here.
The modem must support a TAPI compliant windows
modem driver for Indigo to use the modem for the
connection.
(Indigo enumerates the available modems at program
start up. If your modem was installed after starting
Indigo, you may need to restart Indigo.)

Tip

You can use the RS-232 serial
connection option and the Hayes
modem support if you are using a
Hayes-compatible modem and your
modem does not have a TAPI
complaint driver installed in
Windows.

Please see the Serial Connection
Settings for more information on the
Hayes modem configuration
properties.

Dial Number This option can be enabled if Indigo should make an
outgoing call using the selected modem.
If enabled, then this field must contain the telephone
number that the modem should dial.

Listen for incoming calls This option can be enabled if Indigo should listen for
incoming calls using the selected modem.

Dial Up (Modem) Connection Authentication Options

When using a Dial Up (Modem) connection, Indigo does not provide automated user authentication.
If user authentication is required, the logon request should be prompted in the session window after the modem
establishes a connection.

Telnet Connection Settings

Telnet Connection Settings

The screenshot below depicts the TELNET connection settings.


http://en.wikipedia.org/wiki/Telnet

Session Properties -
Connection | Proxy | Terminal Formatting

Connection Protocol

TELMET -

TELNET Settings

Send Commands

[ AUTO COMMNECT

]

TELMET Host |m'_grhust.|:umpﬂn',r.|:um

TELNET Port |rj (default is 23) Active Telnet Negotiation [
Authentication
Authentication Method: |—|}I5AEILED— ﬂ
[+ |chin =
UzerName: |r|:|:t
Pas=word: FrTTT

Private Key: (OpenSSH, Putty) |

Key Passphrase: |

Cancel |

(For more information on other session property configuration tabs, please see Session Properties.)

The following Telnet configuration settings are available to properly setup your device connection and terminal

session.
Setting

Auto Connect

Telnet Host

Telnet Port

Description

If this option is enabled, then the terminal session will
attempt to establish a connection immediately when
opened in Indigo.

The telnet server/host should be provided in this
configuration field.

This entry can be an IP address, computer name, or
DNS hostname.

The telnet server/host port can be used if a custom
telnet port must be provided.
(The default port for the Telnet protocol is port 23.)



Active Telnet Negotiation

Telnet Connection Authentication Options

In a Telnet connection, there are two types of data
passed between the client and the server/host: actual
text, and telnet negotiations for Telnet protocol specific
extra features.

Indigo can use two different strategies for negotiation:

Telnet Negotiation Description

Active In active mode, Indigo
starts to send
negotiations as soon as
the connection is
established.

Passive (Inactive) In passive mode, Indigo
will wait to negotiate until
it first sees a negotiation
from the server/host.

Indigo defaults to Active Telnet Negotiation because if
both Indigo and the server/host are operating in a
passive mode, then the telnet negotiation will never
take place.

However, passive mode is sometimes required in order
to successfully get through certain types of firewall and
Telnet proxy server. If you have trouble establishing a
Telnet connection through a firewall, you could try
disabling active mode to see if it helps.

When using a Telnet connection, Indigo can provide two options for automated password authentication.
(The Telnet protocol intrinsically supports authentication as part of the protocol.)

Authentication Method: |F‘asswurd (connection)

E

v |Lc§in =

Authentication
UserName: |r|:| ot
Password: |********

Private Key: (OpensSH, Putty |

-

Key Passphrase: |



Authentication

Authentication Method: |F‘asswurd (manual}

Wait for Prompt; ¥ |Login =
UserName: |r|:u:|t
Password: |********

Private Key: (OpenSSH, Putty |

-

Key Passphrase: |

Setting

Authentication Method

Description

This option allows you to set the session authentication
method. For Telnet connections, Indigo supports the

following options:

Authentication Method

None

Password (connection)

Password (manual)

Description

No authentication
method is applied.

Use this option to
provide basic username
and password
credentials to the telnet
server/host.

(This is a protocol based
implementation, where
the user credentials are
negotiated as part of the
telnet protocol at the
time of connection.)

Use this option to
provide basic username
and password
credentials to the telnet
server/host.

(This is a simple
software only
implementation, not a
communication protocol
level authentication
negotiation.

Indigo will send user
credentials at the time of
connection based on the
Wait for Prompt property.

)



Wait For Prompt

Username

Password

SSH Connection Settings

SSH Connection Settings

If this wait for prompt option is enabled, Indigo will wait
until the prompt text is received before sending user
credentials to the connected session.

If this option is not enabled, then Indigo will
automatically attempt to send user credentials when
the connection is established.

(This option is only available when using the Password
(manual) authentication method.)

This is the user name text that Indigo will submit when
attempting to authenticate.

This is the password text that Indigo will submit when
attempting to authenticate.

Each of the Secure Shell connection options: SSH1, SSH2, SSH AUTO use the same configuration dialog and

settings.

Session Properties -

Proxy
Connection Protocol

SSH Auto |

S5H Auto Settings

Connection Terminal Formatting

]

Settings Send Commands

[ AUTO COMMNECT

S5H Auto Host |myhust.u:umpﬂn',r.cum

SSH Auto Port |22 j (default iz 22)

Authentication
Authentication Method:

-DISABLED- -

[+ |chin =

UserName: |r|:|:t

ki

Password:

Private Key: (OpenSSH, Putty)

]

Key Passphrase: |

oK Cancel |

(For more information on other session property configuration tabs, please see Session Properties.)

The following SSH configuration settings are available to properly setup your device connection and terminal

session.


http://en.wikipedia.org/wiki/Secure_Shell

Setting Description

Auto Connect If this option is enabled, then the terminal session will
attempt to establish a connection immediately when
opened in Indigo.

SSH Host The SSH server/host should be provided in this
configuration field.
This entry can be an IP address, computer name, or
DNS hostname.

SSH Port The SSH server/host port can be used if a custom SSH
port must be provided.
(The default port for the SSH protocol is port 22.)

SSH Connection Authentication Options

When using a SSH connection, Indigo can provide an option for automated password authentication.
(The SSH protocol intrinsically supports authentication as part of the protocol.)

Authentication
Authentication Method: |Passwurd (connection) j
[ |chin =
UsertName: |r|:u:|t
Password: |*‘“‘*‘“‘*‘*
Private Key: (OpenSSH, Putty) | J
Key Passphrase: |
Authentication
Authentication Method: |F'ri-.rate Key & Password ﬂ
[+ |Login
Userhame: |root
Pazsword: |”"""""”"’Ht
Private Key: (OpenSSH, Putty) | ]

Key Pazephraze; |

Setting Description



Authentication Method This option allows you to set the session authentication
method. For SSH connections, Indigo supports the
following options:

Authentication Method  Description

None No authentication
method is applied.

Password (connection) Use this option to
provide basic username
and password
credentials to the SSH
server/host.

(This is a protocol based
implementation, where
the user credentials are
negotiated as part of the
SSH protocol at the time
of connection.)

Private Key Use this option when
required to use private
key encryption to
connect to the SSH
server/host.

Private Key & Password  Use this option when
required to use private
key encryption and user
credentials to connect to
the SSH server/host.

Username This is the user name that Indigo will provide when
authenticating with the SSH server/host.
(This option is only available when using the Password
or Private Key & Password authentication methods)

Password This is the password that Indigo will provide when
authenticating with the SSH server/host.
(This option is only available when using the Password
or Private Key & Password authentication methods)

Private Key This option allow you to select the private key file
(*.PPK) to be used when negotiating authentication
with the SSH server/host.

(This option is only available when using the Private
Key or Private Key & Password authentication methods

)



Key Passphrase

RLOGIN Connection Settings

RLOGIN Connection Settings

This option allow you to provide a private key
passphrase to be used when negotiating authentication
with the SSH server/host.

This field can remain empty if your private key file does
not require a passphrase.

(This option is only available when using the Private
Key or Private Key & Password authentication methods

)

The screenshot below depicts the Remote Login (RLOGIN) connection configuration dialog and settings.

Session Properties -

Connection | Proxy | Terminal Formatting

Connection Protocol

RLOGIN |

RLOGIN Settings

Settings

=]

Send Commands

[+ AUTO COMMNECT

RLOGIN Host |rrr'_,rhust.|:umpan1,r.cum
= i 5143

RLOGIMN Port 514 = (default iz 514}
Cormmand To |
Execute:
Authentication

Authentication Method: |-D-I5AEILED— ﬂ

I+ |chin >
UserName: |rcct

Password: | vvvvvv

Private Key: (OpenSSH, Putty) |

]

Kev Passphrase: |

oK Cancel |

(For more information on other session property configuration tabs, please see Session Properties.)

The following RLOGIN configuration settings are available to properly setup your device connection and terminal

session.

Setting

Auto Connect

Description

If this option is enabled, then the terminal session will
attempt to establish a connection immediately when
opened in Indigo.


http://en.wikipedia.org/wiki/Rlogin

RLOGIN Host The RLOGIN server/host should be provided in this
configuration field.
This entry can be an IP address, computer name, or
DNS hostname.

RLOGIN Port The RLOGIN server/host port can be used if a custom
RLOGIN port must be provided.
(The default port for the RLOGIN protocol is port 514.)

Command To Execute This command instruction will be automatically sent to
the server/host when a connection is established.

RLOGIN Connection Authentication Options

When using a RLOGIN connection, Indigo can provide an option for automated password authentication.
(The RLOGIN protocol intrinsically supports authentication as part of the protocol.)

Authentication
Authentication Method: |F‘asswurd (connection) ﬂ
v |L:gir #
UserName: |r|:u:|t
Password: |********

Private Key: (OpensSH, Putty |

Key Passphrase: |

Setting Description

Authentication Method This option allows you to set the session authentication
method. For RLOGIN connections, Indigo supports the
following options:

Authentication Method  Description

None No authentication
method is applied.

Password (connection) Use this option to
provide basic username
and password
credentials to the
RLOGIN server/host.
(This is a protocol based
implementation, where
the user credentials are
negotiated as part of the
RLOGIN protocol at the
time of connection.)

Username This is the user name that Indigo will provide when
authenticating with the RLOGIN server/host.



Password

REXEC Connection Settings

REXEC Connection Settings

This is the password that Indigo will provide when
authenticating with the RLOGIN server/host.

The screenshot below depicts the Remote Process Execution (REXEC) connection configuration dialog and

settings.

Session Properties -

Proxy
Connection Protocol

Connection Terminal Formatting

-

REXEC

REXEC Settings

]

Settings Send Commands

[+ AUTO COMMNECT

REXEC Host |rrr'_,rhust.|:u Mpany.com
(=] i E17

REXEC Port 512 = (default i= 512}
Command To |
Execute:
Authentication

Authentication Method: -DISABLED- -

[+ |Login =
UserName; |r|:|:t

EEREREEE

Password:

Private Key: (OpenSSH, Putty) |

]

Key Passphrase; |

Cancel |

(For more information on other session property configuration tabs, please see Session Properties.)

The following REXEC configuration settings are available to properly setup your device connection and terminal

session.

Setting

Auto Connect

REXEC Host

Description

If this option is enabled, then the terminal session will
attempt to establish a connection immediately when
opened in Indigo.

The REXEC server/host should be provided in this
configuration field.

This entry can be an IP address, computer name, or
DNS hostname.


http://en.wikipedia.org/wiki/Rexec

REXEC Port The REXEC server/host port can be used if a custom R
EXEC port must be provided.
(The default port for the REXEC protocol is port 512.)

Command To Execute This command instruction will be automatically sent to
the server/host when a connection is established.

REXEC Connection Authentication Options

When using a REXEC connection, Indigo can provide an option for automated password authentication.
(The REXEC protocol intrinsically supports authentication as part of the protocol.)

Authentication
Authentication Method: |F'asswurd (connection) ﬂ
[+ |Login
Userhame: |root
Password: |********

Private Key: (OpenSSH, Putty) | J

Key Paszphrase: |

Setting Description

Authentication Method This option allows you to set the session authentication
method. For REXEC connections, Indigo supports the
following options:

Authentication Method  Description

None No authentication
method is applied.

Password (connection) Use this option to
provide basic username
and password
credentials to the REXE
C server/host.

(This is a protocol based
implementation, where
the user credentials are
negotiated as part of the
REXEC protocol at the
time of connection.)

Username This is the user name that Indigo will provide when
authenticating with the REXEC server/host.

Password This is the password that Indigo will provide when
authenticating with the REXEC server/host.

RSH Connection Settings



RSH Connection Settings

The screenshot below depicts the Remote Shell (RSH) connection configuration dialog and settings.

Session Properties -

Proxy
Connection Protocol

Connection Terminal Formatting

]

Settings Send Commands

Authentication Method:

RSH ﬂ ¥ AUTO CONNECT
RSH Settings
RSH Host |rrr'_,rhust.|:umpan1,r.|:um
RSH Port 513 j (defautt is 513)
Command To |
Execute:
Authentication

-DISABLED- -

[+ |chin =

UserName; |r|:|:t

EEREREEE

Password:

Private Key: (OpenSSH, Putty) |

]

Key Passphrase; |

Cancel |

(For more information on other session property configuration tabs, please see Session Properties.)

The following RSH configuration settings are available to properly setup your device connection and terminal

session.
Setting

Auto Connect

RSH Host

RSH Port

Description

If this option is enabled, then the terminal session will
attempt to establish a connection immediately when
opened in Indigo.

The RSH server/host should be provided in this
configuration field.

This entry can be an IP address, computer name, or
DNS hostname.

The RSH server/host port can be used if a custom RSH
port must be provided.
(The default port for the RSH protocol is port 513.)


http://en.wikipedia.org/wiki/Remote_shell

Command To Execute This command instruction will be automatically sent to
the server/host when a connection is established.

RSH Connection Authentication Options

When using a RSH connection, Indigo can provide an option for automated password authentication.
(The RSH protocol intrinsically supports authentication as part of the protocol.)

Authentication
Authentication Method: |F‘asswurd {connection} ﬂ
[¥ |Login =
Userhame: |root
Password: |********

Private Key: (DpenSSH, Putty) | J

Key Passphrase; |

Setting Description

Authentication Method This option allows you to set the session authentication
method. For RSH connections, Indigo supports the
following options:

Authentication Method  Description

None No authentication
method is applied.

Password (connection) Use this option to
provide basic username
and password
credentials to the RSH s
erver/host.

(This is a protocol based
implementation, where
the user credentials are
negotiated as part of the
RSH protocol at the time
of connection.)

Username This is the user name that Indigo will provide when
authenticating with the RSH server/host.

Password This is the password that Indigo will provide when
authenticating with the RSH server/host.

ECHO Connection Settings

ECHO Connection Settings

The screenshot below depicts the ECHO connection configuration dialog and settings.



http://en.wikipedia.org/wiki/Echo_Protocol

Session Properties -

Connection | Proxy | Terminal Formatting

Connection Protocol

ECHO -

ECHO Settings

Settings

[ AUTO COMMNECT

Send Commands

]

ECHO Host |m'_grhust.|:umpﬂn',r.|:um
ECHO Fort 7 j (default is 7)

Cancel

(For more information on other session property configuration tabs, please see Session Properties.)

The following ECHO configuration settings are available to properly setup your device connection and terminal

session.

Setting

Auto Connect

ECHO Host

ECHO Port

ECHO Connection Authentication Options

Description

If this option is enabled, then the terminal session will
attempt to establish a connection immediately when
opened in Indigo.

The ECHO server/host should be provided in this
configuration field.

This entry can be an IP address, computer name, or
DNS hostname.

The ECHO server/host port can be used if a custom
ECHO port must be provided.
(The default port for the ECHO protocol is port 7.)

When using an ECHO connection, Indigo does not provide automated user authentication.

DAYTIME Connection Settings



DAYTIME Connection Settings

The screenshot below depicts the DAYTIME connection configuration dialog and settings.

Session Properties -
Connection | Proxy | Terminal Formatting

Connection Protocol
patve 4

DAYTIME Settings

Settings

[+ AUTO COMMNECT

Send Commands

]

DAYTIME Host  |myhost.company.com

DAYTIME Port |13 ill default is 13}

Cancel

(For more information on other session property configuration tabs, please see Session Properties.)

The following DAYTIME configuration settings are available to properly setup your device connection and terminal

session.

Setting

Auto Connect

DAYTIME Host

DAYTIME Port

DAYTIME Connection Authentication Options

Description

If this option is enabled, then the terminal session will
attempt to establish a connection immediately when
opened in Indigo.

The DAYTIME server/host should be provided in this
configuration field.

This entry can be an IP address, computer name, or
DNS hostname.

The DAYTIME server/host port can be used if a custom
DAYTIME port must be provided.
(The default port for the DAYTIME protocol is port 13.)


http://en.wikipedia.org/wiki/DAYTIME

When using an DAYTIME connection, Indigo does not provide automated user authentication.

CHARGEN Connection Settings

CHARGEN Connection Settings

The screenshot below depicts the Character Generator (CHARGEN) connection configuration dialog and settings.

Session Properties - =]
Connection | Proxy | Terminal Formatting Settings Send Commands

Connection Protocol

CHARGEN - v AUTO COMMNECT

CHARGEN Settings

CHARGEN Host |myhost.company.com

CHARGEN Port |19 ill default iz 19)

oK Cancel

(For more information on other session property configuration tabs, please see Session Properties.)

The following CHARGEN configuration settings are available to properly setup your device connection and terminal
session.

Setting Description

Auto Connect If this option is enabled, then the terminal session will
attempt to establish a connection immediately when
opened in Indigo.

CHARGEN Host The CHARGEN server/host should be provided in this
configuration field.
This entry can be an IP address, computer name, or
DNS hostname.


http://en.wikipedia.org/wiki/CHARGEN

CHARGEN Port

CHARGEN Connection Authentication Options

The CHARGEN server/host port can be used if a
custom CHARGEN port must be provided.
(The default port for the CHARGEN protocol is port 13.)

When using an CHARGEN connection, Indigo does not provide automated user authentication.

Raw TCP Client Connection Settings

Raw TCP Client Connection Settings

The screenshot below depicts the RAW-TCP-Client connection configuration dialog and settings.

Session Properties -

Proxcy
Connection Protocol

RAW-TCP-Client -

RAW-TCP-Client Settings

Connection Terminal Formatting

Settings

[v AUTO COMMECT

[&]

Send Commands

RAW-TCP-Client |myhest.company.com

RAV-TCP-Client |0 ill default iz 0}

LCancel

(For more information on other session property configuration tabs, please see Session Properties.)

The following RAW-TCP-Client configuration settings are available to properly setup your device connection and

terminal session.

Setting

Auto Connect

Description

If this option is enabled, then the terminal session will
attempt to establish a connection immediately when
opened in Indigo.


http://en.wikipedia.org/wiki/Transmission_Control_Protocol

The RAW-TCP-Client server/host should be provided in

this configuration field.
This entry can be an IP address, computer name, or

DNS hostname.

RAW-TCP-Client Host

The RAW-TCP-Client server/host port should be used

RAW-TCP-Client Port
to provide the specific remote TCP port to connect to.

Raw TCP Client Connection Authentication Options

When using an RAW-TCP-Client connection, Indigo does not provide automated user authentication.
Raw TCP Server Connection Settings

Raw TCP Server Connection Settings

The screenshot below depicts the RAW-TCP-Server connection configuration dialog and settings.

Session Properties - ]
Connection | Proxy | Terminal Formatting Settings Send Commands
Connection Protocol
RAW-TCP-Server - v AUTO CONMECT
RAW-TCP-Server Connection Settings
IP Address / Hostname: TCP Port:
Listener Address: [« =l
| soel o
| Display sender information for each TCP packet
(Enter the "= character in the address field to use local computers IP address.
oK Cancel

(For more information on other session property configuration tabs, please see Session Properties.)

The following RAW-TCP-Server configuration settings are available to properly setup your device connection and
terminal session.

Setting Description


http://en.wikipedia.org/wiki/Transmission_Control_Protocol

Auto Connect

Listener Address

Listener Port

If this option is enabled, then the terminal session will
attempt to establish a connection immediately when

opened in Indigo.

This field must contain the IP address or computer
hostname on which the TCP server should host a

listener socket.

Special Listener
Names

*

127.0.0.1

| ocal host

Description

If an asterisk character is
listed as the listener
address, then Indigo will
apply the computer's
default IP address.

(If your computer
supports multiple NICs
or IP addresses, you
may need to distinctly
specify which address
you want to listen on.)

This address represents
the local machine and
only processes running
on this computer can
access this listener
address.

This address represents
the local machine and
only processes running
on this computer can
access this listener
address.

(This is identical to the
127.0.0.1 address, just
an alternate friendly
name representation.)

This field must contain the IP port number on which the
TCP server should host a listener socket.

This port must be an available, unused TCP port on the
computer where Indigo is running.



Display Sender Info If this option is enabled, then Indigo will include a
sender's IP address and port on each packet of data
received in the Standard Terminal View Mode.

See screenshot below for example:

ﬁMySessionName E
[127.8.8.1:38748]
[127.8.8.1:38748]
[127.8.8.1:38748]
[127.8.8.1:38748]
[127.8.8.1:38748]
[127.8.8.1:38748]
[127.8.8.1:38748]
[127.8.8.1:38748]
[127.8.8.1:38748]
[127.8.8.1:38748]

o =MH=m

N ot

2 - | sl -@

Raw TCP Server Connected Client

When using an RAW-TCP-Server connection, and a client has successfully connected to the TCP socket server,
Indigo will display a small connection icon in the upper right corner of the terminal session window.

You can hover of this icon when the mouse pointer to reveal a tooltip with the connect client's details.

You can click this icon to forcefully disconnect the client socket.

A TCP client is connected to this socket server on port: 8081

TCP Client Address: 127001
TCP Client Port: 30794

(Click this icon to disconnect this client.)

ﬁ My Session Name EI

f
| WS

LR I -l -E-A

Raw TCP Server Connection Authentication Options

When using an RAW-TCP-Server connection, Indigo does not provide user authentication.



Raw UDP Connection Settings

Raw UDP Connection Settings

The screenshot below depicts the RAW-UDP connection configuration dialog and settings.

Session Properties - My Session Mame

Proxcy
Connection Protocol

RAW-LUDP -

RAW-UDP Connection Settings
IP Address / Hostname:

Connection Terminal Formatting

Settings

v AUTO COMMNECT

UDP Port:

]

Send Commands

Remote Host: I*

Listener Address: |*

Cancel

(For more information on other session property configuration tabs, please see Session Properties.)

The following RAW-UDP configuration settings are available to properly setup your device connection and terminal

session.

Setting

Auto Connect

Remote Host Address

Remote Host Port

Description

If this option is enabled, then the terminal session will
attempt to establish a connection immediately when
opened in Indigo.

This field should contain the IP address or computer
hostname to which the UDP sender should send UDP
packets to.

This field should contain the UDP port number to which
the UDP sender should send UDP packets to.


http://en.wikipedia.org/wiki/User_Datagram_Protocol

Listener Address

Listener Port

This field may contain the IP address or computer
hostname on which the UDP listener should open a

listener socket.

Special Listener
Names

*

127.0.0.1

| ocal host

Description

If an asterisk character is
listed as the listener
address, then Indigo will
apply the computer's
default IP address.

(If your computer
supports multiple NICs
or IP addresses, you
may need to distinctly
specify which address
you want to listen on.)

This address represents
the local machine and
only processes running
on this computer can
access this listener
address.

This address represents
the local machine and
only processes running
on this computer can
access this listener
address.

(This is identical to the
127.0.0.1 address, just
an alternate friendly
name representation.)

(Set the UDP listener port to "0" to disable the UDP

listener.)

This field must contain the UDP port number on which
the UDP listener should host a listener socket.

This port must be an available, unused UDP port on
the computer where Indigo is running.

(Set the UDP listener port to "0" to disable the UDP

listener.)



Display Sender Info If this option is enabled, then Indigo will include a
sender's IP address and port on each packet of data
received in the Standard Terminal View Mode.

See screenshot below for example:

i

ﬁMySessionName E
[127.8.8.1:38748]
[127.8.8.1:38748]
[127.8.8.1:38748]
[127.8.8.1:38748]
[127.8.8.1:38748]
[127.8.8.1:38748]
[127.8.8.1:38748]
[127.8.8.1:38748]
[127.8.8.1:38748]
[127.8.8.1:38748]
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Raw UDP Connection Authentication Options

When using an RAW-UDP connection, Indigo does not provide user authentication.

Proxy Settings

Overview

The Proxy tab in the Session Properties editor tab is used to configure Indigo to communicate via a network proxy
server.

If your environment requires a proxy server for an outbound network connection, this proxy configuration may be
required.
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Session Properties - <QC= C1,115200,M,8,1

Connection  Proxy | Terminal Formatting Settings
Proxy Options

Proxy Type:

|s0CKs 5 |

Hostname Port:

|myproxyserver.company.com | 80

Lol

Username:

liohndoe

Password:

[rreeee

Send Commands

]

Cancel

Proxy Server Settings

The settings listed below are required to configure Indigo for your proxy server connection.

Setting

Proxy Type

Hostname/Address
Port
Username

Password

Description

Proxy server type/protocol

Supported Proxy Types
NONE

SOCKS 4

SOCKS 4a

SOCKS 5

STANDARD

RELAY

Proxy server IP address, hostname, or DNS.
Proxy server TCP/IP port.
Proxy server user name.

Proxy server user password.


http://en.wikipedia.org/wiki/SOCKS#SOCKS
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Terminal Emulation Settings

Overview

The Terminal tab in the Session Properties editor tab is used to configure the terminal emulation session properties.
If your device/server/host requires the use of a terminal emulation protocol, then the terminal emulation configuration
can be applied here.

Session Properties - <QC= C1,115200,M,8,1 =]

Connection Proxy  Terminal Formatting Settings Send Commands

Direct Terminal Emulation Opticns
Emulation Type: |"-"T1 00 j
Report Terminal Type to Host: | vi100 j

Backiog; 100 =

Receive Data in Polled Mode (instead of Event mode)

Send DEL on Backspace Key  Control-7 {127}

Ignore AMS| Formatting (Strip ANSI Escape Codes)

Reweal ASNI Ezcape Codes in raw terminal window and log files.
Prewent Keyboard Redirection in Direct Terminal Mode/\Vindow
Use underline cursor style instead of block cursor style

I M A A N

Terminal Window Rows:

+ Auto Scale Mumber of Rows Rows:

(" Fixed Number of Rows 23 :||

Terminal Window Columns:

{+ Auto Set Number of Columns Columns:

" Fixed Number of Columns &0 j

LCancel

Terminal Emulation Types

Indigo supports the following terminal emulation types.
More information on the terminal emulation support in Indigo can be found here.

Terminal Emulation Types (Protocol) Report to Terminal Type (Default)
None none

ANSI ANSI

VT100 vt 100

Linux linux | xterm

Terminal Emulation Properties


http://help.shadeblue.com/display/indigo/Session+Properties
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The settings listed below are available to configure the terminal emulation settings/behavior for your terminal

session.

Setting

Emulation Type

Report Terminal Type to Host

Backlog

Receive Data in Polled Mode

Send DEL on Backspace key

Description

Select the terminal emulation type/protocol that Indigo
should use for this terminal session.

The list of available terminal emulation types is listed a
bove.

When Indigo connects to a device or host using a
terminal emulation protocol, Indigo can send a terminal
type identifier to the host to help negotiate the
supported and preferred emulation protocol to be
applied.

When you select an emulation type, a reporting
terminal type identifier will be automatically applied
based on the emulation type selected.

You can override this settings with another type from
the list or by manually typing an identifier string into the
field.

When using the Terminal Emulation view mode, the
session data window supports a backlog to record
previous lines of data.

The number of lines to maintain in the backlog can be
configured using this property.

(Standard view mode does not use the backlog as it
supports a continuous listing of scrolled lines of data.)

This is a special setting that controls how Indigo
collects data from the remote host. Typically Indigo
uses an event model to process data as soon as the
information is available.

If this setting is enabled, Indigo will sample and process
received data at timed intervals. This settings can help
reduce CPU load by processing larger chunks of data
on a timed basis if the device/host emits frequent data
output.

This setting only applies to TELNET, SSH, RAW TCP
client, RAW TCP Server, and UDP connection
protocols.

Some remote devices/hosts do not understand the DEL
instruction byte (0X7F).

If you enable this settings, Indigo will substitute the
instruction when the DEL keyboard button is pressed (i
n the Terminal Emulation view mode) with the
BACKSPACE instruction byte (0x08).



Ignore ANSI formatting
(Strip ANSI Escape Codes)

Reveal ANSI Escape Codes
(standard view mode and log file)

Prevent Keyboard Redirection
(Terminal Emulation view mode)

User underline cursor style
instead of block cursor style

If this option is enabled, then Indigo will remove any AN
S| Escape Codes/Sequences from the data displayed
in the session data window.

This option will prevent your data from being displayed
corrected in the Terminal Emulation view mode becaus
e it is ignoring the formatting instructions.

This option would typically be used if a debugging
scenario or a case where you needed to capture the
contextual data but did not want to capture any of the
terminal emulation escape sequences.

If this option is enabled, then Indigo will display the AN
Sl Escape Codes/Sequences the data displayed in the
session data window of the Standard view mode.

By default, Indigo automatically strips these escape
codes from the Standard view mode since they are
intended as terminal instructions, not context data.
This option would typically be used if a debugging
scenario where you needed to capture the all data
including the raw terminal emulation escape
sequences/codes.

If this option is enabled, then in the Terminal Emulation
view mode, Indigo will never enable keyboard
redirection.

More information on keyboard redirection can be
obtained here.

By default Indigo uses a block sytle cursor in the
Terminal Emulation view mode.

Enabling this option will cause Indigo to use an
underline style of cursor instead.

This may be desirable/preferred for some terminal
hosts/devices.
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Terminal Window Rows

By default, in Terminal Emulation view mode, Indigo
coordinates the virtual screen size (rows and columns)

with the terminal host.

This auto sizing negotiation allow Indigo to render the
maximum number of rows based on the available

screen real estate (size).

The sizing negotiation is dependent on the host's
capability of accepting dynamic sizing.

Some device/hosts may required or prefer a fixed
number of rows to properly render data. Indigo also
supports fixed a row count option.

Setting

Auto Scale Number of
Rows

Fixed Number of Rows

Rows (count)

Description

Indigo will calculate and
negotiate with the host
the number of rows
available based on the
screen/window size.

Indigo will use a fixed
number of rows.

The number of rows to
use when configured to
use a fixed number of
rows.



Terminal Windows Columns By default, in Terminal Emulation view mode, Indigo
coordinates the virtual screen size (rows and columns)
with the terminal host.

This auto sizing negotiation allow Indigo to render the
maximum number of columns based on the available
screen real estate (size).

The sizing negotiation is dependent on the host's
capability of accepting dynamic sizing.

Some device/hosts may required or prefer a fixed
number of columns to properly render data. Indigo also
supports fixed a column count option.

Settings Description
Auto Scale Number of Indigo will calculate and
Columns negotiate with the host

the number of columns
available based on the
screen/window size.

Fixed Number of Indigo will use a fixed
Columns number of column.
Columns (count) The number of columns

to use when configured
to use a fixed number of
columns.

Formatting Settings

Overview

The Formatting tab in the Session Properties editor tab is used to configure some of the session user interface
formatting and behavior .
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Session Properties - <QC= C1,115200,M,8,1 =]

Connection Proxy | Terminal Formatting | Settings Send Commands

Line Numbering Dizplay Options

Allow Column Selection

Allow Drag and Drop

Enable Color Syntax Highlighting
Show Horizontal Scrollbar
Show Vertical Scrollear

Smooth Scrolling

Highlight Line:

Dizgplay Whitezspace

Dock Toolbar to Top

Fix Reversed < LF=<=CR=

Force Mew Line Tracking

[ Append Line Feeds to Line Ends
[ Filter Out <Null= (0x00) bytes

[ Line Mumbering
Style: DEC -

Start at: 1

I I A A

Previews Background Color

Font |

The quick brown fox jumped owver the 1azi‘

Line Numbering
The session formatting options include the ability to configure how line numbering is displayed.

Setting Description

Line Numbering A checkbox is provided to enable or disable line

numbering.
Line numbering can also be enabled or disabled via the
Edit menu.

Style/Format Line numbering can be rendered in the following data
formats:

Data Formats
BINARY
DECIMAL
HEXADECIMAL
OCTAL



Start At

Data Display Options

Line numbering can be configured to start at a specific
line number if preferred.

Typically this option is used to define the line
numbering a zero-based or one-based.

The session formatting options below include control over data and visual representations.

Setting

Allow Column Selection

Allow Drag and Drop

Enable Color Syntax Highlighting

Show Horizontal Scrollbar

Show Vertical Scrollbar

Smooth Scrolling

Highlight Line

Description

In the Standard view mode, if this option is enabled you
can hold down the CTRL key and select columns of
text.

Type control-C to interr
May the command line live fore

Command, one of the following3

ac cal
dir Fact
help ipad
newuser octa
rand stan
units uupd

In the Standard view mode, if this option is enabled you
can select text in the session data window and drag
and drop to text field in Indigo or to another application.

In the Standard view mode, if this option is enabled the
session will render colored syntax based on color

syntax filters.

In the Standard view mode, if this option is enabled the
session will display a horizontal scrollbar in the session
data window.

In the Standard view mode, if this option is enabled the
session will display a vertical scrollbar in the session
data window.

In the Standard view mode, if this option is enabled the
scrolling operations will refresh the data window at a
faster rate to make it more visually appealing.

In the Standard view mode, if this option is enabled the
session will display a line highlighter on the selected
data row.

This option can also be enabled/disabled via the Edit
menu.


http://en.wikipedia.org/wiki/Smooth_scrolling

Display Whitespace In the Standard view mode, if this option is enabled,
space characters (whitespace) display a centered dot
symbol to indicate that an empty space is present in the
data.

--Type-control-C-to-interrupt-

Hay-the-command-line-live-fore

Command,-one-of-the-following:

“rac--e-e-m-- basic------- cal-
sedir-e-eee- eliza------- fact
--help-------- hosts-=------ ipad
--newuser----- noteg------- octa

Dock Toolbar to Top In the Standard view mode, if this option is enabled the
session toolbar will be displayed at the top of the
session window instead of the bottom.
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Fix Reversed <LF><CR> Most devices/hosts output line data ending with either a
Line Feed character only or a Carriage Return followed
by a Line Feed character.

Indigo handles the rendering of these type of line

properly.

However, some device may output lines ending with a
Line Feed followed by a Carriage Return character
which is not the standard behavior.

If Indigo receives this it can cause additional line
separation/spacing in the Standard view mode.

If this option is enabled, Indigo will detect when these
line ending characters that are in the reverse order and
auto correct them so that Indigo can render the lines
correctly.

Force New Line Tracking In the Standard view mode, if this option is enabled
then all newly received data is automatically displayed
in view in the session data window.

This option will force the data window to automatically
scoll to the bottom line to display new data.

If this option is disabled, Indigo uses the standard line
tracking behavior described here.

Append Line Feeds to Line Ends Most devices/hosts output line data ending with either a
Line Feed character only or a Carriage Return followed
by a Line Feed character.

Indigo handles the rendering of these type of line

properly.

However, some device may output lines ending with
only a Carriage Return character which is not the
standard behavior.

If Indigo receives this it can cause undesired line
separation/spacing in the Standard view mode.

If this option is enabled, Indigo will detect when these
line ending characters and automatically include a line
feed so that Indigo can render the lines correctly.

Filter Out <Null> (0x00) bytes Null bytes (0x00) do not have a visual character to
properly display textual data. These null bytes can
cause undesirable characters in the data window.

If this option is enable, then Indigo will detect and filter
out all null bytes from the data stream.

Data Window Color & Font

The session formatting options below control the coloring and font Indigo uses to render the data in the session data
window.

Setting Description



Background Color

Text Color

Font

This option allow you to set the session's background
window color.

This option allow you to set the session's textual data
(foreground) color.

This option allow you to set the session's textual data
font used to render data.

When using the Terminal Emulation view mode and connected to a terminal emulation protocol
that controls background and text color, these user defined colors may be overridden.

Advanced Session Settings

Overview

The Settings in the Session Properties editor tab is used to enabled, disable, and configure some of the more
advanced tools and options for a terminal session.

The individual features/tools are listed on the left side of the screen and include check boxes to designate if the

feature is enabled or disabled.

To enable or disable a feature, you must place or remove the check from the check box in the feature listing.

Session Properties - < QC> C1,115200,M.81
Connection Proxoy

Session Settings

Terminal Formatting

Settings

]

Send Commands

Mult-Command

Internal Commands
Wariable Replacement
[w] Advanced Send Commands
[] Force Window Maximized
Command Buffer

Reboot Sequence
Terminating Character

[] Auto Line Wrap

D Post Processing Script
[ Keep Alive

Character & Line Delay
[ Timestamp

Please select an item from the

list. Upon selecting an item, a

description will be displayed in
this panel.

oK Cancel




If you select a feature in the listing, a feature description and additional feature configuration options will appear on
the right side panel.
Please select from the following feature sections for more information on each feature:

Multi-Command

Internal Commands

Variable Replacement
Advanced Send Commands
Force Window Maximized
Command Buffer

Reboot Sequence
Terminating Characters/Bytes

Auto Line Wrap
Post Processing Script

Keep Alive
Character & Line Delay

Timestamp

Multi-Command

If this option is enabled, the terminal session will support Multi-Commands.
You can also change the multi-command delimiter character on this configuration panel.

Session Settings

hlulj—Cnrrmnd Multi-Command support allows you to

Internal Commands enter more than one command on a
“ariable Replacement =ingle command line, the commands
Advanced Send Commands are seperated by a user specifisd

[] Force Window Maximized delimiter.

Command Buffer

Reboot Sequence Delimiter Character: [
Terminating Character

[] Auto Line Wirap

D Post Processing Script

[] keep Alive

Character & Line Delay

[] Timestamp

Tip

Some devices/hosts may need the use of the pipe "|" character thus you can choose to disable
the multi-command or change the multi-command delimiter to another character.

Internal Commands

The Internal Commands feature can be enabled or disabled on this configuration panel.



If the internal command processor is interfering with your terminal session, then you can disable it for the terminal
session.

— Session Settings

Multi-Command Indigo provides an extended set of
S — command functions built into the

command interpreter. If this option iz
eanbled, vou can include these
commands in macros, command

Variable Replacement
Advanced Send Commands

[[] Force Window Maximized library entries, etc. For a full list of
Command Buffer internal commands, type ™ ;7 " at the
Reboot Sequence sez=ion command line.

Terminating Character
[[] Auto Line Wrap

[[] Post Processing Script
[[] Keep Alive

Character & Ling Delay
[] Timestamp

Variable Replacement

Indigo support a variable replacement feature allowing defined variables to be included in instruction commands and
the Indigo interpreter would replaced the variables with the actual values.
This feature can be disabled for the terminal session.

— Session Settings

Mutti-Command If Wariable Replacement i enabled

Internal Commands and the Variable Manager is st to
active, the session command
Advanced Send Commands interpreter will replace any variables
D Force Window Maximized in the command string with the actual
command Buffer wvalue from Wariable Manager.

“ariables are enclosed in sguare

REbD.Dt S.Eq uenee braces to denote that it is a variable.
Terminating Character (ie. [VAR])

[[] Auto Line Wrap

[[] Post Processing Script
[[] Keep Alive

Character & Line Delay
[] Timestamp

MOTE: The Variable Manager tool must
be =et to active for variable
replacements to work !

Advanced Send Commands



Indigo supports sending instruction commands in multiple data byte representations using the Advanced Send

Commands feature.

If the advanced command syntax interferes with your terminal communication, you can disabled the feature on this

configuration panel.

—Sezsion Settings

Mutt-Command

Internal Commands
‘ariable Replacement
[] Force Window Maximized
Command Buffer
Reboot Sequence
Terminating Character
[] Auto Line Wirap

[[] Post Proceszsing Script
[] keep Alive

Character & Line Delay
[] Timestamp

Advanced Send Command Formatting
provides the capability to send
commands to vour session in multiple
data formats. The =ession command
interpreter will convert the advanced
command syntax into the proper data
bytes before sending to the active
session connection. The Advanced
Send Command format supports
ASCH, HEXADECIMAL, DECIMAL,
BINARY, OCTAL byte formats.

“'Ascii | 3Fh, 32, 111011106, 32¢ "

MOTE: Advanced Send Commands
must be enclosed in double quotes for
the command interpreter to recognize
it as an advanced send command.

Force Window Maximized

If this option is enabled, this terminal session window will always be opened in the maximized states.

—Sezsion Settings

Mutt-Command

Internal Commands
Variable Replacement
Advanced Send Commands
Command Buffer
Reboot Sequence
Terminating Character
[] Auto Line Wrap

[[] Post Proceszsing Script
[] keep Alive

Character & Line Delay
[] Timestamp

If the "Force Window Maximized™ option
is enabled, this seszion will always
open the session window in a
maximized window state.

Command Buffer




If this option is enabled, Indigo will buffer each instruction command submitted via the command bar.
Additional configuration options are available to control buffered command persistence and the auto-complete
behavior of the command bar.

Please see this page for more information on the command bar and command buffer.

Seszion Settings

Mult-Command T:& co mn'Il_Iand buffe‘; will :l:tt;;naticalr'_.r
store each command sent to the
w| Int | C d
;Ernsl RﬂmTﬂn i + session from the session command
. arable heplacemesn entry bar. vou can use the up and
":“d"’ﬂ"'z'“‘_d Send C':'!T”'_”ﬂ”ds down arrow keys to navigate through
[] Force Window Maximized the listing of previous commands or
Command Buffer click the drop-down arrow to display
Reboot Sequence the listing of previous commands.
Terminating Character
[[] Auto Line Wrap ¥ Keep Hi =l
p History 10 =
D Post Processing Script —
[[] Keep Alive
Character & Line Delay Keep History wil savelrecall the
D Timestamp commands in the command buffer each
time the =es=ion is closed/opened.
|Autu Complete Enabled ﬂ
Auto complete will attempt to find and
dizplay the previous command as you
type.
Auto Complete Options Description
Auto Complete Disabled No auto-complete is attempted on the command bar.
Auto Complete Enabled Command auto-complete is enabled on the command
bar.
Case Sensitive Auto Complete Enabled A case sensitive command auto-complete is enabled

on the command bar.

Reboot Sequence

Indigo supports a custom reboot sequence feature that can issue a reboot instruction to the connected terminal
session and then perform timed disconnect and re-connect of the session.

This configuration panel provide the reboot sequence options for the terminal session.

The custom reboot sequence can also be disabled if you have no need for it.




Session Settings

Multi-Command This property wil allow you to create
Internal Commands a custom reboot sequence for this
“ariable Replacement SESEI0N.

[w] Advanced Send Commands

[] Force Window Maximized

Command Buffer

Reboot Command:
Terminating Character |REBDDI

[] Auto Line Wirap

D Post Processing Script

[[] Keep Alive [v UseAuto Re-Connect Timer
Character & Line Delay —
[] Timestamp 3 _I second(s) to disconnect

20 j second(s) to re-connect

Terminating Characters/Bytes

Commands sent to a terminal connection automatically include a set of line terminating characters/bytes.
By default, Indigo includes both a carriage return (Ox0OD) and line feed (0x0A); however, if your device/host requires
a different set of command terminating characters/bytes, you can modify them on this configuration panel.

The character sequence can be expressed using the advanced send command syntax.




Session Properties - Serial Loopback =]
Connection Proxy | Terminal Formatting  Settings Send Commands
Session Settings

Multi-Command The command terminating character

Internal Commands sequence is always appended to the
Wariable Replacement outbound command to be sent.

[#] Advanced Send Commands

D Force Window Maximized Terminating Character Seguence:

Command Buffer
Reboot Sequence

Terminating Character (" Carriage Return (0x00)

[ Auto Line Wrap (" Line Feed (0x0A)
D Post Processing Script

{* <CR>and <LF> (0x0D,000A)

Keep Alive ustom Character Segquence
o (" Custom Character S
[[] character & Line Delay oo oaone
[] Timestamp .

{The terminating command character
seguence can be expressed using the
advanced command syntax.)

(Advanced send commands do not
automatically include this terminating
command character sequence. )

oK Cancel
Command Terminating Character Options Description
<CR> and <LF> (0x0D,-0x0A) This option will always send a carriage return and line

feed appended to each command instruction submitted
to the connected device/host in a terminal session.
(This is the default option in Indigo.)

Carriage Return (0x0D) This option will always send a carriage return
appended to each command instruction submitted to
the connected device/host in a terminal session.

Line Feed (Ox0A) This option will always send a line feed appended to
each command instruction submitted to the connected
device/host in a terminal session.

Custom Character Sequence This option will allow the user to specify a custom
character sequence that will be appended to each
command instruction submitted to the connected
device/host in a terminal session.

(The custom character sequence can be expressed
using the advanced send command syntax.)

Character Byte in Decimal Byte in Hex

Carriage Return <CR> 13 0x0D



Li ne Feed <LF> 10 0x0A

O Note

The command terminating characters/bytes do not apply to advanced send commands or keybo
ard redirected input using the Terminal Emulation view mode.

Auto Line Wrap

By default Indigo only performs line wrapping in the session data window when a line termination character is
received.

Some devices/hosts do not send any carriage return (OxOD) or line feed (0x0A) characters and you may want the
data to be displayed on multiple lines in the data window.

Enabling this option will force the terminal session to perform a line wrap after the specified number of characters
have been rendered to a row on the screen.

This feature is only supported in the Standard view mode.

Session Seftings

Muli-Command Some data connections do not provide
formatted data output with carriage

Internal Commands 3
. returns or line feeds. “ou can enable

Variable Replacement thiz option to automatically enter a
[¥] Advanced Send Commands carriage return and line feed upon
D Force Window Maximized receiving a specified number of
Command Buffer characters.

Reboot Sequence

Terminating Character

) Auto line wrap on IT characters.
D Post Processing Script

[[] Keep Alive

Character & Line Delay

[] Timestamp

Post Processing Script

Indigo supports a scripting feature that allows a user created script to analyze and modify data after it has been
received by the terminal session and before it is rendered to the screen.
This configuration panel allow you to select the custom script file and processing function to perform.

The scripting feature can be enabled or disabled for the terminal session using this configuration option.



—Sezsion Settings

Muli-Command Post-processing allows you to

Internal Commands perform custom processing on the
data recevied in a terminal ses=ion.

Variable Replacement This post-processing feature enables
Advanced Send Commands customization via the use of a custom
[ Force Window Maximized script file. (WBScript or JScript)

Command Buffer
Reboot Sequence

Terminating Character Seript Language:
Auto Line Wrap I‘-.-"BSn:ript j
Post Processing Script
[] Keep Alive Script File:
Character & Line Delay IPustF‘rucessingSample.vbs j
[] Timestamp

Seript Function:

I ForceTolpperCase j

Test

For more information on scripting, please see the Scripting help section.
Keep Alive

Some terminal connections may support keep alive packets and Indigo can be configured to send the keep alive
instruction at regular intervals to prevent the device/host from terminating the connection.

This feature may be useful if you are monitoring a device/host over time and the device/host forcefully disconnects if
no activity is detected.

— Session Settings

Multi-Command
Internal Commands If this option iz enabled, Indigo will
send Keep Alive packets to the

w| VVariable Repl t

A;:a Eedes? EL;EISE” ds connected terminal session after the
a"':. & n!'nr.nan specificied number of seconds of
[[] Force Window Maximized inactivity.

Command Buffer
Reboot Sequence

Terminating Character Inactivity Timeout: {in seconds)
Auto Line Wrap I—_‘|
30 —

Post Processing Script

Character & Line Delay
[] Timestamp

Character & Line Delay



Indigo typically transmits data commands as entire chunks of data in large packets. However, some device may not
be able to process large data packets or fast data transmissions.

You can enabled this feature to buffer the outgoing command data and inject delays between character and line
transmissions.

This feature may be necessary when working with limited resource embedded devices.

Session Settings

Multi-Command C.harau:'t.&r and Line delays allow you
Internal Commande to SPE.‘I:.If}f. a small delay between the
Variable Repl t tranzmiz=zion of each character or
. anable Replacemen each line. Some hardware devices
Ad "’ﬂ”':fj"j Send Cummands have limited data processing buffers
[[] Force Window Maximized that can easily be overrun without
Command Buffer some delay between each character
Reboot Sequence or line. These delays give the
Terminating Character gu nnected device more processing
Auto Line Wrap Tll-ln;z :,:;na c;:tp: and process the
Post Processing Script g ’
Keep Alive . i =l
Line Delay: 20 =
Character & Line Delay - —
- (millizeconds)
[] Timestamp
Character Delay: =1
Y 10 =
(millizeconds)
('0" will dizable each delay parameter. )
Timestamp

Indigo can automatically prepend data lines with timestamps to help record when data has been received by Indigo.
Since the line formatting can vary between each type of terminal connection, you must configure the type of end line
delimiter that Indigo should expect so that it can insert the timestamp at the appropriate locations.



—Sezsion Settings

Muli-Command Thiz option dizplays a timestamp at the

Internal Commands beginning of each line in the data
receive window.

‘ariable Replacement

Advanced Send Commands (Mote: this timeztamp does not apphy

[] Force Window Maximized to the Direct Terminal data window. )

Command Buffer

Reboot Sequence —End of Line Delimiter

Terminating Character T e | TR

Auto Line Wrap where new lines begin and

Post Processing Script where to ingert the timestamp

Keep Alive data.

Character & Line Delay )

¥ Line Feed (S04)

= Carriage Return (S00)
{" <CR= and <LF> (50D ,50A)

Ignore new line, add timestamp
on each data packet.

© Note

If using the option to incude a timestamp on each data packet received, Indigo will not limit the
timestamp to new lines, but inserts timestamp throughout the data stream.

Session Send Commands

Overview

The Send Commands tab in the Session Properties editor tab is used to configure automated commands issues to
the terminal session at the time of connection or disconnection.


http://help.shadeblue.com/display/indigo/Session+Properties

Session Properties - <QC= C1,115200,M,8,1
Connection Proxy | Terminal Formatting

Auto Send Commands (on session connect)

[+ Custom Command
| Global Commands

Settings  Send Commands

Edit Global Commands

]

Custom Session Commands (one command per ling)

command one
command two
command three

Auto Send Commands (on session disconnect)

[~ Dizconnect Command  |quit

Cancel

Auto Send Commands

Indigo terminal sessions can be configured to automatically send a series of commands/instructions to a terminal

session upon connection.

These commands are send each time the terminal session establishes a connection.

Command Set

Session Custom Commands

Global Commands

Edit Global Commands

Description

If this option is enabled, then this terminal session will
transmit the configured custom session commands
defined below.

If this option is enabled, then this terminal session will
also transmit the configured custom session commands
defined below.

This option will open the global commands editor.
The global commands are a series of instruction
commands defined globally that can optionally be
enabled for each terminal session instance.

Tip

transmitted first.

If both global and custom session commands are selected, the global commands will be




Custom Session Commands

This is a series of instruction commands that will be transmitted to the terminal session upon connection defined
exclusively for this terminal sessions instance.
Each command should be listed on a separate line.

This feature is especially useful if you need to always send some set of initialization or staging commands to the
remote device/host when your connection is established.

Example include enabling logging or debugging on a particular device/host or navigating to a specific path or
entering some diagnostics or development mode.

Disconnect Command

Indigo also supports an automated disconnect send command. You can enable this feature and define a disconnect
command in the text field provided.
This may be useful if you need to transmit some logout or graceful closure instruction to the remote device/host.

Tip

If you need to send multiple disconnect commands, enable and use the multi-command syntax.

O Note

The disconnect command will only be transmitted if you invoke the disconnect function, close the
terminal session, or close the Indigo application and the active connection is gracefully closed.
Indigo cannot transmit this disconnect command if the connection is disrupted due to a
network/cabling issue or if the remote host/device terminates the connection due to
timeout/inactivity.

Connection Tools & Features
Indigo supports the following connection management tools and features:

® Auto Reconnect

* Keep Alive
® Custom Reboot Sequence

Auto Reconnect

Overview

Indigo includes an Auto-Reconnect feature that will automatically and continually attempt to reconnect to a
device/host if a connection is lost.

The connection will be attempted every 30 seconds until the connection is established, the terminal session
windows is closed, or the Auto-Reconnect logic is suspended.

The timeline diagram below illustrates the Auto-Reconnect sequence.



Disconnect

o

Tip

This feature can be extremely useful if you are persistently logging data on a terminal connection
and need Indigo to automatically reconnect in the event of a connection disruption.

Session Status Icon

When a terminal session becomes disconnected and the Auto-Reconnect logic is activated, the following status icon
will be displayed.

Auto Reconnect This icon is displayed when a
session is in the disconnected state
and the auto-reconnect feature has
been enabled.

This icon represents that the
session will attempt to
auto-reconnect on a periodic basis
until a successful connection is
established.

Click this icon to disable the
auto-connect attempt. This will not
disable the auto-connect feature for
the session, just stops the
auto-reconnect on the current
disconnect cycle.

e
ﬁ <0C> telehack?.com = This session will attempt to reconnect to the host within 30 seconds. ]
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Session Menu



The session Auto-Reconnect feature can be enabled/disabled via the Session Menu.
A check mark next to the Auto Reconnect menu item indicates that the feature is enabled.

Session |

|i Connection b| . Connect F1
@@ Standard Terminal Mode Alt+F1 BE Disconnect F2
b4 Reconne F4
L' Repeat Last Transmission Ctrl+Spac Auto Reconnect  FJ >
—_—
MM Selected Text k
@ Clear Session Data F5
7 Clear Command Buffer F&
|E| Data Format r

‘E:} Reboot

[i]] Eroadcast Send Commands
IE Log Data To File
bl Local Echo

Il Pause Incoming Data

&% Transmit Control Code *
Syntax Color Filter »
Seszion Properties F8

Session Toolbar

The session Auto-Reconnect feature can be enabled/disabled via connection button on the the terminal session
toolbar.

A check mark next to the Auto Reconnect menu item indicates that the feature is enabled.

LRI ISR TN
. Connect
. Disconnect

E Feconnect

+ | Auto Reconnect

Keep Alive

Overview

Indigo includes a connection Keep-Alive feature to help maintain connectivity with remote device/hosts.
Some terminal connections may support keep alive packets and Indigo can be configured to send the keep alive
instruction at regular intervals to prevent the device/host from terminating the connection.

The Keep -Alive feature can be enabled/disabled from the Session Properties editor on the Advanced settings tab.




Session Settings

Mutt-Command

Internal Commands If thiz option iz enabled, Indigo wil

send Keep Alive packets to the

w| Variable Replacement

Ad u:ISp ic 4 connected terminal session after the
'.ranufar En u!'nr.nan ¥ specificied number of seconds of

[] Force Window Maximized inactivity.

Command Buffer
Reboot Sequence

Terminating Character Inactivity Timeout: (in zeconds)
Auto Line Wrap li_l
[ 30 |

Post Processing Script

Character & Line Delay
[] Timestamp

Tip

This feature may be useful if you are monitoring a device/host over time and the device/host
forcefully disconnects if no activity is detected.

Custom Reboot Sequence
Overview

Indigo supports a custom reboot sequence feature that can issue a reboot instruction to the connected terminal
session and then perform timed disconnect and re-connect of the session.
The timeline diagram below illustrates the custom reboot sequence.

Send Custom Reboot Command

|Disconnect Connect

Session Properties
The Reboot Sequence feature can be configured via the Session Properties editor on the Advanced settings tab.

This configuration panel provide the reboot sequence options for the terminal session.
The custom reboot sequence can also be disabled if you have no need for it.




Session Settings

Multi-Command This property wil allow you to create
Internal Commands a custom reboot sequence for this
“ariable Replacement SESEI0N.

[w] Advanced Send Commands

[] Force Window Maximized

Command Buffer

Reboot Command:
Terminating Character |REBDDI

[] Auto Line Wirap

D Post Processing Script

[[] Keep Alive [v UseAuto Re-Connect Timer
Character & Line Delay —
[] Timestamp 3 _I second(s) to disconnect

20 j second(s) to re-connect

Session Status Icon

When a terminal session is in the Rebooting sequence, the following status icon will be displayed in the Session dat
a window.

Rebooting @ This icon is displayed when the
session's connection is in a reboot
sequence.

Click the icon to stop the reboot
sequence.

ﬁ < QC= telehack.com

f
| ey

& - A = »r-EH-A |

Session Menu

The Reboot Sequence can be initiated for a terminal session by selecting the Reboot item from the application Sessi
on Menu.



Seszzion |

. Connection ¥
Terminal Emulation Mode Alt+F2
C Repeat Last Transmission Ctrl+5pace
MM Selected Text 3
@ Clear Session Data F5
™" Clear Data Above Selected Line

1 Clear Command Buffer Fb
'@Eﬂnrm=+ ____‘---..._}

‘E:} Reboot J

y Y o _n_lldr oY

E Log Data To File
b1) Local Echo

Il PauseIncoming Data

&% Transmit Control Code +

Syntax Color Filter r

session Properties "

Session Toolbar

The Reboot Sequence can be initiated for a terminal session by selecting the Reboot item from the session's toolbar
menu.



ﬁ <Q)C= telehack.com E'@
I

@ - v ~» - B8 - @I
| ‘E:} Reboot

& Log Data TeFile
bll Local Echo

" Pause Incoming Data

[[jﬂ] Eroadcast Send Commands
a® Transmit Control Code »

Syntax Color Filter r
Edit Session Properties

Session Context Menu

The Reboot Sequence can be initiated for a terminal session by selecting the Reboot item from the session's
right-click context menu.



ﬁ <Q)C= telehack.com E'@

. Disconnect

C Repeat Last Transmission Ctrl+5pace

MM Selected Tadt 3
= __-_'-"l-__
C ‘E:} Reboot

@ Clear Session Data

MM Clear Data Above Current Line

= Clear Command Buffer

Copy

E Paste

d% Find Ctrl+F
#,  Find Next

,_!.‘ Find Previous
H Gotoline Ctrl+G

Data Format »

Advanced »

o

. Sy -E-E IS

Internal Command

You can activate Reboot Sequence for a terminal session using the Internal Command syntax.

Example Perform custom reboot sequence

Command :reboot

Outbound Data Tools & Features
Indigo supports the following outbound data management tools and features:

Local Echo

Transmit Break Signal

Transmit Control Codes
Character and Line Delay
Command Terminating Character(s)
Broadcasting Commands
Multi-Command

Command Variable Replacement
Command Prefix & Suffix
Automated Send Commands
Advanced Send Commands

File Transfer (Serial)




® Transmit File Contents

Local Echo
Overview

Some device/hosts do not "echo” the data commands/keys submitted to the device back out for viewing in a terminal
emulator. Therefore for these type of devices, it is useful to have Indigo automatically print to the screen all data
commands that are transmitted to the connected device/host. This behavior is called Local Echo as the software
will locally echo out to the screen the submitted command instructions.

H Display On

. Screen

Transmit
Data

Send to
Device/Host

Session Status Icon
When a terminal session has the Local Echo feature enabled, the following status icon will be displayed.

Local Echo b1 This icon is displayed when the
session's local echo feature is
enabled.

Click the icon to disable the local
echo feature.

Lacal Eche is currently enabled.

(Click this icon to exit Local Echo.)

ﬁ <(QC= telehack.com E

Al <y -E-E S

Session Menu



The session Local Echo feature can be enabled/disabled via the Session Menu.

Session |

. Connection k
Terminal Emulation Mode Alt+F2
L' Repeat Last Transmission Ctrl+5Space
MM Selected Text k
@ Clear Session Data F5
™" Clear Data Above Selected Line

T Clear Command Buffer F&
|E| Data Format k

‘E:} Reboot

[EjL]] Broadeast Send Commands

3 —
I Local Echo
T Paefrcoming Date——————
£ Transmit Contrel Code L
Syntax Color Filter L
Session Properties F&

Session Toolbar

The Local Echo feature can be enabled/disabled for a terminal session from the session's toolbar menu.



ﬁ <Q)C= telehack.com E'@

S

- Sy -E-E N

‘E:} Reboot

& Log Data TeFile
| Bl Local Echo
Il Pause Incoming Data

[[jﬂ] Eroadcast Send Commands

&% Transmit Control Code 4

Syntax Color Filter r
Edit Session Properties

Session Context Menu

The Local Echo feature can be enabled/disabled from the session's right-click context menu.



ﬁ =QJC> telehack.com El@

I s

Dizconnect

Repeat Last Transmission Ctri+5pace

Selected Text k
Reboot

Clear Seszion Data

Clear Data Above Current Line

Clear Command Buffer

Copy

Paste

Find Ctrl+F
Find Mext

Find Previous

Goto Line Ctrl+G

#*ERBF UMM IANE

Data Format r
| Advanced P‘ {:} Reboot
bl Local Echo

[T] Broadcast Send Commands

i® Transmit Control Code 4

Syntax Color Filter >
Edit Session Properties

-
1 4

adihld Sy -E-E NS

Internal Command

The Local Echo feature can be enabled/disabled using the Internal Command syntax.

Example Enable the local echo feature for the session
Command :echo on
Example Disable the local echo feature for the session

Command :echo off



Transmit Break Signal

Overview

When connected via a serial connection, Indigo can send a Break Signal to the UART using one of the following
methods listed below.

Session Menu

The Serial Break Signal can be sent to a serial based terminal session by selecting the Transmit Break Signal item
from the application Session Menu.

Session

E Connection k
:@ Standard Terminal Mode Alt+F1
L' Repeat Last Transmission Ctrl+5pace
MH Selected Text 3
@ Clear Session Data F5
= Clear Command Buffer Fa
|E| Data Format »

{:} Reboot

4=_' Pasz Mode
[[jL]] Broadeast Send Commands
E Log Data Te File

bll Local Echo
1 JerecrrriTy CraTs —_—
( m Transmit Break Signal  (Ctrl+Break) )
07 TranEmitControkCade —
Syntax Color Filter k
Session Properties F&

Session Toolbar

The Serial Break Signal can be sent to a serial based terminal session by selecting the Transmit Break Signal item fr
om the session's toolbar menu.


http://www.freebsd.org/doc/en_US.ISO8859-1/articles/serial-uart/index.html

ﬁ Senial Loopback El@

i

&- <y B E N

{:} Reboot

4'=_" Pasz Mode
& Log Data To File
Bl] Local Eche

" Pause Incoming Data

I3 Brg mmands
C: Bl Transmit Break Signal _j:)

i Transmit Control Code L4

Edit Sessicn Properties

Session Context Menu

The Serial Break Signal can be sent to a serial based terminal session by selecting the Transmit Break Signal item fr
om the session's right-click context menu.



ﬁ Serial Loopback EI@

| =
Bl Disconnect
C Repeat Last Transmission Ctrl+5pace
MM Selected Text 3
‘E:} Reboot
@ Clear Session Data
"™ Clear Data Above Current Line
= Clear Command Buffer
Copy
B Paste
#% Find Ctrl+F
#_ Find MNext
S Find Previous
H Gotoline Ctrl+G
Data Format 3
Advanced Ir| {:} Reboot
4'=_' Pass Mode
8 Log Data To File
b1l Local Eche
" Pause Incoming Data
] .
Bl Transmit Break Signal T
- : ~
Syntax Color Filter »
Edit Session Properties I

-
4 3

adihld Sy -E-E S

Internal Command

The Serial Break Signal can be sent using the Internal Command syntax.

Example Transmit the serial break signal

Command : br eak

Transmit Control Codes

Overview

Indigo includes the ability to transmit special Control Codes/Control Characters to a connected device/host.

The following is a listing of the control codes built into Indigo menus. Most of these control codes can be also
transmitted using the associated hotkey.


http://en.wikipedia.org/wiki/Control_character

CTRL-@  MULL {null)

CTRL-& SOH (start of heading) Ctrl+5hift+4A
CTRL-B  S5TX (start of text) Ctrl+Shift+B
CTRL-C  ETX (end of text) Ctrl+5Shift+C
CTRL-DY EQT (end of tranmission) Ctrl+5hift+D
CTRL-E  EMQ (enquiry] Ctrl+Shift+E
CTRL-F  ACK (acknowledge) Ctrl+5hift+F
CTRL-G  BELL (bell} Ctrl+Shift+G
CTRL-H BS (backspace) Ctrl+5hift+H
CTRL-I TAB (haorizontal tab) Ctrl+5Shift+]
CTRL-1  LF {linefeed) Ctrl+Shift+)
CTRL-K VT (vertical tab) Ctrl+Shift+K
CTRL-L  FF (form feed) Ctrl+Shift+L
CTRL-M  CR (carriage return) Ctrl+5Shift+ M
CTRL-M 50 (shift out) Ctrl+Shift+M
CTRL-O  5I (shift in) Ctrl+5Shift+O
CTRL-P  DLE (data link escape) Ctrl+5hift+P
CTRL-Q DC1 (go) / XON Ctrl+Shift+0)
CTRL-R DC2 Ctrl+Shift+R
CTRL-5 DC3 (stop) / XOFF Ctrl+Shift+5
CTRL-T DC4 Ctrl+5Shift+T
CTRL-U  MAK (negative acknowledge) Ctrl+Shift+L
CTRL-V  5¥M (synchronous idle) Ctrl+5hift+V
CTRL-W ETE (end transmission block) Ctrl+Shift+W
CTRL-X  CAM (cancel) Ctrl+Shift+X
CTRL-Y EM (end of medium] Ctrl+5hift+Y
CTRL-Z  SUB (substitute / suspend) Ctrl+5Shift+Z
CTRL-[ ESC (escape]

CTRL-%  F5 (field separator)

CTRL-] G5 (group separator)

CTRL-* RS (record separator)

CTRL-DEL  US (unit separator) Ctrl+5hift+Delete

Tip

Control codes can also be transmitted to the terminal session using the native CTRL-KEY
combinations when using the Terminal Emulation view mode and when the keyboard input is
being redirected to the terminal session. Control code can also be constructed and transmitted
using the Advanced Send Command syntax.

Session Menu

Control Codes/Characters can be transmitted to a terminal session by selecting an item from the the Transmit
Control Code sub-menu from the application Session Menu.



Seszion

. Connection »
Terminal Emulation Mode Alt+F2
C Repeat Last Transmission Ctrl+5pace
MM Selected Text 3
@ Clear Session Data F5
"™ Clear Data Above Selected Line

= Clear Command Buffer F&
|E| Data Format »

‘E:} Reboot

4'=_' Pass Mode

[i]] Broadcast Send Commands
lﬂ Log Data To File

bl Local Echo

Il Pauselncoming Data

] TranseitBremiSigmat—tCirBremt———

(E"" Transmit Control Code ’I)
. _—.—-'--#_
Syt CotorFike— »
B Sescion Properties
5 Prop 5

Session Toolbar

Control Codes/Characters can be transmitted to a terminal session by selecting an item from the the Transmit
Control Code sub-menu from the session's toolbar menu.



ﬁ Serial Loopback EI@

b S -E-ENE

{:} Reboot

4'=_' Paz= Mode

& Log Data ToFile

bll Local Echo

" Pause Incoming Data

[T] Broadcast Send Commands

m I s B i
C_T &% Transmit Control Code 3
i k

Edit Session Properties

Session Context Menu

Control Codes/Characters can be transmitted to a terminal session by selecting an item from the the Transmit
Control Code sub-menu from the session's right-click context menu.



ﬁ Serial Loopback EI@

o1

Disconnect

Repeat Last Transmission Ctrl+5pace
Selected Text *
Reboot

Clear Sessicn Data

Clear Data Above Current Line

Clear Cornmand Buffer

Copy

Paste

Find Ctrl+F
Find Mext

Find Previous
Goto Line Ctrl+G

2 RF OMNMSOG INE

Data Format 4
| Advanced P| ‘E:} Reboot
¢'=_' Pass Maode
I Log Data To File
bl Local Echo

" Pause Incoming Data

[[jj] Broadcast Send Commands
< i® Transmit Control Code » >
T ——Synta-ColorEilter—"F |

Edit Session Properties -
‘ f

& - S B E

Character and Line Delay
Overview

Indigo typically transmits data commands as entire chunks of data in large packets. However, some device may not
be able to process large data packets or fast data transmissions.

For these cases, Indigo supports a character and line delay feature to limit/throttle the rate of data transmissions.



Submit Data

Transmit Character

Character Delay

_rransmit Line

Line Delay

Session Properties

You can enabled this feature in the Session Properties editor under the Advanced tab to buffer the outgoing
command data and inject delays intervals between character and line transmissions.
This feature may be necessary when working with limited resource embedded devices.

— Session Settings

Multi-Command Character and Line delays allow you

Internal Commande to specify a small delay between the
transmigsion of each character or

Variable Replacement each line. Some hardware devices
Ad"'E'”':E_d Send Cnmmands have limited data processing buffers
[[] Force Window Maximized that can easily be overrun without
Command Buffer some delay between each character
Reboot Sequence or line. These delays give the
Terminating Character connected device more processing

. ime to accept and process the
[«] Auto Line Wrap —=- Ll -

incoming data.
Post Processing Script -

Keep Alive . i .
Line Delay: I 20 =
Character & Line Delay =

[] Timestamp (milizeconds)

Character Delay: |
aracter Delay 10 =

(millizeconds)

('0" will dizable each delay parameter. )

Session Status Icon

While Indigo is buffering outbound data and in the process of transmitting it using character or line delays, the
following status icon will be displayed.



Outbound Data Buffering |:| This icon is displayed when
outbound data is being buffered and
transmitted to the connected
session on a buffered basis.
Outbound data buffering will only be
present when the Character and
Line Delay option is enabled.

You can click this icon to abort
transmitting the remaining buffered
data.

Tip

The number of remaining buffered bytes is displayed in the status icon.

Buffing Output Bytes

(Click thiz icon to abort transmission.)

ﬁ Serial Loopback EI =N,
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Command Terminating Character(s)

Overview

Command instructions sent to a terminal connection automatically include a set of line terminating

characters/bytes appended to the end of the data string.

By default, Indigo includes both a carriage return (Ox0OD) and line feed (0x0A); however, if your device/host requires
a different set of command terminating characters/bytes, you can provide a set of custom terminating characters.

O Note

The command terminating characters/bytes do not apply to advanced send commands or keybo
ard redirected input using the Terminal Emulation view mode.

Session Properties



The command terminating character sequence can be enabled/disabled or customized with a user specified
character sequence from the Session Properties editor on the Advanced settings tab.

Connection Proxy | Terminal

Session Settings

Session Properties - Serial Loopback

Multi-Command

Internal Commands
Wariable Replacement
[#] Advanced Send Commands
[[] Force Window Maximized
Command Buffer

Reboot Sequence

[[] Auto Line Wrap

D Post Processing Script
[[] Keep Alive

[[] Character & Line Delay
[] Timestamp

Formatting  Settings

The command terminatin

seguence is always appended to the
outbound command to be sent.

Terminating Character

{* <CR=> and <LF> (0x0D,000A)

(" Carriage Return |

(" Line Feed (0x04)

(" Custom Character Sequence

]

Send Commands

g character

Sequence:

0x0D)

"0x0D, Ox

{The terminating command character
sequence can be expressed using the

advanced command syn

(Advanced send commands do not

automatically include this

command character sequence. )

SRRl
U

tax.)

terminating

Cancel

Command Terminating Character Options

<CR> and <LF> (0x0D,-0x0A)

Carriage Return (0x0D)

Line Feed (Ox0A)

Custom Character Sequence

Description

This option will always send a carriage return and line
feed appended to each command instruction submitted
to the connected device/host in a terminal session.
(This is the default option in Indigo.)

This option will always send a carriage return
appended to each command instruction submitted to
the connected device/host in a terminal session.

This option will always send a line feed appended to
each command instruction submitted to the connected
device/host in a terminal session.

This option will allow the user to specify a custom
character sequence that will be appended to each
command instruction submitted to the connected
device/host in a terminal session.

(The custom character sequence can be expressed
using the advanced send command syntax.)




Tip

The character sequence can be expressed using the advanced send command syntax.

Character Byte in Decimal Byte in Hex
Carriage Return <CR> 13 0x0D
Li ne Feed <LF> 10 0x0A

Broadcasting Commands
Overview

Indigo supports a command Broadcasting feature that allows you to transmit command instructions from one
terminal session to all open and connected terminal session windows in Indigo simultaneously.

First, the session from which you want to send the command instructions must be enabled for broadcasting. Once
enabled any command/data transmitted from this terminal session will also be automatically transmitted in all other
open and connected terminal sessions.
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Session Status Icon

When a terminal session is enabled for command broadcasting, the following status icon will be displayed in the
session window.



Broadcasting =1 This icon is displayed when the
current session is configured to
broadcast all its outbound
command to all open and
connected terminal sessions.
Click the icon to disable command
broadcasting.

All commands transmitted to this terminal session are also being broadcast to all other open terminal sessions.

N (Click this icon to disable transmission broadcasting.)
ﬁ Serial Loopback Ell

ol

LRy command] -y -BE-EE

Session Menu

The Broadcasting feature can enabled/disabled from the application Session Menu.

Seszion

. Connection k

Terminal Emulation Mode Alt+F2

' Repeat Last Transmission Ctrl+5pace
MH Selected Text 3

@ Clear Session Data F5
™M™ Clear Data Above Selected Line

=1 Clear Command Buffer Fig
|E| Data Format k

‘E:} Reboot
=

oy
JL]T Broadcast Send Commands )
Log DataFoie

bl Local Echo

Il PauseIncoming Data

m Transmit Break Signal  (Ctrl+Break)

& Transmit Control Code r

Syntax Color Filter k
Session Properties F&

Session Toolbar

The Broadcasting feature can enabled/disabled from the session's toolbar menu.



ﬁ Serial Loopback EIEI

& ] <y -E-E N

{:} Reboot

4'=_' Paszs Maode

E Log Data Te File
bl Local Echo

( v [[jL]] Broadcast 5end Commands

&® Transmit Control Code

Syntax Color Filter
Edit Session Properties

Session Context Menu

The Broadcasting feature can enabled/disabled from the session's right-click context menu.



ﬁ Serial Loopback El@
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. Disconnect
L' Repeat Last Transmission Ctrl+5pace
MM Selected Text 3
‘E:} Reboot
@ Clear Sessicn Data
™ Clear Data Above Current Line
¥ Clear Command Buffer
Copy
E. Paste
#% Find Ctrl+F
#_ Find Next
,_f.‘ Find Previous
H Gotoline Ctrl+G
Data Format [
Advanced >| ‘E:} Reboot
4'=_' Pass Mode
& Log Data ToFile
b1l Local Echo
__M-Peremeommy tate—
<[[j£] Broadcast Send Cormmands )
*--...E + e ” —
£# Transmit Control Code r
Syntax Color Filter [
Edit Sessicn Properties —
< of
&z~ vl =y -

Multi-Command
Overview

Indigo supports a Multi-Command feature that allows you to chain together multiple commands into a single
command line expression.

Command 1 Delimiter Command Two

command- one | (pipe) conmmand- t wo



Example:

command- one| comrand- t wo| command- t hr ee| conmmand- f our

When the command line is submitted, Indigo looks for the multi-command delimiter and then separates the
command into multiple commands and transmits them individually to the connected device/host.

Indigo will include the command terminating characters at the end of each individual command (unless it is an advan
ced send command).

Submit Data

Transmit Command

ﬁ Serial Loopback E'@

iy command one =l
il command tuwo —
a3 \

‘ | f

e
@"ﬁﬂ'c\mmild one | command two ’ "."lE II

You can use the Multi-Command syntax to separate Advanced Send Command expressions.
Example:

"' HELLO "| " 0x48, 0x45, 0x4C, 0x4C, Ox4F"

Session Properties

The Multi-Command feature can be enabled, disabled, an customized in the Session Properties editor on the Advan
ced tab.

If this option is enabled, the terminal session will support Multi-Commands.
You can also change the multi-command delimiter character on this configuration panel.



Session Seftings

hlulj—l::nrrmand Multi-Command support allews you to

Internal Commands enter more than one command on a
‘ariable Replacement single command line, the commands
Advanced Send Commands are seperated by a user specified

[[] Force Window Maximized delimiter.

Command Buffer

Reboot Sequence Delimiter Character: | |
Terminating Character

[] Auto Line Wrap

D Post Processing Script

[[] Keep Alive

Character & Line Delay

[] Timestamp

Tip

Some devices/hosts may need the use of the pipe "|" character thus you can choose to disable
the multi-command or change the multi-command delimiter to another character.

Command Variable Replacement
Overview

Indigo includes a variable replacement feature that allows you to define a set of variables whose values can be
substituted in command data when it is submitted to the connected device/host.

ﬁ Serial Loopback EI@

logon jdoe querty

FY

-
4
logon [username] [password] 5 - b - .T |E| II




Variable Value

USERNAME j oe
PASSVWORD guwerty
Usage

To configure variables you wish to use in Indigo, you must enter them into the Variable Manager tool.

The syntax for using a variable in your data command is simple.
Just enclose the variable name in square brackets and Indigo will search for an available replacement.

Syntax

data [variabl e nane] data

Variable replacements can be used in the following places:

Command Bar

Paste To Session (Edit Menu)
Paste from Session Context Menu
Command Macros

Command Library

Command Repeater

Session Send Commands
Automated Send Commands

Session Properties

This feature can be enabled/disabled for a terminal session from the Advanced tab of the Session Properties editor.

Session Settings

Multi-Command If Variable Replacement iz enabled
Internal Commands and the Variable Manager is et to
active, the session command
Advanced Send Commands interpreter will replace any variables

in the command =string with the actual
wvalue from VWariable Manager.
vw| Command Buffer
Reboot S “Variables are enclosed in square

& D_u .equence braces to denote that it is a variable.
[#] Terminating Character (ie. [VAR])

[] Auto Line Wrap

D Post Processing Script
[] keep Alive

Character & Line Delay
[] Timestamp

[] Force Window Maximized

MOTE: The VYariable Manager tool must
be =et to active for variable
replacements to work !




Command Prefix & Suffix

Overview

Indigo provides a Prefix and Suffix feature on the Command Bar where you can define prefix/suffix data that will be
concatenated with your main command string when it is submitted to the connected device/host.

This feature can be particularly useful when you are communicating a series of commands where a portion of the
command remains static and a portion needs to be modified for each command submission.

3.] Senial Loopback E@
g update "John_Doe"™ account =
a2 —

Command ]
f
@ {I)|upd.ate " |Jchn Doe " account | ’ - . - IE‘ II

Session Toolbar

The Prefix and Suffix command feature can be accessed via the session window toolbar immediately to the left of
the command bar.
You can enable/disable the Prefix and Suffix command field independently.

ﬁ Serial Loopback EI@

@H

| <l -m-E
4|' Command Prefix
| Command Suffix

4| Enable Command Prefix & Suffix
| Dizable Command Prefix & Suffix




Automated Send Commands

Overview

Indigo includes a feature for automatically issuing instruction commands to a terminal session at the time of
device/host connection and/or disconnection.
Indigo includes support for both session based custom commands and globally defined commands.

This feature is especially useful if you need to always send some set of initialization or staging commands to the
remote device/host when your connection is established.Disconnect Command

Send Global Commands

Connect | Send Session Commands

Disconnect_

Disconnect Send Session Disconnect

Request ‘Command

Session Properties

Indigo terminal sessions can be configured to automatically send a series of commands/instructions to a terminal
session upon connection/disconnection.

The Send Commands tab in the Session Properties editor tab is used to configure automated commands issues to
the terminal session at the time of connection or disconnection.



http://help.shadeblue.com/display/indigo/Session+Properties

Session Properties - <QC= C1,115200,M,8,1 ]
Connection | Proxy | Terminal | Formatting | Seftings Send Commandsl

—Auto Send Commands (on =session connect)y

[¥ Custom Command

I_ Global C ds Edit Global Commands |
pbal Comman

— Custom Session Commands (one command per line)

command one -
command two
command three

—Auto Send Commands {on =ession disconnect)

[~ Disconnect Command  |quit

; Cancel |

Global Send Commands

Indigo also provides a configuration editor for Global Commands in the Program Preferences editor.




Program Preferences [E]

Main | Session [GlobaICommands] Com Ports

Global Sezsion Commands: fone command per ling)

command one -
command two

command three
command four

Advanced Send Commands

© Screencast

A screencast demonstration using the advanced send command syntax is available. Click here
to see the video.

Overview

When communicating with certain equipment or embedded devices, it may be desirable to send command
instructions to the connected device in data byte formats other than ASCII.

Indigo supports a feature called Advanced Send Commands that allow you to express these alternate byte
representations in a command string and Indigo will interpret the expression and transmit the appropriate data bytes.

If command
starts and ends Interpret
with quotes (") Command

User Submits Transmit |
Command Command




The Advanced Send Command syntax supports the following data byte formats:

ASCII
HEXADECIMAL
DECIMAL
OCTAL
BINARY

Session Properties

First, the session must be configured to allow Advanced Send Commands.
This feature can be enabled/disabled in each session.

Navigate to the session properties and select the Settings tab and make sure the Advanced Send Command setting
is enabled.

Session Properties - <QC= telehack.com =
Connection | Prosy | Terminal | Formatting Settings | Send Commands

Sezsion Settings

bulti-Command Flease select an item from the
Intermal Commands list. Upon selecting an item, a
e description will be displayed
in this panel.

Command Buffer
Reboot Sequence

T erminating Character
Auto Line Wwirap

[[] Post Processing Script
[] k.eep dlive

[[] Character & Line Delay
[] Timestamp

ak. Cancel

Syntax

To send Advanced Data Commands to the connected session, you must submit them using a syntax that Indigo can
recognize to interpret the intended data bytes for transmission.

Please note the following requirements for sending Advanced Send Commands:

1. All Advanced Data Command expression strings must be encapsulated in double quote characters.
The double quotes instruct Indigo that the data expression being submitted is an Advanced Send Command.

2. Each data byte in the command expression (with the exception of ASCII characters) must be separated by



commas.

3. When using the Advanced Send Command feature it is important to note that unlike normal command
instructions sent to the connected device, Indigo will not automatically append any terminating characters to
the instruction command (By default this is a carriage return byte and line feed byte). If your command
instruction requires some form of termination, you will have to include the appropriate
termination characters/bytes within the Advanced Send Command expression.

Below are examples of the send command: "HELLO" in each supported data byte representation

Data Type: Advanced Send Command Syntax:

ASCII ASCII strings are expressed by encapsulating the
sequence of characters inside single quotes.

"' HELLO "

ASCII characters can be individually expressed by
encapsulating each character

inside single quotes and each character separated with
a comma.

“THOUE 'L 'L Lo

Decimal Decimal data bytes are expressed as numeric values
with no prefix or suffix identifier characters.

"72,69,76,76, 79"



Hexadecimal

Octal

Binary

Mixed

Usage

Hexadecimal data bytes can be expressed as hex byte
values with a 'h' suffix identifier character.

.................................................................................

Hexadecimal data bytes can be expressed as hex byte
values with a '$' prefix identifier character.

.................................................................................

Hexadecimal data bytes can be expressed as hex byte
values with '0x' prefix identifier characters.

.................................................................................

Octal data bytes can be expressed as a numeric value
with a 'o' suffix identifier character.

.................................................................................

Binary data bytes can be expressed as strings of zeros
and ones with a 'b' suffix identifier character.

.................................................................................

"01001000b, 01000101b, 01001100b, O
1001100b, 01001111b"

Data bytes in the Advanced Send Command do not
have to be expressed in only one data format.

You can mix the data byte formats, the command
interpreter will decipher each byte separately

This example mixes binary, decimal, ASCII, and
hexadecimal bytes into a single command expression.

.................................................................................



You can use the Advanced Send Command syntax for any data submitted via the command bar at the bottom of the
session window. They can also be used in Macro Commands and in Command Library commands.
A screencast demonstration usage of the Advanced Send Command syntax is available. Click here to see the video.

File Transfer (Serial)

Overview

Indigo includes a file transfer for serial connections that can transfer the a file to or from the connected device/host.

Please note that this is a different feature from the Transmit File Contents feature.

The file transfer feature uses specific file transfer protocol to send or receive a complete file between the host and
computer running Indigo.

The transmit file contents feature uses transmits the contents (bytes/strings) directly to the connected device/host
and does not transfer a file to the remote device/host, just sends the data contents as a raw stream of data.

Indigo support the following file transfer options:

® Supported Protocols
® Send/Upload File
® Receive/Download File

Supported Protocols

Indigo supports the following serial file transfer protocols.

Feature Indigo V3 Standard Indigo V3 Professional
ASCII (Send Raw Text File, No
Protocol)

X-Modem
X-Modem 1K
X-Modem/CRC
Y-Modem
Y-Modem-Batch
Y-Modem-Batch-G
Z-Modem
Z-Modem/Save
Kermit

Tools Menu



The transfer file options can be accessed using the Tools Menu.

Tools

% Edit Custorn Data Conversion Format
A ASCH Chart F12
l] Syntax Celor Editor

Window States »
——
('ﬁ Send/Upload File . Alt+Ctrl+S )
H:_El Recerve/Download File ... Alt+ Ctrl+ P‘_..-

B Transmit Text File (ASCI BY LIME)
E‘F Transmit BEaw File (BINARY)

Transmit Raw File (THROTTLE] Ctrl+R
Refresh Available Com Ports Shift+F12
Refresh Available Modems Ctrl+F12

Send/Upload File

This option will transfer a file from the computer running Indigo to the remote serially connected device/host using a
file transfer protocol.

The Send/Upload File option can be accessed using the Tools Menu.

B send/Upload File ...

When you activate this feature will be first prompted to select a file and transmit protocol.

After selecting the file and protocol, click the Send button to start the transfer.

Indigo will negotiate the file transfer with the remote connected device/host and start transmitting the file data.
(The remote device/host must be in the receive file mode with the same file transfer protocol before the file will
be transferred.)

Send File

File To Send:
CMest.txt

Browse |
Tranzmit Protocol:
| ZMODEM -

Send Cancel |
Property Description
File The file to be transferred to the remote connected

device/host.



Transmit Protocol The file transfer protocol used to negotiate the file
transfer.
(Both Indigo and the remote host must be configured to
use the same file transfer protocol.)

Indigo includes the following options:

ASCIl (Send Raw Text File, No Protocol)
XMODEM

XMODEM CRC

XMODEM 1K

YMCODEM

YMODEM BATCH

YMODEM BATCH G

ZMODEM

ZMODEM Save

KERM T

Indigo will display a progress dialog to show the current transfer status.
You can Abort the transfer during the process if needed .

Send File
Sending File:
CA\_test txt
Action: [S%'N] Synchronizing
File Size: 14581 Bytes
Bytes Transfered: (} Bytes

e |

When the file transfer is complete, you can choose to close the file transfer dialog or choose to resend the file
again.

Receive/Download File

This option will transfer a file from the remote serially connected device/host to the computer running Indigo using a
file transfer protocol.

The Receive/Download File option can be accessed using the Tools Menu.

'El Receve/Download File ...

When you activate this feature will be first prompted to select a folder and transmit protocol.
After selecting the folder and protocol, click the Receive button to start the transfer.



Receive File

Transmit Protecol;
|Yr.1DDE M-BATCH-G j

Folder to store received file:

CAlsers\John Doe\Documentsh

Select Folder |

._Receive |  Cancel |
Property Description
Receive Folder The folder on the local system where received files will
be stored.
Transmit Protocol The file transfer protocol used to negotiate the file
transfer.

(Both Indigo and the remote host must be configured to
use the same file transfer protocol.)

Indigo includes the following options:

ASCI| (Send Raw Text File, No Protocol)
XMODEM

XMODEM CRC

XMODEM 1K

YMCODEM

YMODEM BATCH

YMODEM BATCH- G

ZNMODEM

ZMODEM Save

KERM T

Indigo will negotiate the file transfer with the remote connected device/host and begin receiving the file data.
(The remote device/host must be in the send file mode with the same file transfer protocol before the file will
be transferred.)

Indigo will display a progress dialog to show the current transfer status.
You can Abort the transfer during the process if needed .



Receive File

Receiving File:

C:A\_test bt

Action: [S%'N] Synchronizing
Bytes Received: (} Bytes
File Size: (} Bytes

| . Avort |

When the file transfer is complete, you can choose to close the file transfer dialog or choose to receive the file
again.

Transmit File Contents

Overview

Indigo includes a feature that can transmit the contents of a file to a connected device/host.

Please note that this is a different feature from the File Transfer feature.
The file transfer feature uses specific file transfer protocol to send or receive a complete file between the host and
computer running Indigo.

Using this feature, Indigo will open the file and transmit the contents (bytes/strings) directly to the connected
device/host. This does not transfer a file to the remote device/host, just sends the data contents as a stream of
data.

Indigo support the following options for transmitting file contents:

® Transmit ASCII File (Line-By-Line)

® Transmit RAW Binary File

® Transmit RAW Binary File using Throttling
Internal Command

Tools Menu

The transmit file option can be accessed using the Tools Menu.



Iu:u:ulsl

% Edit Customn Data Conversion Format
A ASCH Chart F12
. Syntax Color Editor

Window States k
l’ Send/Upload File ... Alt+Ctrl+5
'E| Receive/Download File ... Alt+ Ctrl+R
T Transmit Text File (ASCI BY LINE) b
H‘F Transmit Eaw File (BINARY)
Transmit Raw File (THROTTLE) Ctrl+R )
Refresh fvailable Com Ports Shift+F12
Refresh Available Modems Ctrl+F12

Transmit ASCII File (Line-By-Line)

This option will open a text based file and transmit each line of text as a separate command.
This is a useful option when you have a series of commands listed in a text file that you want to transmit in
succession to the connected device/host.

The Transmit Text File (ASCII BY LINE) option can be accessed using the Tools Menu.

|E|b Transmit Text File (ASCI BY LINE) |

When you activate this feature will be first prompted to select a file.
After selecting the file, Indigo will start transmitting each line of the file and display a progress dialog to show the
current transfer status.

Transmit Text File

File: _test.txt

Tatal Bytes: 14581
Bytes Sent 13452
Remaining: 1519

When the file content transmission is complete, you can choose to close the transmit dialog or choose to resend the
contents again.

Transmit RAW Binary File

This option will open a (binary) file and transmit a stream of data to the connected device/host.
This is a useful option when you have raw data in a file that you want to transmit to the connected device/host.

The Transmit Raw File (BINARY) option can be accessed using the Tools Menu.



||E" Transmit BEaw File (BINARY)

When you activate this feature will be first prompted to select a file.
After selecting the file, Indigo will start transmitting the contents of the file and display a progress dialog to show the
current transfer status.

Transrit Raw (Binary) File

File: .keystore

Total Bytes: 1343

Bytes Sent 1343 | Transfer Complete |
Remaining: 0
[ | 100

L Abort Resend | gose |

When the file content transmission is complete, you can choose to close the transmit dialog or choose to resend the
contents again.

Transmit RAW Binary File using Throttling

This option will open a (binary or text) file and transmit blocks of data bytes to the connected device/host with delay
intervals between each block to throttle the stream of data.

This is a useful option when you have data in a file that you want to transmit to the connected device/host but need
to control the rate of transmission.

The Transmit Raw File (THROTTLE) option can be accessed using the Tools Menu.

B Transmit Raw File (THROTTLE) |

When you activate this feature will be first prompted to select a file.
After selecting the file, Indigo will display a Transmit Raw File dialog where you can specify the following options:

Transmit [Block Size] bytes every [Timing Interval] milliseconds.

Option Description

Block Size The number of bytes to include in a send block that will
be transmitted to the connected device/host during
each timing interval.

Timing Interval The number milliseconds to wait between each data
block that will be transmitted to the connected
device/host.

Once you have the block size and timing configured, you can click the Start button to begin the transfer.



Transmit Raw File

File: .keystore

Total Bytes: 1343 Percantage: 0%
Bytes Sent 0 Rate {Bytes/sec.) 100
Femaining: 1343 Estimated Tinne: 13

Transmit I m Bytes e'.reryl 100 miiseconds

Reset | Start | Pauze |

| | Close

Indigo will start transmitting each block of data and display a progress dialog to show the current transfer status.
You can Pause and Resume the transmission during the process if needed .

Transmit Raw File
File: .keystore
Total Bytes: 1343 Percentage: gLy
Bytes Sent 740 Rate {Bytes/zec.) 100
Femaining: B03 Estimated Tinne: 13

Transmit I m Bytes e'.reryl 100 miiseconds

Reset | Start | Pause |

O | o

When the file content transmission is complete, you can choose to close the transmit dialog or choose to reset the
state and re-start the transmission again.

Transmit Raw File

File: .keystore

Total Bytes: 1343 Percentage: 100%
Bytes Sent 1343 Rate {Bytes/sec.) 100
Femaining: 0 Estimated Tinne: 0

Transmit I 10 Bytes e*.reryl 100 miiseconds

Reset | Start | Pausze |

| cosc

Internal Command

You can initiate a Transmit File Contents action using the Internal Command syntax.




Example Transmit the contents of an ASCII text file

Command ctxtextfile:<fil ename>
Example Transmit the contents of a raw binary file
Command txrawfil e: <fil ename>

Inbound Data Tools & Features
Indigo supports the following inbound data management tools and features:

Pause Incoming Data

Line Numbering
Line Highlighting
Line Tracking
Line Wrapping
Timestamps

Pause Incoming Data

Overview

Indigo supports a Pause feature that suspends the receipt of incoming data from the remote connected device/host.

© Note

The Pause feature will not buffer data. Indigo will ignore received data while the Pause feature is
enabled.

Session Status Icon
When a terminal session has the Pause feature enabled, the following status icon will be displayed.

Pause IEI Pause incoming/received data from
being rendered to the screen.
(While enabled all incoming data
from the connected session is
ignored and not rendered to the
screen.)
Click this icon to resume rendering
incoming data.



( All incorning data has been paused,

(Click this icon to resume incoming data.)
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Session Menu

The session Pause feature can be enabled/disabled via the Session Menu.

Session

. Connection »
Terminal Emulation Mode Alt+F2
L' Repeat Last Transmission Ctrl+5pace
WM Selected Text ]
@ Clear Session Data F5
™" Clear Data Above Selected Line

3 Clear Command Buffer Fé
|E| [rata Format »

{:} Reboot

[Eﬂ] Eroadcast Send Commands
E Log Data To File

h) h —
J_" Pause Incoming Data ‘:F
&P Trans r

Syntax Color Filter »
Session Properties F&

Session Toolbar

The Pause feature can be enabled/disabled for a terminal session from the session's toolbar.
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The Pause feature can be enabled/disabled for a terminal session from the session's toolbar menu.

ﬁ <QC> telehack.com
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Session Context Menu

‘E:} Reboot
fH Log Data To File
I‘]]] Local Echo

] Pause Incoming Data

"L’ Broadcast Send Commands
## Transmit Control Code

Syntax Color Filker
Edit Session Properties

The Pause feature can be enabled/disabled from the session's right-click context menu.
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1] —
Bl Disconnect 7
L' Repeat Last Transmission Ctrl+5pace
M Selected Test 3
{:} Reboot
@ Clear Session Data
™" C(Clear Data Above Current Line
= Clear Command Buffer
Copy
E Paste
@k Find Ctrl+F
#_ Find Mext
S Find Previous
H Gotoline Ctrl+G

Data Format *
| Advanced P| ‘E:} Reboot
I Log Data To File
bl Local Echo
C:I:— ] Pause Incoming Data __:I:}

_[ETEruadcast Send Commands

&® Transmit Control Code »
Syntax Color Filter r

Edit Session Properties i

-
4 4

& - | Sy cE-E

Line Numbering
Overview

If using the Standard View Mode, you can enable the Line Numbering feature which will be displayed in the left
margin of the session data window.
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View Menu

You can enable/disable Line Numbering using the View Menu.

Session List Bar

Status Bar
Session Manager Ctrl+F1
Command Library Ctrl+F2
Data Conwverter Ctrl+F3
Repeater Ctrl+F4
Variable Manager Ctrl+F5

Quick Connect Toolbar
Recent Sessions Toolbar
Window States Toolbar

Macros Toaolbar
Find /.

Ctrl+I

Session Properties



The Formatting tab in the Session Properties editor tab is used to configure the Line Numbering display options.

Session Properties - <QC= C1,115200,M,8,1 =]

Connection Proxy | Terminal Formatting | Settings Send Commands

Line Numbering Dizplay Options

Allow Column Selection

Allow Drag and Drop

Enable Color Syntax Highlighting
Show Horizontal Scrollbar
Show Vertical Scrollear

Smooth Scrolling

Highlight Line:

Dizgplay Whitezspace

Dock Toolbar to Top

Fix Reversed < LF=<=CR=

Force Mew Line Tracking

[ Append Line Feeds to Line Ends
[ Filter Out <Null= (0x00) bytes

[ Line Mumbering
Style: DEC -

Start at: 1

I I A A

Preview Background Color """""""" T exﬂll:lll:lr -------- Font |

The quick brown fox jumped owver the 1azi‘

-
4 [

oK Cancel |

Line Numbering Options
The session formatting options include the ability to configure how Line Numbering is displayed.

Setting Description

Line Numbering A checkbox is provided to enable or disable line
numbering.
Line numbering can also be enabled or disabled via the
Edit menu.

Style/Format Line numbering can be rendered in the following data
formats:

Data Formats
BINARY
DECIMAL
HEXADECIMAL
OCTAL


http://help.shadeblue.com/display/indigo/Session+Properties

Start At Line numbering can be configured to start at a specific
line number if preferred.
Typically this option is used to define the line
numbering a zero-based or one-based.

Line Highlighting
Overview

If using the Standard View Mode, you can enable the Line Highlighting feature which will display a highlighted bar on
the active line where the cursor focus is positioned in the session data window.

ﬁ <Q)C= telehack.com E@

It is 5:82 am on S3turday, June 2, 2ﬂ1}i
There are 21 local users. There are 244

Type ? for a comfland list.
Type HELP for a e detailed command
Type control-C interrupt any commai

Way the command line live forever.

Command, one of the following: —

ac basic cal Ci
dir eliza Factor f:
help hosts ipaddr ji
newvuser notes octopus pl
rand Score starwars t
units users uupath z21
f
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View Menu

You can enable/disable Line Highlight feature using the View Menu.



Yiew
Session List Bar
Status Bar

Session Manager Ctri+F1
Command Library Ctrl+F2
Data Conwverter Ctrl+F3
Repeater Ctrl+F4
Variable Manager Ctrl+F5

Quick Connect Toolbar

Recent Sessicns Toolbar

Window States Toolbar

Macros Toalbar

Find / Search Toolbar

LT +]
Line Highlight Crl+T
"‘-\-__________ _________..-""

Session Properties

The Formatting tab in the Session Properties editor tab can be used to enabled/disable the Line Highlight feature.

Session Properties - <QC= C1,115200,M,8,1
Connection | Proxy | Terminal Formatting l Settings | Send Commands
—Line Humbering——— —Display Options

[¥ Line Numbering [+ Alow Column Selection
[+ Alow Drag and Drop
Style: |DEC -~ ¥ Enable Color Syntax Highlighting

Start at: I 1 [+ Show Horizontal Scrollbar

[+ Show Vertical Scrollbar

[~ Dock Toolkar to Top

[~ Fix Reversed =< LF==CR=

[~ Force New Line Tracking

[~ Append Line Feeds to Line Ends
[~ Filter Out <Mull= (0x00) bytes

Preview Background Color Text Color Font

The quick brown fox jumped over the 1az «

o

oK | LCancel |

Line Tracking


http://help.shadeblue.com/display/indigo/Session+Properties

Overview

In the Standard View Mode, Indigo includes a Line Tracking feature that helps track the cursor to newly received
data in the session data window.
This allows new data to be made visible in the continuous scrolling data window as it is received.

The Line Tracking feature is enabled by default.

Session Status Icon

The following session status icon is displayed when Line Tracking is suspended.

Line Tracking @ This icon is displayed when the
cursor is placed in the data window
on a line of data and the session is
not longer actively tracking
(scrolling) to newly received data.
Click the icon to jump to the newest
data line and resume line tracking.
(auto-scrolling)

Suspend Line Tracking

If you need to inspect/review portions of the received data you can suspend Line Tracking by placing the cursor on
the data line.

Indigo will suspend Line Tracking when the cursor in the session data windows is focused to a line other than the
last line of data.

When Line Tracking is suspended a session status icon will be displayed in the session data window.

ﬁ <Q)C= telehack.com E@

It is 5:82 am on Saturday, June
There are 21 local users. There

Type ? for a command 1i
Type HELP for a more d®tailed command
Type control-C to interrupt any commai

May the command line live forever. |

Command, one of the following:

ac basic cal Ci
dir eliza factor f:
help hosts ipaddr ji
newvuser notes octopus pl
rand SCcore starwars ti
units users uupath z21
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Resuming Line Tracking



To resume line tracking, you can either click the status icon or set the cursor to the last data line in the session data
window.

Mew line tracking is currently.

(Click this icon to resurme new line tracking.)

ﬁ =QC> telehack.com EI B

It is 5:83 am on Saturday, June 2, E
There are 21 local users. There are 2Ll

Type ? for a command list.
Type HELP for a more detailed command
Type control-C to interrupt any commai

May the command line live forever.

Command, one of the following:

ac basic cal Ci
dir eliza factor F:
help hosts ipaddr jiu
newuser notes octopus pl
rand score staruwars t
units users uupath ZI
.7
Command. one of the followinao: _j:J
3
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Session Properties

The Formatting tab in the Session Properties editor tab can be used to Force New Line Tracking.
If this option is enabled, then Indigo will always track to the new data line.
In this mode you cannot suspend the Line Tracking behavior.


http://help.shadeblue.com/display/indigo/Session+Properties

Session Properties - <QC= C1,115200,M,8,1 =]

Connection Proxy | Terminal Formatting | Settings Send Commands

Line Numbering Dizplay Options
Allow Column Selection

Allow Drag and Drop

Enable Color Syntax Highlighting
Show Horizontal Scrollbar
Show Vertical Scrollear

Smooth Scrolling

Highlight Line:

Dizgplay Whitezspace

Dock Toolbar to Top

[ Line Mumbering
Style: DEC -

Start at: 1

I N i A A

[~ Force New Line Tracking

Previews Background Color

Font |

Force New Line Tracking In the Standard view mode, if this option is enabled
then all newly received data is automatically displayed
in view in the session data window.

This option will force the data window to automatically
scoll to the bottom line to display new data.

If this option is disabled, Indigo uses the standard line
tracking behavior described here.

Line Wrapping
Overview

By default Indigo only performs line wrapping in the session data window when a line termination character is
received.

Some devices/hosts do not send any carriage return (Ox0D) or line feed (0xOA) characters and you may want the
data to be displayed on multiple lines in the data window.

Enabling this option will force the terminal session to perform a line wrap after the specified number of characters
have been rendered to a row on the screen.

This feature is only supported in the Standard view mode.
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Tip

Auto line wrapping may be a useful feature to enable when working with unstructured or raw
binary data.

Session Properties

The Line Wrapping feature can be enabled/disabled and configured in the Advanced tab of the Session Properties e
ditor.




Session Settings

Mutt-Command

Internal Commands
‘ariable Replacement

[w] Advanced Send Commands

Some data connections do not provide
formatted data output with carriage
returns or line feeds. You can enable
this option to automaticaly enter a
carriage return and line feed upon

[] Force Window Maximized
Command Buffer

Reboot Sequence
Terminating Character
D Post Processing Script
[] keep Alive

Character & Line Delay
[] Timestamp

receiving a specified number of
characters.

Auto line wrap on | &2 characters.

Timestamps

Overview

In the Standard View Mode, Indigo can automatically prepend data lines with timestamps to help record when data
has been received by Indigo.
This can be a very useful feature when you need to understand the timing of the data received.

71 <QC> telehack com o &=
[BF:-43:59.228 o
[B7:43:59_228]|It is 5:43 am on Saturday, June—
[B7:43:59_.228]|There are 24 local users. There
[B7:-43:59.228]
[B7:43:59.228]
[B7-43:59.228]
[B7:43:59.228]
[B7 :43:59.228]
[B7:43:59_.228]|Hay the command line live forev
[B7:-43:59.228] b
[B7:43:59_.228]|Command, one of the following:

Type 7 for a command list.
Type HELPF for a more detailed
Type control-C to interrupt a

[BF:-43:59.228] ac basic cal
[BF -43:59_.228] dir eliza facto
[B7:-43:59.228] help hosts ipadd
[BF:43:59.228] newuser notes octop
[B7:43:59.228] rand score starw
[B7:43:59_.228] units users uupat
[B7:43:59.228] -

| 3
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Session Properties

The Timestamp feature can be enabled/disabled and configured in the Advanced tab of the Session Properties edito




r

Since the line formatting can vary between each type of terminal connection, you must configure the type of end line
delimiter that Indigo should expect so that it can insert the timestamp at the appropriate locations.

Seszion Settings

Mult-Command Thiz option dizplays a timestamp at the
Internal Commands beginning of each line in the data

i indow.
Variable Replacement rECElE window
Advanced Send Commands (Mote: this timestamp does not apply
[[] Force Window Maximized to the Direct Terminal data window.}
Command Buffer
Reboot Sequence End of Line Delimiter
Terminating Character This is used to determinge
Aute Line Wrap where new lines begin and
Post Processing Script where to inzert the timestamp
Keep Alive data.
Character & Line Delay .
{* Line Feed Es'llﬁl.}

(" Carriage Return (300}

" «CR=and <LF> (500 %04)
lgnore new line, add timestamp
on each data packet.

® Note

If using the option to incude a timestamp on each data packet received, Indigo will not limit the
timestamp to new lines, but inserts timestamp throughout the data stream.

Data Analysis Tools & Features
Indigo supports the following data analysis tools and features:

Session Data Formatting
Syntax Color Filters

Session Data Logging
Serial Pass Mode

Session Data Formatting

Overview

© Screencast

A screencast demonstration applying various session data byte representations is available. Clic
k here to see the video.

Indigo includes a powerful feature that allows you to select what data representation format you would like used to
display received data in the session data window.

Indigo can render the received data bytes in the following formats/representations:



Data Format

ASCII

ASCII with Control Codes

Hexadecimal

Hexadecimal w/ Control Codes

Decimal

Octal

Binary

Mixed ASCII/HEX

Custom

Byte Analysis

Description

This data format is the default format and renders
received data bytes in the standard ASCII textual
character representation.

This data format renders data bytes that fall in the valid
ASCII character range as text and the bytes typically
found the the control code range (0x00 to Ox1F) with a
control code label.

This data format renders displays the hexadecimal
values for all data bytes received.

This data format renders displays the hexadecimal
values for all data bytes received except those bytes ty
pically found the the control code range (0x00 to 0x1F)
which are renders as control code labels.

This data format renders displays the decimal values
for all data bytes received.

This data format renders displays the octal values for
all data bytes received.

This data format renders displays the binary values for
all data bytes received.

This data format renders data bytes that fall in the valid
ASCII character range as text and the bytes typically
found the the control code range (0x00 to 0x1F) as
their hexadecimal values.

This data format renders displays the data bytes
received using the user-defined custom data format.

This data format renders displays the data bytes
received using the byte-analysis rendering.

© This option should not be used in
cases where there is a large volume
of data bytes being transferred.
This option will render each data
byte received in multiple data data
representations and can impact the
performance of Indigo and the
computer when there is a high
frequency or large volumes of data
bytes in the stream.



Tip

Indigo also includes a Data converter tool widget that can convert ASCII data to these alternate
data format representations on the fly.
Click here to lean more about the Data Converter tool.

Session Menu

You can select and apply a Data Format to your active terminal session window from the Session Menu.

. Connection k

Terminal Emulation Mode Alt+F2

' Repeat Last Transmission Ctrl+5pace

MH Selected Text 3

@ Clear Session Data F5

™" Clear Data Above Selected Line

= mand Buffer 6|
_"E Data Format ) 3 |E| Ascii
W [A] Ascii w/ Control Codes
[[jf] Broadcast Send Commands [H Hexadecimal

E Log Data To File [H] Hexw/ Control Codes
bl Local Echo O] Decimal

Il PauselIncoming Data [O] Octal

£# Transmit Control Code 3 Binary

Syntax Color Filter b [l Mixed Ascii/Hex
Session Properties F& @ Custom
H| Byte Analysis
\_ | /

Session Toolbar

You can select and apply a Data Format to your active terminal session window from the session toolbar.
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Asciiw) Control Codes
Hexadecimal
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Custom

Byte Analysis
\ | /

Session Context Menu

You can select and apply a Data Format to your active terminal session window from the session right-click context
menu.
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Disconnect

Repeat Last Transmission Ctrl+5pace
Selected Text »
Reboot

Clear Session Data

Clear Data Above Current Line

Clear Command Buffer

Copy
Paste

=B IS G ITAHE

Eind Ctrl+F
#, Find Mext

J.‘ Find Previous

# Gotoline CirleG L.
Data Format ) |E| Asci _\

Asciiwy Control Codes

e 1

Hexadecimal

Hex wy Control Codes
Decirnal

Octal
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Byte Analysis Data Format

The byte-analysis data format will render each data byte on a separate line.
Each line of byte-analysis data will include the following columns:

Data Type Byte Number Decimal Hexadecimal Octal Binary ASCII
Example Byte: 785 116 74h 164 01110100 t



£ recrnc e e
Byte:7&0 11l T4h 124 01110100 T :j
Byte: 761 115 73h 163 01110011 = -
BEyte:7Tg2 32 20h 40 00100000
Eyte:7G3 32 20h 40 00100000
Eyte: 7G4 32 20h 40 00100000
Byte: 7G5 32 20h 40 00100000
Byte:7GG 32 20h 40 00100000
Byte:7a7 32 20h 40 00100000
BEyte: TGl 32 20h 40 00100000
BEyte:7G9 117 75h 15 01110101 u
Byte: 770 115 73h 183 01110011 k4
Byte:771 101 a5h 145 01100101 e
Byte: 772 114 T2h 162 01110010 r
Byte:773 115 T2h 13 01110011 =
Eyte:774 32 20h 40 00100000
Byte: 775 32 20h 40 00100000
Byte: 776 32 20h 40 00100000
Byte:777 32 20h 40 00100000
Byte:7T75H 32 20h 40 00100000
Byte: 779 32 20h 40 00100000
BEyte: 78O 32 20h 40 00100000
Byte: 781 117 75h 185 01110101 u
Byte:T7E2 117 T5h 15 01110101 u
Byte: 783 112 TOh 150 01110000 P
B S 7g24 a7 Glh 141 01100001 3

yte: 785 lla 74h 1c4 01110100 T >

Eyte: 7 80b 104 o8h 150 01101000 h

Byte:TEY 32 20h 40 00100000

Byte:7EE 32 20h 40 00100000

Byte: 78S 32 20h 40 00100000

BEyte:790 32 20h 40 00100000

Eyte: 791 32 20h 40 00100000

Byte: 792 32 20h 40 00100000

Byte: 793 122 TAh 172 01111010 z

Byte: 794 114 T2h 162 01110010 r

BEyte: 795 117 T5h 15 01110101 u

BEyte: 796G 110 GEh 155 01101110 n

Byte: 7897 32 20h 40 00100000

Byte: 7958 32 20h 40 00100000

Byte:799 32 20h 40 00100000

Byte:B800 32 20h 40 00100000

Eyte:-801 32 20h 40 00100000

Eyte: 802 32 20h 40 00100000

BEyte:803 13 ODh 15 00001101 <CR=

Eyte: 204 10 OAR 12 00001010 <LF= hd
1 | 3
@ - v =~y B

Syntax Color Filters

Overview

In the Standard View Mode, Indigo supports the ability to define keywords that can be rendered with one of three
user defined colors.
This is a useful feature to help draw visibility/attention to targeted keywords and phrases.




ﬁ =(QJC» telehack.com E'@
It is 6:35 am on June 2, 2012 in Hou]
There are 21 loca There are 24414 hosts—
Type i, a command list.
Typ or a more detailed command listing
Type~eankfol-C to interrupt any command.

May the command line live forever.

Command, one of the following:
ac basic cal calc

f eliza factor figlet
@ hosts ipaddr joke
i ey notes octopus phoon
rand : starwars telnet
units uupath Zrun
f

B Sy BB

Syntax Color Filters

User defined keywords and colors are configured in color syntax filters.
This allow you to switch between multiple filters to provide different coloring and keywords options based on the
selected filter.

Syntax color filters can be created and edited using the Syntax Color Editor tool.




Ml

N Mew | £l Close
" Color1 Color 1
= Color2
" Color 3 Foreground Color | Background Color
{~ Strings
i~ Comment Blocks r Default
Background Color
[~ Enable String Syntax Coloring ¥ Enable Comment Syntax Coloring
String Delimiter: E Start Delimiter I
End Delimiter: 1

Color1 | Color2 | Color3

ERROR

exception

warning
Warn

attention

OO0000O0OREOOOR

OO00rROEOOOOXO
ORROOOOOR®OO

Session Menu

You can select and apply a Syntax Color Filter to your active terminal session window from the Session Menu.



Seszion |

. Connection r
Terminal Emulation Mode Alt+F2
C Repeat Last Transmission Ctrl+5pace
M Selected Text »
@ Clear Session Data F5
™" Clear Data Above Selected Ling

X Clear Command Buffer F&
|E| Data Format r

‘E:} Reboot

[i]] Eroadcast Send Commands
IE Log Data To File

bl] Lecal Echo

Il Pause Incoming Data

£# Transmit Contrel Code Ly

| Syntax Color Filter | Mene
Session Properties F8 My 2nd Filter

My Custom Syntax Color
BB syntax Color Editor

NS

Session Toolbar

You can select and apply a Syntax Color Filter to your active terminal session window from the session toolbar men
u.



ﬁ <QC=> telehack.com EI@
(TR It is 6:35 am on Saturday, June 2
(W There are 21 local my There ar
Type 7 for a command list.

Type HELP for a more detailed co
Type control-C to interrupt any

May the command line live forever.

Command, one of the following:

ac basic cal

dir eliza factor

help hosts ipaddr

newuser notes octopus

rand score starwars

units users| uupath

o
@ - = » -B-E

{:} Reboot
E Log Data Te File
}]]] Local Eche

" Pause Incoming Data
9

[[jL]] Broadcast Send Commands

&# Transmit Control Code 4 T
| Syntax Color Filter None
Edit Session Properties My 2nd Filter

My Custom Syntax Color

I syntax Color Editor
Mo

Session Context Menu

You can select and apply a Syntax Color Filter to your active terminal session window from the session right-click co
ntext menu..
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Disconnect

Repeat Last Transmission Ctrl+5pace
Selected Text 3
Reboot

Clear Session Data

Clear Data Above Current Line

Clear Command Buffer

Copy

Paste

Find Ctrl+F
Find Mext

Find Previous
Goto Line Ctrl+G

#2ERFOMSG IAERE

Data Format 3
Advanced >| {:} Reboot

2 Log Data To File
bl Local Echo

" Pause Incoming Data

[T] Broadcast Send Commands

i® Transmit Control Code o
| Syntax Color Filter >| None
Edit Session Properties My 2nd Filter

My Customn Syntax Color
B syntax Color Editor

\Z

o
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Session Data Logging
Overview

Indigo includes a Data Logging feature to capture data as it is received to a persisted log file.
The data is actively written to the log file so that in the event of a power outage or computer reboot all the data
received is already recorded and nothing is lost.



22 Serial Loopback =y ="
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49h,77h, 650, 72h, 000, BAh,
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720,730, F7h, 760, 770,330, 340,72

k
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© Screencast

A screencast of the data logging process is available. Click here to see the video.

Data Logging Configuration

When you enable Pass Mode, the following Pass Mode Configuration editor will be displayed.



Legging Options

Header | Footer Raw Data
[v Include Log File Description Header Log Raw Data Feed
[+ Include Log File Description Footer (Mo Formatting)

Start New Log File

f+ Alow Log file to grow continioushy
(" Start new Log file on date change. Bytes:
(™ Start new Log file after number of bytes received: =

[ Auto clear screen buffered data upon new log file.
{ ** Recommended lo consen/e memory.)

[ Auto start logging when session is opened.

Log Timestamp

[ Include time stamp on each log data line

Timestamp Format String: | hh:mm:ss. fff |

Timestamp Line Detection:

Each line as displayed in the session data window (Default)
Custom Line Delimiter: (zingle character) I:I
Log File

CAProgramData\shadeBlueiindigo\Log Files\Telehack.log

Change |

Cancel |

The Data Logging feature includes the following configuration options:

Setting
Header / Footer

Include Log File Description Header

Include Log File Description Footer

Raw Data

Log Raw Data (No Formatting)

Start New Log File

Description

If this option is enabled, Indigo will include a header
comment with date and time information in the log file
when logging starts.

If this option is enabled, Indigo will include a footer
comment with date and time information in the log file
when the logging is stopped or the session is closed.

If this option is enabled, Indigo will not attempt to
determine line separation or add any formatting to the
log file. The exact data received will be faithfully
recorded to the log file as-is.



Allow Log file to grow continuously

Start new log file on date change

Start new log file after number of bytes received

Bytes Received

Auto clear screen buffered data upon new log file

Auto start logging when session is opened

Log Timestamp

Include time stamp on each log data line

Timestamp format string

If this option is enabled, Indigo will constantly log data
to a single log file as long as the session is open.

If this option is enabled, Indigo will start new recording
to a new log file when the date changes.

This is useful when recording data over multiple days
and you want to break up the logging data into multiple
files.

If this option is enabled, Indigo will start new recording
to a new log file after a log file reaches the specified
number of bytes.

This is useful when recording data over time and you
want to break up the logging data into multiple
manageable sized files.

This option is only used when the logging is configured
to start a new log file after a number of bytes have
been received.

This field is used to specify the maximum number of
bytes in each file. This is essence determines the
maximum file size.

If this option is enabled, Indigo will clear the data from
the terminal session window when a new log file is
started.

This option is highly recommended when logging
large amounts of data to prevent Indigo from
consuming too much system memory.

If this option is enabled, Indigo will automatically start
logging when the session file is opened.

The existing logging configuration option will be
applied.

If this option is enabled, Indigo will record a time stamp
for each line of data received and logged.

This option should not be used if the
terminal session was already
configured to include a timestamp in
the session data window.

This option specifies the timestamp string format to use
when recording timestamps to the log file.

hh - hours

mm - ninutes

ss - seconds

fff - mlliseconds



Timestamp line detection Not all devices/hosts conform to a single line
termination standard, therefore it may be necessary to
define the line termination characteristics of the
connection.

The following options are available:

® Each line as displayed in the session data window
(Default)

Each line ends with a <CR> 0x0D character

Each line ends with a <LF> Ox0A character

Each line ends with a custom character

Each line is separated based on the received data
packet

Custom line delimiter If the timestamp line detection property is configured to
use the: Each line ends with a custom character option,
then this field defines the line termination character.

Log File

Log file path This field defines the directory and file name for the
data log file.

Session Status Icon
When a terminal session is actively logging data to a file, the following status icon will be displayed.

Logging This icon is displayed when the
session data is being actively
logged to a file.

Click the icon to display additional
logging options or to stop logging.

|& View Log File

~ Open Log File Folder
“+3 Stop Legging to File




This session data is actively being logged to file:
ChProgramData\shadeBlueiIndigotLog Files\Telehack.log

ﬁTefEhack
f
@~ v ~r-E-E N7

Session Menu

You can activate Session Data Logging from the Session Menu.

Seszion

. Connection k
Terminal Emulation Mode Alt+F2
' Repeat Last Transmission Ctrl+5pace
MM Selected Text 3
@ Clear Session Data F5
™" Clear Data Above Selected Line

T Clear Command Buffer Fé&
|E| Data Format k

‘E:} Reboot

[[.]] E ZLII\JI 'LUIIIIIII]IIUIS ___'_‘-b-__
(:Lﬁ Log Data To File _I)

}':[ﬂTU‘__rE—M-I T ——

Il Pauselncoming Data

£® Transmit Contrel Code r
Syntax Color Filter k
Session Properties F&

Session Toolbar

You can activate Session Data Logging from the session toolbar.



1] Telehack
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Session Context Menu

d__,_...:@?—— RetooT

—

Leg Data To File

<

%

LE-h

" Pause Incoming Data
[i]] Broadcast Send Commands
&® Transmit Control Code r

Syntax Color Filter >
Edit Session Properties

You can activate Session Data Logging feature from the session right-click context menu.




ﬁ Telehack El @

Disconnect

Repeat Last Transmissicn Ctrl+5pace

Selected Text r
Reboot

Clear Session Data

Clear Data Abowve Current Line

Clear Command Buffer

Copy

Paste

Find Ctrl+F
Find Mext

Find Previous

Goto Line Ctrl+G

2 25 UMS S ITAOE

Data Format r

| Advanced >| FretroeT —
( = Log Data Te File
sealEcha —

" Pause Incoming Data

=

[T] Broadcast Send Commands

5# Transmit Control Code 4

Syntax Color Filter k

Edit Session Properties -
4 3
& - | <> B E

Internal Command

You can activate/deactivate Session Data Logging feature using the Internal Command syntax.

Example Start/stop session data logging
Command 11 og

Serial Pass Mode

Overview

Indigo includes a Pass Mode feature for serial connections (RS-232, RS-422, RS-485) whereby connecting the host
computer running Indigo between two serial devices/terminals,
Indigo can intercept and display the serial communication between the two parties

Pass Mode refers to the notion that Indigo will pass (or relay) data communication between two serial connections.
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7ah,64h, 660, ADN, BAR, ——
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© To use Pass Mode you must use two serial ports on the host computer running Indigo and
connect each port to the desired endpoints.

Pass Mode Configuration
When you enable Pass Mode, the following Pass Mode Configuration editor will be displayed.

You can configure the secondary serial com port and the appropriate baud rate and communication settings.
Additionally you can inject prefix identifiers to data packets to help identify which data bytes came from which
endpoint connection when bi-direction communication is present.

Click the Enable Pass Mode button when you are ready to establish the connection and start Pass Mode.

Pass Mode Configuration: Serial Loopback

—Pass From {Input)

Serial Connection Settings:

Com Part: Bawd Rate: Parity: Data: Stop: Flow Control:

COM1 | 38400 | MOME | B | 1 | MOME

— Pass To (Output)

Please Enter Serial Connection Settings:
Baud Rate: Ciata: Control:

S o
[com3 _"384["] _"NEINE EE _|]1 _"Nu:une ~]

— ldentify

[~ Enable Indentification 100 T Preficto Data from | INE:
Prefo Strings nput Fort
Add This Prefix to Data from | OTIT -
Qutput Port:

i Enable Pass Mode || Disable Pass Mode




Session Status Icon

When a terminal session is enabled for Serial Pass Mode, the following status icon will be displayed.

Pass Mode

=

This icon is displayed when the
serial pass mode is enabled.

Click the icon to disable serial pass
mode.

ﬁ Serial Loopback

(=

{ Pass mode is currently enabled.

(Click this icon to exit Pass Mode.)

—

&3 v d|p|

~ry-BE-ENE

Session Menu

You can activate the Serial Pass Mode feature from the Session Menu.



Seszion |

. Connection r
Terminal Emulation Mode Alt+F2
C Repeat Last Transmission Ctrl+5pace
M Selected Text 3
@ Clear Session Data F5
™" Clear Data Above Selected Ling

X Clear Command Buffer F&
|E| Data Format r

Q__Hgﬂﬂ o) e ———

Pass Mode __:I3
[Wamld \.,LFIIIIIIGIIL::- ___--_

lﬁ Log Data To File

b1l Local Echo

Il PauseIncoming Data

m Transmit Break Signal  (Ctrl+Break)

&% Transmit Control Code 4
Syntax Color Filter K
Session Properties F&

Session Toolbar

You can activate the Serial Pass Mode feature from the session toolbar.



ﬁ Serial Loopback El@
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| E3Reb
<| 4=—' Pasz Mode |>

“"""E—' ao Data To File "]
hl] Local Eche

" Pause Incoming Data

[EjL]] Broadcast Send Commands
& Transmit Break Signal
&® Transmit Centrol Code [

Syntax Color Filter k
Edit Session Properties

Session Context Menu

You can activate the Serial Pass Mode feature from the session context menu.



ﬁ Serial Loopback E'@

Disconnect

Repeat Last Transmission Ctrl+5pace

Selected Text k
Reboot

Clear 5ession Data

Clear Data Abowve Current Line

Clear Command Buffer

Copy

Paste

Eind Ctrl+F
Find Mext

Find Previous

Goto Line Ctrl+G

i
C
M
&
@
=
e
#
h

-
H

Data Format r

Advanced 2 | ’___E:JL—'?‘-'_LU\.-L —

= Pass Mode I}
bl Local Echo

" Pause Incoming Data

[EE] Eroadcast Send Commands
ransmit Break igna
G it Break Signal

&# Transmit Control Code L
Syntax Color Filter k
Edit Session Properties
1 LH
Ry > » -@- A
Widgets
Overview

Indigo includes widgets which are dockable tool windows that can provide useful tools and/or
usability convenience options.
Indigo includes the following widgets:

Session Manager
Data Converter
Command Library
Variable Manager
Command Repeater

The following sections of this page will discuss the user interface layout and behavior of tool widgets.



Widget Docking

Widget Floating

Widget Pinning

Widget Re-sizing
Multiple Widgets Tabbed
Multiple Widgets Stacked

Widget Docking

Indigo's tool widgets can be docked to any side of the Indigo application window.

Select the title bar of a Widget Tool and you can drag it to the left, right, top, or bottom edge of the Indigo application
window to dock the widget.

Example: Docked Left

e

EJ Indige Terminal Emulator E'@
File Edit View Tools Session Macre Window Help
Command Library x|

"]

hed 3@

Cimnimeaind Drescription
l= list directony
= -l list directory more i
reboot reboot system
set-date st the date & time

debug-on enable debugging
help display help options
4 T 3

Example: Docked Right



.

Indigo Terminal Emulator = ||-= @

File Edit View Tools Session Macre Window Help

Command Library x|
hed 3

Command
l=

I= -1
rebaosat
sat-date
get-time
debug-on
help

Example: Docked Top

Indige Terminal Emulator =nac @

File Edit View Tools | Session | Macre Window Help

e

Command Library x|
"]

hed 3@
Cimnimeaind Drescription -
= list directony
= -l list directory more info c
reboot reboot system
set-date st the date & time

. -
debua-on enable debuaaina

Example: Docked Bottom



e

H| Indigo Terminal Emulator E@

File Edit View Tools Session Macre Window Help

Command Library o x|
u

ez 3

Ciomimand Drescription -

I= list directony =

= -l list directony more info

reboot reboot system

set-dats et the dats & time T

Widget Floating

Indigo's tool widgets can be floated where it is not attached to any side of the Indigo application window, but rather

floating in a detached window.
Select the title bar of a Widget Tool and you can drag outside of the Indigo application window or away from the

edges of the window to float the widget.

Example: Floating



P

E_J Indigo Terminal Emulator - [Serial Loopback] EI@

ﬁ File Edit View Tools Session Macro Window Help - 8 X

('l logon jdoe querty —

" f_hldl.m; } B

hed 3

Command | Description |
l= list directony

= -l list directony mare infio

reboot reboot system

set-date st the date & time

debug-on enable debugging

help display help options

b =t
. | _’l_l

&b ~y-E-E
ﬁ| 1 Serial Loopback| - 8 X
Serial Loopback | <RS232> COM 1, 33400, NONE, &, 1 y

Widget Pinning
Indigo's tool widgets can pinned down to conserve valuable screen real-estate.

When a Widget Tool is docked, you can select the Pin button ( J;l ) to pin the widget to a collapsed state.
When in the pinned state, you can hover your mouse cursor over the widget title to expand the tool window.

Example: Pinned



H| Indigo Terminal Emulator EI@

File Edit View Tools Session Macre Window Help

m AIEJqT pUB LW T

Widget Re-sizing

Docked tool widgets re-sized to the user preferred size.
When a Widget Tool is docked, you select the edge of the widget with the mouse cursor and drag it to re-size the

tool window.

Example: Resizing



I =

H| Indigo Terminal Emulator EI@

File Edit View Tools Session Macre Window Help
Command Library x|

heEed @ @

Command
l=

I= -1
rebaosat
sat-date
get-time
debug-on
help

Multiple Widgets Tabbed

Multiple tool widgets can be tabbed on top of each other when docked to the same screen edge.
You can select the tabs to switch between the widgets.

Example: Tabbed



H| Indigo Terminal Emulator
Eile

Edit View Tools 5ession

Macro

(= & S

Window Help

Command Library x|
OEE 3

Command Drescription
l= list directony

= -l list directony more

reboot reboot system
set-date set the date & time
debug-on enable debugging
help display help option:
F i t
@ Comman.. |0 Data Co..
. —

Multiple Widgets Stacked

Multiple tool widgets can be stacked on top of each other when docked to the same screen edge.

Example: Stacked

e

H| Indigo Terminal Emulator

File Edit Yiew Tools Session

Macro

(= & S

Window Help
Command Library }
hed 3
Command Deescription -
l= list directony

m

= -l list directory m

reboot reboot system
set-date s=t the date &

o
] I

Data Converter

[ [E] - 7]

Total Bytes: 17

T

01101100,01101111,0 .
11001311,01101111,01
101110, 00100000,011
01010,01100100,0110
1111,013100101,00100 -

PN et B = I W =T T = B = i |




Session Manager

Overview

Indigo supports a Session Manager widget tool that allows you to create and manage all your terminal sessions.
The Session Manager widget provides a tree-based hierarchy where you can group terminal sessions into multiple
nested folders for better organization.

" ™
Session Manager Serial Loopback
) *View All Groups Type e
- Com Port: 1

= aéf:ﬁ':ﬂz Settings: 38400, N.8.1

..... % Work (double-click session to cpen,

""" Mac-0SX S5H or right-click for more options..)

----- Modem Listend J

..... &1 My Session Name
'gi; Serial Loopback
----- @ TCP Listener

..... == Telehack

----- = Telnet Localhost
..... &1 UDP Listener

(Hovering the mouse cursor over a session instance will display some session configuration information in a tooltip.)

View Menu
The Session Manager widget can be displayed using the View Menu.

Session List Bar

Status Bar

—— ~
(I Session Manager Ctri+F1 I)
o T rl+F2
Data Converter Ctrl+F3
Repeater Ctrl+F4
Variable Manager Ctrl+F5

Quick Connect Toolbar

Recent Sessicns Toolbar
Window States Toolbar

Macros Toolbar

Find / Search Toolbar

Line Mumbers Ctrl+1
Line Highlight Ctrl+T




Widget Docking, Pinning, Re-sizing

Widget docking, pinning, re-sizing, etc information is listed here.

Tip

You will most likely prefer to have the Session Manager widget permanent available (docked or
pinned) for quick access to launch your pre-configured terminal sessions.

User Interface

The Session Manager user interface consists of a tree listing of terminal sessions with a single options toolbar.

Session Manager x|
By | < View Al Groups | - |

B sossiors
..... a2l Mac-05X SSH

----- E¥ Modem Listener
----- E"’;J My Ses=ion Name
-Sfa; Serial Loopback

..... == Telehack
..... 4= Telnet Localhost
..... &1 UDP Listener

The Session Manager widget options are listed below.

Name Description



New Session This option will provide a drop-down listing of
connection types to create a new terminal session insta
nce.

If the desired connection type list not listed, please
select the Other Terminal Session option.

Telnet Session

S5H (Auto) Session

Senal (R5-232) Seszion
Serial (R5-422) Session
Serial (R5-485) Session
Dial Up (Modem) Session

L

! ul
Ll w
u u

=
m
n

Y
e

0

Other Terminal Session ==

Web URL Shortcut

(1 R4

Web Shortcuts can also be created in the Session
Manager widget. This shortcuts simply open a URL
using your default web browser.

Group Filter This option provides a listing of the groups defined in
your session tree.
Selecting a group will filter the displayed session
instances to only those that belong to or are
descendants of that group.

Sessign-Manager =]

----- Modem Listener
----- ﬁ My Session Name
‘-55; Zerial Loopback
..... a3l TCP Listener

..... %= Telehack

----- == Telnet Localhost
..... &1 UDP Listener

Context Menu
The Session Manager widget also supports a right-click context menu that provides session management options.

Context Menu when a Group is selected Context Menu when a Session is selected



=] Session Manager
S *iew All Groups -

Rename

_____ Auto Load on Startup

El--a Sessions

----- 4 Telehack
----- S Telnet Localhost

----- &1 UDP Listener

----- &1 Mac-0SX SSH

Telnet Session || . .
55H (Aute) Sessi | o e ”‘:-‘
Serial (RS-232) § -4, Ser
..... E;J TCP
Serial (RS-422) S || .. — Tele
Serial (RS-485) 50| & = Teln

Al
Dial Up (Moderr || a;l UDP

2 8% 4

=
bl
n

-
m
n

W
)

5

Cther Terminal !
Web URL Shartc

[ }43

'@ Open Session
'@ Add Session r

'@ Remove Session

Edit Session Properties

Move Session
Rename

Auto Load on Startup

The Session Manager widget context menu options are listed below.

£

Name

Add Group

Remove Group

Open Session

Add Session

Remove Session

Move Session

Rename

Auto Load on Startup

Description

This option will create a new group
at the selected location in the
session tree.

This option will remove the selected
group from the session tree.

This option will launch/open the
selected terminal session.

This option can be used to create a
new terminal session or web
shortcut.

This option will remove the selected
terminal session from the listing.
(This option permanently deletes
the terminal session and its
configuration.)

This option can be used to move an
existing terminal session to a new
group container.

This option will prompt the user to
rename the existing group or
session.

This option will enable/disable the
selected terminal session to
automatically load when the Indigo
application is started.



Edit Session Properties This option will open the Session

Properties editor for the selected
terminal session.

Auto Load Sessions (Auto-Start)

The Session Manager widget will display any session that is configured to auto-load on start-up with a green arrow
icon (" ) and blue bold text.

Session Manager x|
S *iew All Groups -

El--a Sez=ions

( =] Mac-05X 55H

Wy Session Name
ﬁa; Serial Loopback
..... a2l TCP Listener

----- %= Telehack

----- % Telnet Localhost
..... &1 UDP Listener

Open Sessions

The Session Manager widget will display any session that is currently open in Indigo with green bold text.

Session Manager o x|
S+ iew All Groups -

E-43 Seszions

C ¥ Modem Listener
-sfa; Serial Loopback
..... a2l TCP Listener

..... = Telehack

----- % Telnet Localhost
..... &1 UDP Listener

Data Converter

Overview



© Screencast

A screencast demonstration applying various session data byte representations is available. Clic
k here to see the video.

The Data Convert Widget is a tool that can convert ASCII characters (text) into the other data byte representation
format on the fly.

When active the Data Converter will convert any selected text from the session data window into the selected data
format.

Example: The text "score" was selected and converted into the binary data format.

e

-

EJ Indige Terminal Ernulater - [Telehack] E@
ﬁ File Edit Yiew Tools Session Macre Window Help - O X
Type ? fTor a command 113 Data Converter J;lﬂ
Type HELP for a more dei -
Type control-C to 1'nter ."r
May the command line liwve fo /-MSJ—\
Command, one of the followin Eilégﬁ%%lgg%éigimn'1
ac basic ca ! ! _/
dir eliza
help hosts
newuser otes
ramd
units L= uu
-
[
o
@ v Ay > » -B- A
[ 1Telehack -8 X
<TELNET telehack.com =

Example: The text "score" was selected and converted into the hexadecimal data format.
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EJ Indigo Terminal Emulator - [Telehack] E@
ﬁ File Edit Yiew Tools Session Macro Help - 8 X

Data Converter x|
Command., one of the fnlln. -
ac basic E .lEl"
dir eliza fa
help hosts ip
F‘::SSE" o EEh,Elh,FEh,E'&h,EE‘-_I‘I)
units [

f
@ - ‘“P |hE11|: world j } - . - |E| o
ﬁ 1 Telehack a2 x

<TELMET telehack.com =

View Menu

The Data Converter widget can be displayed using the View Menu.

Session List Bar
Status Bar
Session Manager Ctrl+F1
__Lomrmarmd TBTaTy —Ekelafl
(I Data Converter Ctrl+F3 )
T Repeate— —em<TT
Variable Manager Ctrl+F5

Quick Connect Toolbar
Recent Sessicns Toolbar
Window States Toolbar

Macros Toolbar

Find / 5earch Toolbar

Line Mumbers Ctrl+I
Line Highlight Ctrl+T

Widget Docking, Pinning, Re-sizing

Widget docking, pinning, re-sizing, etc information is listed here.



User Interface

The Data Converter widget user interface includes a toolbar at the top of the tool window to configure the Data

Converter widget run-time options.

Data Converter x|
& H - Total Bytes: 7

&Eh,&5h,77h,75h,73h,65h, 72h

The Data Converter widget options are listed below.

Icon Name

Active Conversion

Description

When this option is enabled, any
text data that is selected in the
session data window will be
automatically converted on-the-fly in
the Data Converter widget.

® Note

This option does
not
enable/disable
the Data
Converter widge
t. Is just controls
whether or not
this tool will
actively convert
selected text
from the active
session data
window or not.




M Data Format Select the desired data conversion

format that the Data Converter widg

et should apply to selected text.

g
[v][A] Ascii
|E| Asciiw/ Control Codes
|E| Hexadecimal
|E| Hex w/ Control Codes
|E| Decirmal
@ Cctal
Binary
M| Mixed Ascii/Hex
@ Custom
[*] Byte Analysis
|
Help This option displays the following

help information.

P

Data Converter Tool

B If the data converter is enable

" text in the active session data
will be converted based on tk
format and displayed here.

You can also drag and drop t
perform conversicn on the di

Total Bytes: 5 Total This field displays the total number
of bytes/characters that were
converted.

Drag & Drop

Indigo supports dragging and dropping text data into the Data Converter widget.
When dropped, the text will be converted to the selected data format.
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E_J Indige Terminal Emulator - [Telehack] E @

ﬁ File Edit View Tools Session Macroe Window Help - 0 X

Type ? for a command list. — Data Converter a x|
Type HELF for a more detai -
Type contrel-C to 'interrup Eilﬁl'

May the command line live forew Total Bytes: 5

Command, one
ac
dir
help *
NeEwuser notes octop h
rand score Starw iy
units users uupat =

following:
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f
v Sy -B-E I

<TELNET telehack.com =

Session Menu

You can select a block of text in the session data window and then use Send to Data Converter option in the session
menu to send the selected text to the Data Converter widget.

The text will be converted to the data format selected in the Data Converter widget.



Seszion |

. Connection r

Terminal Emulation Mode Alt+F2

C Repeat Last Transmission Ctrl+5pace

,“’l Selected Text I*| P Send te Active Session Ctrl+D
@ Clear Session Data = Fﬁ Send to All Open Sessions

"™ Clear Data Above Selected Line bm Send to Command Bar Ctrl+B
X Clear Command Buffer Fﬁc:’
G Resurne Mew Line Tracking F7 % Add t Command Macros —

[A] Data Format L Add te Command Library

{:} Feboot YE Add te Command Repeater

[Eﬂ] Broadcast Send Commands
lﬁ Log Data To File
bl Local Echo

Il PauseIncoming Data

&® Transmit Control Code r
Syntax Color Filter L
Session Properties Fa

Session Toolbar

You can enter command text into the command bar and then use session toolbar to send the selected text to the Da
ta Converter widget.
The text will be converted to the data format selected in the Data Converter widget.

S-oEmEE D E-ENE ]

2 1 Telehack M2 Send to Active Session _ A x
Pi Se ions
<TELNET telehack.com = #—M
Send t Data Converter
Al commamttETes |
+L Add to Command Library
+[El Add to Command Repeater

Session Context Menu

You can select a block of text in the session data window and then use the right-click session context menu to send
the selected text to the Data Converter widget.
The text will be converted to the data format selected in the Data Converter widget.



H| Indigo Terminal Emulater - [Telehack] EI@
ﬁ Eile Edit View Tools Session Macro Window Help -3 X
Data Converter x|
Command, one of the following: @ - ?
ac bas_ric cal calc cr_ring EEIE'IE
Ei: slizs facier rigler  Iinger Toto Bytes: 5
newui [l Disconnect phoon ping
rand Eelnet tracerou
units ¥ Repeat Last Transmission Ctrl+Space Frun
""' Selected Text Pl ﬁ Send to Active Session
.E:} Reboot B Send to All Open Sessions
H—
@ Clear Session Data .E"E —— .
mm : ﬁ Send to Data Converter ll‘
~a_ Clear Data Above Current Line " A
BT Clear Cornmand Buffer WM
& Resume New Line Tracking F7 Add to Command Library
Copy Y&l Add to Command Repeater
E, Paste
#% Find Ctrl+F
# Find Next
J_‘ Find Previous —
H GotoLine Ctrl+G
Data Format 4
Advanced 3
4 |
&0
[ 1 Telehack -8 X
<TELNET telehack.com =

Command Library

Overview

Indigo supports a Command Library widget tool that allows you to define collections of commands that you may
want to send to a connected device/host.

This feature is very similar to the Command Macros feature, except that command macros are intended to be more
of a permanent set of commands used across all sessions whereas the Command Library widget is targeted at

creating library files of commands that can be easily swapped for different libraries as needed.

This is particularly useful is you want to build up commands sets that target a specific device or host.
Command library files can also easily be shared across multiple users of Indigo or multiple computers running

Indigo.




COMMAMND:
get-time
Command Library

DeEeld 3@ DESCRIPTION:

get the current time

Coomimand Description

= list directory {double-click row to send command to current

= -l list directory more info | ceccjon; or drag coermmand to session command bar)
reboot reboot system .
s=t-date =&t the date & time

debug-on enable debugging

help display help options

(Hovering the mouse cursor over a command instance will display the command information in a tooltip.)

View Menu
The Command Library widget can be displayed using the View Menu.

Session List Bar

Status Bar
Sesgi rl+F1
(f Command Library CtrI+F21>
_“EEFE_LD”VETLEI Tﬁ
Repeater Ctrl+F4
Variable Manager Ctrl+F5

Quick Connect Toolbar

Recent Sessicns Toolbar
Window States Toolbar

Macros Toolbar

Find / Search Toolbar

Line Mumbers Ctrl+1
Line Highlight Ctrl+T

Widget Docking, Pinning, Re-sizing
Widget docking, pinning, re-sizing, etc information is listed here.
User Interface

The Command Library user interface consists of a grid listing of commands with a single options toolbar.



Command Library x|

heEed 3

Command Drescription

l= list directony

Is -l list directony more info
reboot reboot system
set-dats set the date & time
get-time get the cument time
debug-on enable debugging

help display help options

The Command Library widget options are listed below.

Name Description

O New This option will prompt the user to
create a new command library file.

T

Open This option will prompt the user to
select and existing command library
file.

When a file is selected the Comman
d Library widget will refresh and
display the contents of the newly
selected file.

=] Save This option will prompt the user to
save the current command library
file.
(The current command library file is
automatically saved when the
Indigo application is closed.)

= Edit This option will switch the Comman
d Library widget into edit mode.
Edit mode will allow adding and
editing commands in the command
library.



Help This option displays the following
help information.

Command Library Tool

& The command repeater can s
' commands in individual libra

recall as many command libr

To edit the command library
cpen the editor mode, Wher
click the 'E' again to return to

You can double-click the cor
the command to the current
and drop the command libra
bar if you wish to make any ¢

The Command Library widget also supports a right-click context menu that provides the same options.

Command Library x|
heEd 3
Comimand ipti

Lict dirgrtong

Copy

reboot]

. 1 Mew

gettinge | (& Open
E Save
@ Edit

'}@ View Toolbox

(The View Toolbox option will show and hide the toolbar in the Command Library widget.)

Edit Mode User Interface

When in the edit mode, the Command Library user interface will include a few more toolbar options and allow editing

of the commands in the data grid.



Command Library x|

DEE @ FHE

= Comimand
1k

I= -l

reboot

set-date

get-time

| en | e | | R

debug-on

help

Q| =~

Drescription

list directony

list directony maore info
reboot system

set the date & time
get the cument time
enable debugging

display help options

The additional Command Library widget options exposed in edit mode are listed below.

Name

Exit Edit Mode

Insert

Remove

Move Up

Move Down

Description

This option will exit the editing
mode and return to run-time mode.

Insert a new command row above
the current selected row.

Remove the selected command
row(s).

(Note that the entire row must be
selected. Click the numbered cell to
select an entire row.)

Move the selected command row(s)
up one position in the listing.

(Note that the entire row must be
selected. Click the numbered cell to
select an entire row.)

Move the selected command row(s)
down up one position in the listing.
(Note that the entire row must be
selected. Click the numbered cell to
select an entire row.)

The Command Library widget also supports a right-click context menu that provides the same options.



Command Library x|
ODEE @ FHE

# | Command Drescription

= 2 r

1f

2[ls Copy

3| reboat E Paste

4 set-date

5| get-time D Mew

G| debug-o ﬁ, GFIEH

T| help

g = save
[@ Close Edit
Add
|E| Remove
Movwe Up
Mowe Down
'}'@ View Toolbox

b‘#l—
(The View Toolbox option will show and hide the toolbar in the Command Library widget.)

Double-Click to Send

You can double-click a record in the command library and the command text will be transmitted to the connected
device/host in the active terminal session.

Drag & Drop

The Command Library widget supports drag-and-drop.
You can select a record in the command library and drag the entry to the command bar to stage the command text.

Session Menu

You can select a block of text in the session data window and then use Add to Command Library option in the sessi
on menu to add the selection as a new record in the Command Library widget.
(The new command library record will only be added if it does not match an existing record.)



Seszion |

. Connection r

Terminal Emulation Mode Alt+F2

C Repeat Last Transmission Ctrl+5pace

,“’l Selected Text b | B2 Send to Active Session Ctrl+D
@ Clear Session Data = Fﬁ Send to All Open Sessions

"™ Clear Data Above Selected Line bm Send to Command Bar Ctrl+B
X Clear Command Buffer F& ﬁ Send to Data Converter

% Resume New Line Tracking

[A] Data Format ] Add to Command Library

{:} Reboot

[Eﬂ] Broadcast Send Commands
lﬁ Log Data To File
bl Local Echo

Il PauseIncoming Data

&® Transmit Control Code r
Syntax Color Filter L
Session Properties Fa

Session Toolbar

You can enter command text into the command bar and then use session toolbar to add the selected text as a new
record in the Command Library widget.
(The new command library record will only be added if it does not match an existing record.)

:@ M ‘1"‘ |hellc: world ﬂ } v| . - |E| Ir

ﬁ 1 Telehack P2 Send to Active Session

ny .
<TELNET telehack com = PL Send to All Open Sessions

M Send to Data Conwverter

+0 Add to
HU Add to Command Library

+[El Add to Command Repeater

Session Context Menu

You can select a block of text in the session data window and then use the right-click session context menu to add
the selection as a new record in the Command Library widget.
(The new command library record will only be added if it does not match an existing record.)
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@ Clear Session Data b Send to Command Bar
™" Clear Data Above Current Line BE] Send to Data Converter
= Clear Command Buffer N
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Copy "Bl Addto Command Repeater
E Paste
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Variable Manager

Overview

Indigo includes a variable replacement feature that allows you to define a set of variables whose values can be
substituted in command data when it is submitted to the connected device/host.

Indigo provide a Variable Manager widget tool that allows you to define collections of these replacement variables
and define their substitution values.

Variable Manager x|
M oEeE 3

Varisble Walus

NUM 3

USERNANE
FASSWORD qaerty

COUNT 44




Tip

For information on how to use command variables with your terminal session, please click here.

View Menu

The Variable Manager widget can be displayed using the View Menu.

Session List Bar

Status Bar
Session Manager Ctrl+F1
Command Library Ctrl+F2
Data Converter Ctrl+F3

e —CurlF4
Wariable Manager Ctrl+F5 T
ul

Recent Sessions Toolbar
Window States Toolbar
Macros Toclbar
Find / Search Toolbar

Line Mumbers Ctrl+I
Line Highlight Ctrl+T

Widget Docking, Pinning, Re-sizing
Widget docking, pinning, re-sizing, etc information is listed here.

User Interface

The Variable Manager user interface consists of a grid listing of replacement variables with a single options toolbar.

aabie M =
M oO=Ed 3

Varisble | value |
NUM 3

FASSWORD qerty

GOUNT 44

The Variable Manager widget options are listed below.

Name Description



| X Enabled This option will globally
enable/disable the variable
replacement feature.

0 New This option will prompt the user to
create a new variable replacements
data file.

= Open This option will prompt the user to

select and existing variable
replacements data file.

When a file is selected the Variable
Manager widget will refresh and
display the contents of the newly
selected file.

= Save This option will prompt the user to
save the current variable
replacement data file.
(The current variables data file is
automatically saved when the
Indigo application is closed.)

E | Edit This option will switch the Variable
Manager widget into edit mode.
Edit mode will allow adding and
editing variable replacements in the
variables listing.

The Variable Manager widget also supports a right-click context menu that provides the same options.

Variable Manager x|
DeEd 3@

Variable
MNUK

_ Enabled
Copy
[ Mew
= Open
E Save
[H Edit

% View Toolbox

RASS
COUNE

P L [ ¢

(The View Toolbox option will show and hide the toolbar in the Variable Manager widget.)

Edit Mode User Interface

When in the edit mode, the Variable Manager user interface will include a few more toolbar options and allow editing



of the replacement variables in the data

Variable Manager x|

DEE @ &#HE

# |V\ariable Value
1| NUM 3
2| USERMNAME jdo=
3| PASSWORD qwerty
4| COUMNT 44
5

grid.

The additional Variable Manager widget options exposed in edit mode are listed below.

Name

Exit Edit Mode

Insert

Remove

Move Up

Move Down

Description

This option will exit the editing
mode and return to run-time mode.

Insert a new variable replacement
row above the current selected row.

Remove the selected variable
replacement row(s).

(Note that the entire row must be
selected. Click the numbered cell to
select an entire row.)

Move the selected variable
replacement row(s) up one position
in the listing.

(Note that the entire row must be
selected. Click the numbered cell to
select an entire row.)

Move the selected variable
replacement row(s) down up one
position in the listing.

(Note that the entire row must be
selected. Click the numbered cell to
select an entire row.)

The Variable Manager widget also supports a right-click context menu that provides the same options.



Variable Manager £l
M NEHdE HE B
£ |Variable [ value |

HWUM T
[# Enabled

Copy
E Paste
[ Mew
= Open

E Save

@ Close Edit
Add

|E| Remowve

Move Up
Move Down

'}@ View Toolbox

(The View Toolbox option will show and hide the toolbar in the Variable Manager widget.)

Double-Click to Send

You can double-click a record in the variable manager and the variable replacement token (name) will be appended
to the text in the command bar.

Drag & Drop

The Variable Manager widget supports drag-and-drop.
You can select a record in the variable manager and drag the entry to the command bar to stage the variable in the
command text.

Session Properties

The variable replacement feature can be enabled/disabled in the terminal Session Properties editor under the Advan
ced tab.



—Sezsion Settings

Mutt-Command If Variable Replacement is enabled
Internal Commands and the Variable Manager is set to
‘ariable Replacement active, the session command
Advanced Send Commands interpreter will replace any variables

D Farce Window Maximized in tlhe Tc_:-l:rmrr1'.|.:larln1:.| s;]t;nﬂ with the actual
value from \faria anager.

vw| Command Buffer

Reboot Sequence ‘ariables are enclosed in square

T braces to denote that it is a variable.
Terminating Character {ie. [VAR])

[] Auto Line Wirap

[[] Post Proceszsing Script
[] keep Alive

Character & Line Delay
[] Timestamp

MOTE: The VWariable Manager tool must
be =et to active for variable
replacements to work !

Command Repeater

Overview

Indigo supports a Command Repeater widget tool that allows you to define collections of commands and variables
that you can use to send repeated commands to a connected device/host.

This is particularly useful is you want to send one or more commands repeatedly for testing or for querying a
device/host.

You can also include dynamic variables in the repeated commands where the variable substitution can be updated
via a mathematical expression on each repeat cycle.

Command Repeater
NEE 3 @ »En

Qﬂmmandsw ‘ariables 1
Enabled | Command | Description
time

View Menu

The Command Repeater widget can be displayed using the View Menu.



Session List Bar
Status Bar
Session Manager Ctrl+F1
Command Library Ctrl+F2
I""'-.-_Re[:lnaleter Ctrl+F4

Quick Connect Toolbar

Recent Sezsions Toolbar

Window States Toolbar
Macros Toclbar
Find / Search Toolbar
Line Mumbers Ctrl+I
Line Highlight Ctrl+T

Widget Docking, Pinning, Re-sizing

Widget docking, pinning, re-sizing, etc information is listed here.

User Interface

The Command Repeater user interface consists of a grid listing of commands and variables with a single options
toolbar and a status bar.

Command Tab Variables Tab
‘Command Repeater x ‘Command Repeater
DEE B @ MEN DEE B @ MEN

{_:umrmnds} Variables | Commands | guriahleﬂ

time COUNT
N
ratry

LOOP

VAR

VARZ
3

|
EI

The Command Repeater widget options are listed below.

Name Description

0O New This option will prompt the user to
create a new command repeater
data file.



T8

Open

Save

Edit

Configure

Start

Stop

Pause

This option will prompt the user to
select and existing command
repeater data file.

When a file is selected the Comman
d Repeater widget will refresh and
display the contents of the newly
selected file.

This option will prompt the user to
save the current command repeater
data file.

(The current command repeater
data file is automatically saved
when the Indigo application is
closed.)

This option will switch the Comman
d Repeater widget into edit mode.
Edit mode will allow adding and
editing commands on the command
tab.

Tip

Existing variable
replacement
values can be
edited even
when not in edit
mode.

This option will open the Command
Repeater run-time settings

This option will start/resume
sending commands from the Comm
and Repeater to the active terminal
session.

This option will stop sending
commands from the Command
Repeater to the active terminal
session.

This option will pause/resume
sending commands from the Comm
and Repeater to the active terminal
session.

The Command Repeater widget also supports a right-click context menu that provides the same options.



‘Command Repeater
DEE 3 @ pEl

(_:umrmndﬂ Variables |
Enabled | Command | Description

Copy

1 Mew
= Open
. Save

@ Configure Repeater Settings
A Edit
’ Start Repeater

Stop Repeater

“ Pause Repeater

2% View Toolbox

(The View Toolbox option will show and hide the toolbar in the Command Repeater widget.)

Edit Mode User Interface

When in the edit mode, the Command Repeater user interface will include a few more toolbar options and allow

editing of the commands in the data grid.

Command Tab

‘Command Repeater x|
NEE B @ HE &G

{_:nmrmnds} Variables |

time
date

retry

Variables Tab

DER E B EE EE

Commands Lhriahles}

COUNT O+ o
LOOP 1+ 1
VART 0+ o
VARZ 0+ .
O 0+ 0

The additional Command Repeater widget options exposed in edit mode are listed below.

Name

Description



E| Exit Edit Mode

Insert

(=] Remove
Move Up
Move Down

This option will exit the editing
mode and return to run-time mode.

Insert a new command row or
variable replacement row above the
current selected row depending on
which tab is selected.

Remove the selected command
row(s)or variable replacement
row(s) depending on which tab is
selected.

(Note that the entire row must be
selected. Click the numbered cell to
select an entire row.)

Move the selected command row(s)
or variable replacement row(s) up
one position in the listing depending
on which tab is selected.

(Note that the entire row must be
selected. Click the numbered cell to
select an entire row.)

Move the selected command row(s)
or variable replacement row(s)
down up one position in the listing d
epending on which tab is selected.
(Note that the entire row must be
selected. Click the numbered cell to
select an entire row.)

The Command Repeater widget also supports a right-click context menu that provides the same options.



Command Repeater x|
DEEd @ @ BE R
gummandsw ‘g‘hriahles-}

Enabled | Command | Description

time
=

Copy
E Paste
[ Mew
= Open

H Save

@ Configure Repeater Settings
[@ cClose Edit

Add

|E| Remowve

Move Up
Move Down

'}@ View Toolbox

(The View Toolbox option will show and hide the toolbar in the Command Repeater widget.)

Run-time Settings

The Command Repeater includes run-time configuration options to determine the repeater behavior.
Use the @ Configure Repeater Settings option to access this dialog.

m
—Playback Mode ———— —~Timing

{~ Continicus Playback
{* Fixed Playback

{* Send next command on time interval:

Delay (ms): | 1000 ==

" Send next command on data received:

— Cycle Function

& On each cycle, send

) ) Data RX: | |
entire command list.

On each cycle, send
© next list entry % of | 3 =

3 total commands in list

[V Reset Cycle Index

— Target Session

# of Cycles:

{* Send commands to active session.

{" Send commands to all sessions.




Playback Mode

Continuous Playback

Fixed Playback

Cycle Function

On each cycle, send entire command list

On each cycle, send next list entry

Reset Cycle Index

Number of Cycles

Timing

Send next command on time interval

Delay (ms)

Send next command on data received

Data RX

Number of

Target Session

Send commands to active session

If this option is selected, the Command Repeater will
iterate over the defined command listing and then
continually start over and repeat the listing.

If this option is selected, the Command Repeater will
iterate over the defined command listing once and then
stop.

If this option is selected, the Command Repeater will
iterate over the defined command listing and transmit
all the commands during each repeater cycle.

If this option is selected, the Command Repeater will
iterate over the defined command listing and transmit
only one command during each repeater cycle.

If this option is selected, the Command Repeater will
reset the repeat cycle index counter when the targeted
number of repeat cycles have been reached.

If the Reset Cycle Index option is selected, then this
field will be used to define the number of cycles at
which to reset the repeat cycle index count.

If this option is selected, the Command Repeater will
initiate the repeater cycle based on a user defined time
interval.

If the Send next command on time interval option is
selected, then this field will define the number of
milliseconds for the time cycle delay interval.

If this option is selected, the Command Repeater will
initiate the repeater cycle only over having received a
specific target data string.

If the Send next command on data received option is
selected, then this field will define the target received
data string to watch for.

If the Fixed Playback option is selected, then this field
will be provided to define the number of repeat cycles
the Command Repeater should invoke.

(Note that if the reset cycle index option is enabled,
then it could affect the total number of cycles that will
be repeated.)

If this option is selected, the Command Repeater will
transmit its data commands to only the selected/active
terminal session.



Send commands to all sessions

Variable Cycling

If this option is selected, the Command Repeater will
transmit its data commands to all open and connected
terminal sessions.

The Command Repeater can perform a simple mathematical equation on a variable expression on each repeater

cycle.

Command Repeater

NEE 3 @ >

Commands | Variables

Enabled | \ariable
COUNT
LOOP
VAR1T
WARZ
a3

K &I & & &

Start

+ + + + o+

Operator

Cyclic

%]

Current

L= == = I = |

. Ready

The following fields for a replacement variable row defines the variable properties and mathematical equation

properties.

Name

Enabled

Variable

Start

Operator

Cyclic

Current

Description

This option allows you to enable/disable specific
variables.

This field defines the variable replacement name/token.
To embed a variable in command data, please see Co
mmand Variable Replacement

This field defines the seed value or initiating start value
that the variable will be assigned when the Command
Repeater cycle starts.

The variable value will always be rest to this start
value when the Command Repeater is re-started.

This field defines the math operation to perform on
each repeater cycle. The Command Repeater can
perform addition, subtraction, multiplication, and
division.

This field defines the operand value to use in the
equation on each repeater cycle.

This field displays the current value derived from the
equation after each cycle.

The mathematical equation is applied to each variable on each repeater cycle .



Expression
CURRENT = START

FOR EACH CYCLE

{
CURRENT = CURRENT [+|-|*|/] CYCLIC

Tip

You can pause the Command Repeater and modify a variable's current value, operator, cycle
operand, etc. and resume the repeater cycle.

Tip

You can also use variables defined in the Variable Manager with commands listed in the Comma
nd Repeater.

Double-Click to Send

You can double-click a record in the commands tab of the Command Repeater widget and the command text will be
transmitted to the connected device/host in the active terminal session.

Drag & Drop

The Command Repeater widget supports drag-and-drop.
You can select a command record in the command tab of the Command Repeater widget and drag the entry to the c
ommand bar to stage the command text.

Session Menu

You can select a block of text in the session data window and then use Add to Command Repeater option in the ses
sion menu to add the selection as a new command record in the Command Repeater widget.
(The new command record will only be added if it does not match an existing record.)



Seszion

. Connection

Terrminal Emulation Maode

E Repeat Last Transmission

K Selected Text

@ Clear Session Data
M Clear Data Above Selected Line

B Clear Command Buffer
|E| Data Format

{:} Reboot

4=_' Pas= Maode

[[jL]] Broadcast Send Commands
& Log Data Te File

bl Local Echeo

Il Pauselncoming Data

&# Transmit Control Code

Syntax Color Filter
session Properties

m Transmit Break Signal — (Ctrl+Break)

Alt+F2
Ctrl+5pace
b|| B2 Send to Active Session Ctrl+D
= Fﬁ' Send to All Open Sessions
b= Send to Command Bar Ctrl+B
F& ﬁ Send to Data Converter

3 % Add to Command Macros

Session Toolbar

You can enter command text into the command bar and then use session toolbar to add the selected text as a new
command record in the Command Repeater widget.
(The new command record will only be added if it does not match an existing record.)

&3 - 3 |hellc: world|

Session Context Menu

-]

b B -E
P Send to Active Session
Bi Send to All Open Sessions

PEl Send to Data Converter

+HH Add to Command Macros
+@O Add to ibra

+[El Add to Cormnmand Repeater >
o —

You can select a block of text in the session data window and then use the right-click session context menu to add
the selection as a new command record in the Command Repeater widget.
(The new command record will only be added if it does not match an existing record.)
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Tools
Indigo Internal Commands

Overview

Indigo includes a set of internal commands and an internal command processor that can perform various application
tasks.
Internal commands are invoked by sending the internal command instruction to a terminal session.

All internal commands (except the cls command) start with a color character.

Internal commands can be included and sequenced in multi-commands.

Internal Commands
The following list includes the internal commands that Indigo supports.

Internal Commands



- cls > clear screen -
- :help : display internmal command listing -
- 7 : display internmnal command listing -
- :d : disconnect session -
- e I connect session -
- Irc : disconnect, then reconnect session -
- It : toggle connection state -
- reboot : reboot session -
- echo <on|off=> : enablefdisable local echo -
- log : toggle session data logging onfoff -
- log:=logfile= - start logging data to specified log file -
- Imacro:<macro #:= I execute a macreo by macro number -
- :tileh : tile windows horizontally -
- tilew D tile windows vertically -
- :cascade o cascade windows -
- maximize D maximize session window -
- minimize I minimize session wWwindow -
- properties - edit session properties -
- launch:=<=filename> : launch a file -
- web : open web browser to current address -
- web:=zaddress:> : open web browser to speficied address -
- close . close session -
- closeall > close all open sessions -
- exit D oexit program -
- -about : display about dialog -
- helpfile : display Indigo's help file -
- break : send BREAK =signal to R5232 session -
- p:=milliseconds=> : pause remaining commands {(non-blocking} -
- s«<milliseconds> : sleep remaining commands (blocking) -
- @=script.function= o execute VBScript method inm script file -
- lescript.function= : execute method in post processing script -
- =<s5cCcipt code> o execute WBScript code -
- txtextfile:<filename> : tranmsmit text file (ASCII) content by line -
- txrawfile:=filename= : transmit raw file (BINARY} content -
1
Tip

You can send the ": hel p" or": ?" command any time in a terminal session window to display
the listing of available internal commands.

Examples
Example clear the session data window
Command cls
Example Transmit the serial break signal
Command . break
Example Enable logging for the terminal session
Command ;1 og
Example Perform the custom reboot sequence.
Command : reboot
Example Transmit the contents of an ASCII text file

Command txtextfile:<fil enane>



Example

Command

Example

Command

Example

Command

Example

Command

Session Properties

Enable the local echo feature for the session

:echo on

Transmit command macro #2
> macro: 2
Send two commands separated by a 3 second pause

delay
(This example uses the multi-command syntax)

command- one| : p: 3000| conmand- t wo
Send a "quit" command, close the connection, wait 15

seconds and then reconnect
(This example uses the multi-command syntax)

quit]:d]:p:15000|:c

The Internal Commands feature can be enabled/disabled in the Advanced tab of the Session Properties editor.
If the internal command processor is interfering with your terminal session, then you can disable it for the terminal

session.

Session Settings

Mutt-Command

Variable Replacement
Advanced Send Commands
[] Force Window Maximized
Command Buffer

Reboot Sequence
Terminating Character

[] Auto Line Wrap

D Post Processing Script
[] keep Alive

Character & Line Delay
[] Timestamp

Macro Commands

Overview

Indigo provides an extended set of
command functions buitt into the
command interpreter. If this option iz
eanbled, you can include these
commands in macros, command
library entrieg, etc. Fora full list of
internal commands, type ™ .7 " at the

session command line.

Indigo supports a Macro Command feature that allows the storage of commonly used instructions commands.
These commands are made easily and conveniently accessible via assigned hotkeys, the macro menu and the



macro toolbar.

When a macro is selected the Macro Command will be send directly to the connected device/host in the active
terminal session window.

Macro Command Toolbar

Command macros can be accessed using the Macro Command Toolbar.

The Macro Command Toolbar can display up to 10 icons for the top ten macros.
However, you can use the drop down button to access up to 20 macros as well as the Macro Menu.

Macres - (I EHEEBEHEBEHEEBEDOE

Date
Tirne
IP Info
LS

PS

Test Command 1

Test Command 2

Test Command 3

w o o~omm s L P

. Test Caommand 4
10. Test Cammand 5

ﬂ Edit Macros Chrl+t

Macros Menu

Command macros can be accessed using the Macro Menu.

Macro

1. Date

2. Time

3. IP Info

4, LS

5. P5

6. Test Command 1
7
8
9

. Test Command 2

. Test Command 3

. Test Command 4
10, Test Command 5
test

'}@ Edit Macros Ctrl+M

Macro Command Editor

Command macros can be created and edited using the Macro Command Editor.



Macro Editor
[ Mew (& Open Alternate

# | Enabled Macro Command

==

i date

2 time

3 ifconfig
4 -3

5 ps

[ test-1
7 test-2
8 test-3
g test-4
10 test-5
11 test
12| O

B8 = M ot o L =

|E| ECIDSE

Name

. Date

Time:
IP Info
LS
Ps

. Test Command 1
. Test Command 2
. Test Command 3
5.

Test Command 4

10. Test Command S

test

The Macro Editor can be access from the Macro Menu or the Macro Toolbar.

Using the command Macro Editor, you can create and manage the command macros using the following options.

T8

[+]

[1]

Option

New

Open Alternate

Insert

Remove

Move Up

Move Down

Description

Create a new user macro command
data file.

Open an alternate existing user
macro command data file.

Insert a new command macro row
above the current selected row.

Remove the selected command
macro row(s).

(Note that the entire row must be
selected. Click the numbered cell to
select an entire row.)

Move the selected command macro
row(s) up one position in the listing.
(Note that the entire row must be
selected. Click the numbered cell to
select an entire row.)

Move the selected command macro
row(s) down up one position in the
listing.

(Note that the entire row must be
selected. Click the numbered cell to
select an entire row.)



% Close Close and save the command
macro data file.

Session Menu

A Macro Command can be added to the macro listing by selecting text in the session data window and then using
the Add To Command Macros option via the Session Menu.

Seszion |

. Connection r

Terminal Emulation Mode Alt+F2

C Repeat Last Transmission Ctrl+5pace

,“’l Selected Text b | B2 Send to Active Session Ctrl+D
@ Clear Session Data = Fﬁ Send to All Open Sessions

"™ Clear Data Above Selected Line bm Send to Command Bar Ctrl+B
X Clear Command Buffer F& ﬁ Se

G Resurne Mew Line Tracking Fi :_IET Add to Command Macros J
[A] Data Format L B -

{:} Feboot YE Add te Command Repeater

[Eﬂ] Broadcast Send Commands
lﬁ Log Data To File
bl Local Echo

Il PauseIncoming Data

&® Transmit Control Code r
Syntax Color Filter L
Session Properties Fa

Session Context Menu

A Macro Command can be added to the macro listing by selecting text in the session data window and then using
the Add To Command Macros option via the session right-click context menu.
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[ 1Telehack -8 x
<TELMET telehack.com =

Session Toolbar

A Macro Command can be added to the macro listing by entering command text into the Command Bar and then
using the Add To Command Macros option via the Session Toolbar.

& - [ <[y EEE
ﬁ 1 Telehack P2 Send to Active Session

L H
<TELNET telehack com = PL Send to All Open Sessions

ME Send to Data Conwverter
g e

[l Add to Cormmand Macros

+[El Add to Command Repeater

Internal Command

Command Macros can be invoked using the Internal Command syntax.

Example Transmit command macro #2



Command > nmacro: 2

ASCII Chart

Overview

Indigo includes a series of ASCII tables and charts for quick and convenient reference.
Click the F12 hotkey anytime in Indigo to display the ASCII charts.

Tools Menu

The ASCII Chart tool can be accessed via the Tools Menu.

Tools

ata OoNVErsion Cor

A ASCI Chart F2 D
n-‘.“!ﬂ'E-l'“fnr _-____,_.-""'
Window States [
l"' Send/Upload File ... Alt+Ctrl+5
'El Receve/Download File ... Alt+Ctrl+R

B Transmit Text File (ASCI BY LIME)
E’ Transmit BEaw File (BINARY)

Transmit Raw File (THROTTLE) Ctrl+R
Refresh Available Com Ports Shift+F12
Refresh Available Modems Ctrl+F12

ASCII Table

The following ASCII reference table is provided in the Indigo ASCII Charts.



7 ASCI Chart =R =

ASCII Table

Simple ASCII Extended ASCII Flain Text Chart =

Decimal Octal Hex Binary Character Description

0 0 00 00000000 NUL

1 1 01 oo000001 SOH start of header

2 2 02 00000010 STX start of text

3 3 03 ooooo011 ET end of text

4 4 04 oo000100 EOT end of transmission

5 5 05 00000101 ENQ  enquiry

6 6 06 00000110 ACEK acknowledge

7 7 07 oo0000111 BEL bell

8 10 08 ooo01000 BS backspace

0 11 09 oo001001 HT horizontal tab

10 12 0A 00001010 LF line feed

11 13 0B ooo01011 VT vertical tab

12 14 OC oo001100 FF form feed

13 15 0D ooo01101 CR carriage return

14 16 OE oo0001110 SO shift out i

Simple ASCII Chart

The following ASCII reference chart is provided in the Indigo ASCII Charts.



§t ASCI Chart == ol ="
*
Simple ASCII
ASCI Tabls Extended ASCII Flsin Text Chart
Dec Hex Char Dec Hex Char Dec Hex Char Dec Hex Char
[ o [ 32 =0 Space 64 40 @ S5 B0
1 01 Start of heading 33 i | 6.5 AR A 97 681 a
2 02 Startoftext T4 P g 42 B 95 6z b
3 03 Endoftext 35 23 # 67 43 C 99 B3 cC
4 04 Endof transmit Ig 24 % 65 44 D 100 w4 d
5 05 Enguiry 37 RS & 69 45 E 101 &5 e
& 06 Acknowledge 38 =26 & 70 48 F 102 66 £
707 Audible bel 35 S ! 71 47 G 1053 67 g
g 08 Backspace 40 28 72 458 H 104 63 h
S 0% Horizortal tab 41 SRR ) TS ARl EE T 105 692 i
10 0OA Linefeed 47 SEA 74 4A J 106 6BA ]
11 0B “erdicaltah 43 BEEHE -+ 75 4B K 107 6B k
12 0C  Form feed 4 SR 76 4C L 108 6C 1
13 0D Carriage return 4 5 SRS — TS 1T 102 a6l m E
14 0OE Shift out 4 AR 75 4E N 110 6E n
15 0OF Shiftin 477 G 79 4F 0 111 BEEES o
16 10 Datalink escape 45 30 0 80 50 P 112 70 np
17 11 Device control 1 49 31 1 815 =i O 113 IS cf
18 12 Device control 2 SO 2 82 8EEEa R 114 BEate S
19 13 Device contral 3 S-1 i 3 83 SEEEEN 5 115 S =
20 14 Device control 4 bz Begd e 4 54 S T 116 BEEETE
21 15 Meq.acknowledge R T B 558 =Ee U 117 Bt 11
22 16  Synchronous idle 54 36 o &g 58 W 118 76w
23 17 Endtrans. block S5 R 7 g7 57 W 119 A 17
24 18 Cancel 56 3§ 8 g8 58 X 120 78 =
25 18 Endof medium 57 i O A=k sl B 121 BERZER 7
26 1A  Substitution 55 3A 90 5a Z 122 B =
27 1B Escape hel G e 91 BELEEN [ 123 BNEEEE |
28 1C  File separator 60 3IC < 02 BEEE Y 124 BEEIE |
28 1D Group separatar ] SRR = =Res. i N 125 BB
30 1E Fecord separstor 62 3E > 94 EE * 126 JE ~
31  1F  Unit separator 5.3 G R ) 95 5F 1277 ENEEEE [
ASCI Tabls Extended ASCII Flsin Text Chart

Extended ASCII Chart

The following ASCII reference chart is provided in the Indigo ASCII Charts.




(o & ]S

§t ASCI Chart
Extended ASCII
ASCI Tabls Simple ASCII Flsin Text Chart
Dec Hex Char Dec Hex Char Dec Hex Char Ilec Hex Char
izg &0 C i60 A0 & iz co L 224 EO o
129 81 1 i61 A1 i 193 1 L 225 ELlL B
130 82 & i62 A2 & 194 ©zZ T 226 EEE T
131 83 & 163 A3 10 185 Ccz } 227 (K I 11
132 84 a i64 A4 £ 196 ©C4 — 228 E4 ¥
133 85 a 165 A5 W 197 ©5 + 229 E5 o
134 86 & i66 Al = 198 ©s F 230 E6 n
135 H S 167 DA © i c7 |} 231 BEETE 1
136 88 & 168 A8 ¢ zpo £ L 232 E8 9
137 89 & 169 A9 -~ 201 €9 § 233 E9 o
138 B8A & 170 AA 2Dz ca &L 234 EA ©
130 BNEEN 1 i71 AB * 203 CB g 235 EB &
140 8BE i 172 AC W 2o £ |k 2356 EC =
i41 8D 1 173 AW 205 Cp = 237 ED =
142 8E 4 174 AE « zZos CE 238 EE ¢
143 8F A& i75 AF = 207 CF <+ 239 EF 1N
144 90 FE 176 BE 5 zos Do 1L 240 FO =
145 91 = 177 Bi 209 D1 T 241 Fl: +
146 92 & 178 B2 B 210, Dz g z4z F2z =z
147 83 & i79 B3 | 211, bz L 243 F3 =
148 94 o 160 B4 212 Da L 244 F4 |
149 85 & i1 BS A 213 b5 F z45 F5 |
i50 96 i igz Be 1| 214 D6 245 F6 =
151 87 10 183 B7? g zi15' b7 ¢ 247 F7 =
i52 98 ¥ i64 B& 35 zis D8 ¥ 245 Fg °
153 83 O 165 Bg 4 z17. Do 249 FS -
154 BSA O ige Ba | 218 DA 250 FA
i55 8B < 187 BB 5 zis DB HB 251 FB
i56 8C £ igg BC 4 220 DC g 252 FL =
157 8bh ¥ 12 BD 1 zz1 DD | 253 BEETE =
i58 BSE E igo BE 4 zzz DE | 254 FE ®W
159 SF F 191 BF 4 223 DF ®W 255 FF O
ASCI Tabls Simple ASCII Flain Text Chart

s

m

ASCII Plain Text Reference

The following ASCII reference document is provided in the Indigo ASCII Charts.




% ASCT Chart

1=
in
%]

000
001
ooz
003
004
005
00&
oo7
008
005
010
011
01z
013
014
015

0le
017
018
01s
020
021
D2z
023
024
025
026
027
0zg
029
030
031

032

Il Tabls

Oct

000
001
002
003
004
005
00&
007
010
011
012
013
014
015
0l1le
17

020
0zl
ozz2
023
024
025
0zZa
027
030
031
032
033
034
035
036
037

040

ASCIl Plain Text

Simple ASCII

Hex Binary Ascii Char/Control Code

0a
01
oz
03
04
05
0a
o7

=]
o

09
0n
0B
oc
oD
0E
oF

10
11
1z
13
14
15
1a
17

=3
[a]

18
1z
1B
1c
1D
1E
1F

20

00000000 ~@ ~°

00000001
00000010
00000011
00000100
00000101
00000110
00po0111
00001000
00001001
00001010
00001011
00001100
00001101
00001110
00001111

00010000
00010001
00010010
00010011
00010100
00010101
00010110
00010111
00011000
00011001
00011010
00011011
00011100
00011101
00011110
00011111

00100000

i
“B
~C
~D
“E
~F
Gz
~H
~I
~J
K
L
M
N
-0

~B
Q
“R
~5
~T
~U
~V
W
~X
~Y
~Z
~l
N\
"1

kS

"a
b
o
~d
e
~f
g
~h
i
J

K
~1
“m
“n
o

~

LI I T »or »
woH Q'™

*

SRR

1
1
~}

e,

NULL NUL null c-@ o--

S0H GIL c-A c-a start-of-heading
S5TX c-B c-b =start-of-te=xt

ETX c-C c—-c end-of-text

ECT

50C end-of-transmission co-D c-d

ENQ PPC c-E c-e enguiry
ACK c-F c—f acknowledge
BELL BEL bell c-G c-g ha

BS

BET backspace c-H c-h ‘b

TAER TCT HT tab c-I c-i M\t

LF
VT
FF
CE
50
51

DLE
DC1
DCz2
DC3
DC4

1f linefeed c-J o-J “n
vertical-tab c-K oc-k ‘v

ff formfeed page “\f o-L c-1
cr carriage-return c-M c-m \r
c-N c-n shift-out

c-0 c—-o shift-in

c—-P c-p data-link-escape
LLO go XON xon o-0 co-Q
c-R c-r

stop XOFF xoff -5 c—=
DCL =-T c-t

HAE PPU negative-—-acknowledge co-U c—-u
S5YN c-V c—v syvnchronous-idle

ETE end-of-transmission-block c-W c-w
CAN SPE c-X c-x cancel

EM

5FD c-Y c-v end-of-medium

SUE =suspend c-Z c-z substitute
E5C ezscape c-[ c—{ m—

F5
=5
E5

field-=zeparator o-% o—|
group—-sSeparator
record-separator co-" c—-=

“DEL unit-separator U5 co—_ c-DEL

5PC space spc

Extended AS

1|

L

m

Custom Data Editor

Overview

Indigo include this tool providing users the ability to define their own custom data format.
Users can configure a session to render data bytes received using this custom data format.

Tools Menu

You can access the Custom Data Conversion Format Editor from the Tools Menu.




Tools .

(:@ Edit Custorn Data Conversion Enrm;:i) |
_H-EELL_LHEH: ——= F12

I] Syntax Celor Editor

Window States »
B Send/Upload File ... Alt+Ctrl+5
'E| Receive/Download File ... Alt+Ctrl+R

B Transmit Text File (ASCIH BY LIME)
E‘) Transmit Eaw File (BINARY)

Transmit Raw File (THROTTLE] Ctrl+R
Refresh Awvailable Com Ports Shift+F12
Refresh Available Modems Ctrl+F12

Custom Data Conversion Format Editor
The Custom Data Conversion Format Editor displays bytes from 1 to 255.

Each column represents a different display representation for the bytes.
You can select a cell to configure a byte's data representation.
The green highlighted cells indicate which data representation will be rendered for the data byte.

The Custom column allows users to enter their own text to be rendered for a data byte.
You can mix and match data format representations.



- =

\;’* Custom Data Editer (CA\ProgramDatatshadeBlug\IndigetConfighMy Cust... E'@
[ Mew [Z OpenAlternate | [ Close
DEC HEX OCT BIN ASCI CUSTOM -
1 1h 1 ooooaom <50H>
2 2h 2 ooo0oaot1a <5TK= E
3 3h 3 ooo0o0ao <ETX>
4 4h 4 00000100 <EQT=>
=) sh =) o001 <ENCG>
L &h L 00000114 <ACK= HACK !
7 Th 7 00000111 <BELL= << RING >
i &h 10 00001000 <B5=
G 8h 1 oooo10m <TAB> :
10 Ah 12 00001014 <LF= n
1 Bh 13 oooo101 <\T=
12 Ch 14 oo0011040 <FF=>
13 Dh 15 00011 <CR= \r
14 Eh 16 00001114 <50=
15 Fh 17 oooo1111 <5
16 10h 20 00010000 <DLE=
17 11h 21 oo0100m <DC1HON=
18 1Zh 22 00010010 <DCZ=
19 13h 23 ooo1a01 <DCIHOFF=
20 14h 24 00010100 <DC4DCL>
21 15h 25 001 <N AK=
22 16h 26 00010114 <5 M=
23 17h 27 00010111 <ETH=
24 18h 30 oo011000 <CNCL=
25 158h I 0o00110m <EN=
26 14h 32 00011014 <5UB> -

When your custom configuration is complete, click the Close button to save the custom data format.
(You can also create new custom data format files or open an alternate custom data format file using the toolbar
options.)

Example

The following screenshot is an example of data bytes 1 though 10 being rendered using the custom data
configuration shown below.

ﬁ Seri

1,02h,3,00000100,0,**? ACK *%?,{{{< RING >2>23,%\<, \t \n, j
. 4[_‘

@~ Al =l -BE-E




This is the custom data format configuration applied to this example.
Note that byte #5 could not be rendered because 0x05 (<ENQ>) is not a valid/render-able ASCII character.

.#* Custom Data Editor (C:\ProgramData\shadeBluehIndige’ ConfighMy Custo... E@
[ Mew [ OpenAlternate | [ Close
DEC HEX OCT BIN ASCI CUSTOM -
1 1h 1 oo00aom <30H=
2 2h 2 ooooao1a =5 =5TK=
3 3h 3 00000011 <ETK= <ETH=
4 4h 4 00000100 <EOT= <EOT=
3 Sh 3 0000t <ENG> | <ENQ=
L Gh L oo00a11a <ACK= HACK I
7 Th 7 0000111 <BELL= oo RING a0
i &h 10 00001000 <B5= =
G 8h 1 oo0010m <TAB= it
10 Ah 12 00001010 =L F= n o

Syntax Color Editor

Overview

In the Standard View Mode, Indigo supports a syntax coloring feature where you can define keywords that can be
rendered with one of three user defined colors.
This is a useful feature to help draw visibility/attention to targeted keywords and phrases.

User defined keywords and colors are configured in color syntax filters.
The Syntax Color Editor is used create and edit these syntax color filters.

© Note

Click here to learn more about applying a Syntax Color Filter to a terminal session window.

Syntax Color Editor

When the Syntax Color Editor is launched, you can choose to create a New syntax color filter or edit and existing
color filter.



Syntax Color Editor ]
[ Mew [ Close

— Open Exigting Color Syntax Template:

by 2nd Filker.izf

hu Cuztom Syntax Color. ist

Mew Open

After creating a new or selecting an existing color filter, the editor dialog will be displayed.

You can select from the various color options and define the foreground and background colors.
(To set a background color, you must uncheck the Default Background Color checkbox.)

In the botton portion of the Syntax Color Editor, you can define a list of keywords that you want to apply a color filter
to.
After adding a keyword, select from the three color options that you want to apply to that keyword.

When you have completed the desired configuration, click the Close button at the top of the dialog to save and close
the editor.



Ml

N Mew | £l Close
@ Cobr
= Color2
" Color 3 Foreground Color | Background Color |
{~ Strings
i~ Comment Blocks r Default
Background Color
[~ Enable String Syntax Coloring ¥ Enable Comment Syntax Coloring
String Delimiter: E Start Delimiter I
End Delimiter: 1

Color1 | Color2 | Color3

ERROR

exception
warning
Warn
attention

OO0000O0OREOOOR

OO00rROEOOOOXO
ORROOOOOR®OO

© The Syntax Color Editor also supports color filters for strings enclosed in a delimiter and
comments defined between a start and end delimiter.

Tools Menu

You can access the Syntax Color Editor from the Tools Menu.
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% Edit Custom Data Conversion Format

.

F12

Y

H J—
Syntax Color Editor
i —

D

Window States

[ send/Upload File ...
'E| Receive/Download File ...

H‘F Transmit Eaw File (BINARY)
Transmit Raw File (THROTTLE)

Refresh fwvailable Com Ports
Refresh Available Modems

[# Transmit Text File (ASCI BY LINE)

]

Alt+Ctrl+5
Alt+ Ctrl+R

Ctrl+R

Shift+F12
Ctrl+F12

Session Menu

You can access the Syntax Color Editor from the Session Menu.

Session |

. Connection

Terminal Emulation Mode

E Repeat Last Transmission
WM Selected Text

@ Clear Session Data
™" Clear Data Above Selected Line

BT Clear Command Buffer
|E| Data Format

{:} Reboot

[EE] Eroadcast Send Commands
& Log Data To File

1] Local Echo

Il Pause Incoming Data

&® Transmit Control Code

Ctrl+5pace

Alt+F2

]

F5

F&

| Syntax Color Filter

b| Mone

session Properties

F8 My 2nd Filter

Session Toolbar

BB syntax Color Editor

My Custom Syntax Color
e

You can access the Syntax Color Editor from the session toolbar menu.



ﬁ <QC=> telehack.com EI@
(TR It is 6:35 am on Saturday, June 2
(W There are 21 local my There ar
Type 7 for a command list.

Type HELP for a more detailed co
Type control-C to interrupt any

May the command line live forever.

Command, one of the following:

ac basic cal
dir eliza factor
help hosts ipaddr
newuser notes octopus
rand score starwars
units users| uupath
LD
@ Al > » -BE-@E
{:} Reboot
E Log Data Te File
}]]] Local Eche
" Pause Incoming Data
[[jL]] Broadcast Send Commands
& Transmit Control Code 3
| Syntax Color Filter >|
Edit Session Properties

None

My 2nd Filter

Session Context Menu

My Custom Syntax Color
Syntax Color Editor
_—

You can access the Syntax Color Editor from the session right-click context menu..



ﬁ <QC> telehack.com EI@

Disconnect

Repeat Last Transmission Ctrl+5pace
Selected Text 3
Reboot

Clear Session Data

Clear Data Above Current Line

Clear Command Buffer

Copy

Paste

Find Ctrl+F
Find Mext

Find Previous

Goto Line Ctrl+G

#2ERFOMSG IAERE

Data Format 3
Advanced >| {:} Reboot

2 Log Data To File
bl Local Echo

" Pause Incoming Data

[T] Broadcast Send Commands

i® Transmit Control Code 4
| Syntax Color Filter P| None
Edit Session Properties My 2nd Filter
My Custom Syntax Color
(_‘_—_ Syntax Color Editor 1]
o
& - | < B E

Window States

Overview

Indigo's provides a unique size and positioning feature called Window States.
Each Window State represents the position in the Indigo application on screen and the size of the Indigo application
window.

You can use this Window State feature to store and recall the Indigo application to specific sizes and locations on
screen.

The Window States can be accessed using the following options:

® Application Toolbar
® Tools Menu

Saving/Editing a Window State

There are five window state slot locations that you can store to.
Simply set the program window to the location on the screen and to the size that you like, then click the Save
Window State option on one of the menus or toolbars.



Window Statez -

n Windows 5tate 1
E Windows State 2
a Windows State 3
Windows State 4
E Windows State 5

[ Save Window State

A Windows State editor will be displayed allowing you to select the state number (1-5) and provide a state friendly
name.
You can also optionally choose if the Window State should persist both size and position or just size or position.

Window Size/Position (=]
Select Window State

State: Mame:
|1 ﬂ |‘.-'-.l'inu:|u:|x-.'5 State 1

v Window Size
[v Window Position

oK Cancel

When you have the configuration complete, click the OK button to save the Window State.

Application Toolbar

Windows States can be access form the Windows States Toolbar.

File Edit Wiew Toolr Session Maco  Window  Help
J %= Telnet = telehack. com = Nore = p J Window States
n Windows State 1

Sy [ . ‘windows State 2
B2 Sessions B ‘windows State 3
'&- cugtom scnpt session W?NdDWS State 4

=';] Localhost Session B “windows State 5

| [\r’lE:C;:lST: 55H [B 5 ave window State
elehac

ﬂ Test Sezsion

0
o
7
(%]
o
=]
=
@
=
o
-




Tools Menu

Windows States can be access form the Tools Menu.

Tools

b Edit Custom Data Conversion Format

A ASCH Chart F12
(1 | Syntax Color Editor /
(__ Window States __) H
EP Send/Upleoad File ... Alt+Ctrl+
'E| Receive/Download File ... A+ Crl+
[ Transmit Text File (ASCI BY LINE)
E" Transmit Baw File (BINARY)
Transmit Raw File (THROTTLE) Ctrl+R!
Refresh fvailable Com Ports Shift+F12
Refresh fvailable Modems Ctrl+F12

=

n Windows State 1
B Windows State 2
ﬂ Windows State 3
Windows State 4
E Windows State 5

@ Save Window State /

Scripting

Overview

Indigo supports the following scripting options:

® |n-Session Command Scripting
® Post Processing Scripts

In-Session Command Scripting

In-Session Command Scripting allows you to send commands to the terminal session using Internal Command synt

ax.

The following types of scripting methods can be invoked.

Description

Syntax

Example

Description

Syntax

Example

Description

Executes a script function from a named script file.
Transmit return data to connected device/host.

D @script-nane>. <script-function>
: @ost Processi ngSanpl e. For ceToUpper Case(

"hell o world")

Executes a script function from the currently configured
session Post-Processing script file.
Transmit return data to connected device/host.

:l<script-function>

: ' MyCust onfFuncti on()

Executes a VBScript code expression
Transmit return data to connected device/host.



Syntax : =<scri pt-code>
Example : =Host . Post ("Hel o Worl d")

Example :=UCase("hell o worl d")

Post Processing Scripts

Indigo supports a Post-Processing scripting feature that allows a user created script to analyze and modify data after
it has been received.

Post-Processing scripting enables you to execute a script function to process data received from a terminal session
before it is rendered to the screen.

To use this feature, Post-Processing scripting must be enabled and configured for each session in the Advanced tab
of the Session Properties editor.

Session Settings

Muli-Command Post-processing allows 1_..r|:|u to
Internal Commands perform u:u;tum prnce;slng on t.he
Variable Replacement data recevied in a terminal session.
p This post-processing feature enables
Advanced Send Commands customization via the use of a custom
E Force Window Maximized script file. (WBScript or JScript)
Command Buffer
Reboot Sequence
Terminating Character script Language:
Auto Line Wrap |‘-.fEl Script j
Post Processing Script o
D Keep Alive Script File:
Character & Line Delay |F‘-:|stF‘ru|:essingSﬂ mple.vbs j
[] Timestamp
Script Function:
| ForceTolUpperCase j
Test
Property Description
Post Processing Script This option must be checked before the session will
use Post-Processing scripting.
Script Language Select the scripting language used in the script file.
® VBScript
® JScript
Script File Select the script file to use.
(This script file must exist in the Scripts data directory.)
Script Function Select the desired script function to be invoked when

this terminal session receives data.



Test This button provides a simple option to test an
invocation of your script function.

In the example configuration above the "ForceToUpperCase" function is selected from the "PostProcessingSampl
e.vbs" script file.

The code snippet below illustrates this function.

Post-Processing Script Example

/] A Function wll allow you to specify the
return data

/1 which will get displayed to the session
data w ndow

Functi on ForceToUpper Case(ByVal sDat a)

‘//force all inconmm ng data to upper case
ForceToUpper Case = UCase(sDat a)
End Functi on

When this Post-Processing script function is enabled, all textual data received will be forced into upper case before it
is displayed on screen.
The screenshot below is an example of data received and displayed after being processed by this script function.



ﬁ Telehack E @

CONMWECTED TO TELEHACK FORT 33 —
FY
IT IS 9:12 AM ON SUNDAY, JUME 3. 2
THERE ARE 27 LOCAL USERS. THERE ARE

TYPE ? FOR A COMMAMND LIST.
TYPE HELF FOR A MORE DETAILED COM
TYPE CONTROL-C TO INTERRUPT ANY C

MAY THE COMMAND LINE LIVE FOREVER.

COMMAND, OME OF THE FOLLOWIMNG:

AC BASIC CAL
DIR ELIZA FACTOR
HELF HOSTS IPADDRE
NEWUSER NOTES QCTOPUS
RAMND SCORE STARWARS
UNITS USERS UUPATH
w
f
@ - | ~y -B-E

Script File Location

Script files should be placed in the "Scripts" directory under the Indigo Data Directory.

OS Version Directory Location
Windows XP C:\ Docunment and Settings\All
User s\ Appl i cati on Dat a\ shadeBl ue\ | ndi go\ S
cripts
Windows 2003 Server C:\ Docunment and Settings\All
User s\ Appl i cati on Dat a\ shadeBl ue\ | ndi go\ S
cripts
Windows Vista C:\ Progr anDat a\ shadeBl ue\ | ndi go\ Scri pts
Windows 7 C:\ Progr anDat a\ shadeBl ue\ I ndi go\ Scri pts
Windows 8 C:. \ Progr anDat a\ shadeBl ue\ | ndi go\ Scri pts
Windows 2008 Server C:\ Progr anDat a\ shadeBl ue\ | ndi go\ Scri pts
® info

The C:\ProgramData directory is hidden by default in Windows.

Examples
Indigo includes two files to help get you started with writing your own scripts.
(These files are both located in the Scripts directory referenced above.)

File Description



PostProcessingSample.vbs This script file includes a number of example
post-processing functions and event handlers.

Indigo Scripting Host API.txt This is a text document that defines the available
methods and events provided by the scripting "Host"
object.

@ f you are creating your own script functions, please create a new script file and do not create
your customization in the "PostProcessingSample.vbs" file.
This file may be automatically overwritten in Indigo version updates, thus losing your
customization.

Web Update

Overview

Indigo includes a web update feature to help you stay up to date with the latest version.

© Screencast

A screencast of the web update procedure is available. Click here to see the video.

Check For Updates
A Check for Updates using Web Update can be launched from the Help Menu.
Help
@ About

Indige Online Documentaticn Shift+F1

Check For Updates (Web Update) _)

Licen armation

Indigo will attempt to connect via your Internet connection to see is there is a newer version of Indigo available for
download.

-

(100%) Downloading.. ==

. v

Downloading Mwerzsion=3.0.149edition=profeszional
7A5FKB /7 45 KB

ENENRNNENNNNNNNEEE| _ cence

shadeBlue.com

No Update Available

If no updates are available, the following message will be displayed:



Indige Web Update @

. Mo updates are available at this time,
@' Please try again at a later date or check the shadeblue website for more
information.

http:/fwww.shadeblue.com

oK

Perform An Update

If an update is available you will be prompted to confirm if you want to close Indigo an perform the update.

-

Indigo Web Update £3

% An update is available!

I Would you like to download and install the program update now?

(Please note, selecting YES will immediately close Indigo and all open
sessions)

Yes | No

The Web Update utility will be started and display information about the available update.
Click the Update Now button to proceed with the update.

* Indige Web Update @
Indigo Terminal Emulator : BETA
Professional Edition D
3.0.134

shadeBlue
s s o ftwarae
: d == deBlue, L = h = hlue

The following udpates available for Indigo ...

Indigo.exe 12.0.135)
Indigo.exe.manifest

2 updated file(s) are available
- readme.tHt

Please note that updating may require an application reatart

Update Now Clos=

The Web Update utility will start downloading all the necessary update files.



W

Indigo Terminal Emulator BETA
Professional Edition
3.0.134

shadeBlue
shadeBlue, LLC s of it warae
Copyright £ shadeBlue, LLC 2011 Rilg.i/uw shagebiye com

9

Indigo. exa

Downlsading updated files

The Web Update utility will then install the downloaded update files.

Indigo Terminal Emulator
Professional Edition D
h

3.0.134

shadeBlue, LLC
Copyright £ shadeBlue, LLC 2011

-

Pleast Wait.....Installing Updates

nstaling Updales

When the update is complete, you will be prompted with the option to restart the Indigo application.

@ Do you want to restart Indige Terminal Emulator now?

Yes I Mo




0 Note

A web update of the Indigo software will require the application to be shutdown and restarted. In
some (rare) case you may be prompted to re-start the computer after a web update.

Program Preferen

Indigo includes a Program
The Program Preferences

ces

Preferences editor to configure global application settings.
editor can be accessed using the Edit Menu.

Please select from the options below for more information on the individual tabbed pages in the Program

Preferences editor.

Main Application Preferences
Session Global Preferences

Global Session Commands

Serial/Com Port Detection

Main Application Preferences

Overview

Indigo provides a number of customizable options and user preferences to personalize Indigo's behavior.

Program Preferences

Main Session

General

[v Allow muttiple insta

Form Memory

{* Enabled
" Disabled

Auto Resize

None
Horizontalhy
Wertically
Caszcade
Maximized
Last Known

RS R RO R

[v Display Splash Screen at Program Start
[+ Default Windows Telnet Client (telnet:Vaddress:port)

Bl

Global Commands Com Ports

nces of Indige to run simultaneocushy

Application Menu Font

Font Name: Arial
Font Size: 8
Font Bold: Falze
Font talic: Falze
Change Font Reset Font |

gr{|

Configuration Properties




The following configuration properties control the application launch, size, position and fonts.

Settings

Display Splash Screen

Default Windows Telnet Client

Allow Multiple Instances of Indigo

Form Memory

Auto Resize

Application Menu Font

Session Global Preferences

Overview

Description

If this option is enabled, Indigo will display a splash
screen each time Indigo is started.

(If running an evaluation copy of Indigo, the splash
screen will always be displayed.)

If this option is enabled, Indigo will register itself at the
default application handler for any URI request with the
telnet:// protocol handler.

If this option is enabled, you can launch multiple
instances of the Indigo application.

If this option is enabled, Indigo will remember the
application container's size and position on screen
between application launches.

If this option is set to a value other than None, then
each time a terminal session window is opened it will
automatically be resized based on this setting.

This option allows you to change the application menu
font to a user selected font name and size.

Indigo provides a number of customizable options to globally control terminal sessions.



Program Preferences [E]

Main Session Global Commands Com Ports

Last Session

[ Open Last Session at Program Start

Session Directory

|C:*.F‘rugra mOata\shadeBluelindigo\Sessions |

Restore Default Change |

Misc.

Change Default Session Properties |

gr{|

Session Preferences

The configuration options below control terminal sessions in Indigo.

Setting Description

Open Last Session at Program Start If this option is enabled, Indigo will automatically open
the last terminal session when the program is restarted.

Session Directory This option controls where Indigo will look to find its
session files that are displayed in the Session Manager

This option can be useful if you want to change where
Indigo stores its sessions such as on a network drive,
DropBox folder or other collaborative location.

Default Session Properties This option will display the Session Properties Editor
and allow you to make maodification to the default
session settings.

All new terminal sessions that get created use these
default session setting as the initial configuration
properties.

Global Session Commands

Overview

Indigo provides support for a global set of commands that can be optionally transmitted to a terminal connection
automatically upon connection.



Program Preferences [E]
Main Session Global Commands Com Ports

Global Sezsion Commands: fone command per ling)

command one -
command two

command three
command four

Each command should be listed on a separate line.

For more information on how to configure a terminal session to make use of these global commands, please see the
Custom Commands configuration under the Session Properties.

Serial/Com Port Detection

Automatic Com Port Detection

Indigo includes automatic serial port detection to provide a listing of available serial ports installed on the computer.
This detection populates the listing of available com ports in the Quick Connect toolbar and the Session Serial
Connection settings dialog.




Program Preferences

Main | Session | Global Commands | Com Ports

= B
O comz |:|
{~ Manually Select Com Ports Jcom 3
O com 4
O coms
Ocome
Ocom7
Ccoma
Ocomsg
Ccom 10
[ com 11
O com1z
O com13
Ccom 14
[ com 15
[ com 16 -

{* Auto Detect Available Com Ports

Manually Selected Com Ports

The automatic serial port detection routine works perfectly on the vast majority of serial ports; however, there are
rare occasions where this detection process does not properly detect certain com ports.

For these edge cases, Indigo provide the option allowing the user to manually specify which serial ports should be
displayed and made accessible in Indigo.



Program Preferences [E]

Main Session Global Commands Com Ports

Ld
(" Auto Detect Available Com Ports _

v COM 2 |
(* Wanualy Select Com Ports COM 3
v COM 4

COMS

COME

COMT

COM &

COMS

COM10

COM 11

COM12

COM13

COM 14

COM15

COM 18 -

Indigo Data Directory

Overview

When Indigo is installed and used all user data is persisted in a data directory.
This data directory contains the following Indigo data files:

Indigo Terminal Sessions 1

Indigo Program Preferences (user preferences)
Session Data Log Files

Command Libraries

Command Macros

Command Variables

Command Repeater Data

Custom Data Conversion Formats
Quick Connect Session Configuration
Syntax Color Files

Script Files

Web Update Log Files

SSH Connection Fingerprints

( 1. An alternate session file directory can be configured via Indigo Program Preferences.)

Location

The Indigo data directory is stored in the following location on the file system:



OS Version Directory Location

Windows XP C.\ Docunent and Settings\All
User s\ Appl i cati on Dat a\ shadeBl ue\ | ndi go
Windows 2003 Server C:\ Docunment and Settings\All
User s\ Appl i cati on Dat a\ shadeBl ue\ | ndi go
Windows Vista C:\ Progr anDat a\ shadeBl ue\ | ndi go
Windows 7 C:\ Progr anDat a\ shadeBl ue\ I ndi go
Windows 8 C. \ Progr anDat a\ shadeBl ue\ | ndi go
Windows 2008 Server C:\ Progr anDat a\ shadeBl ue\ | ndi go
@ Note

The C:\ProgramData directory is hidden by default in Windows.

Backup

If you want to backup all your Indigo data, the Indigo data directory referenced above is the most important directory
to backup.

Uninstall

A normal Indigo application uninstall will not remove this data directory. If you wish to permanently remove this
data, then make sure Indigo is uninstalled and then manually delete this folder and all its contents.

Video Tutorials (Screencasts)

This section lists the available screencast video tutorials for Indigo Terminal Emulator.

Please select from one of the following video tutorials:

Indigo Installation Screencast

© instructions

A step-by-step outline of the installation procedure with screenshots is available here: Installation

(Click on the video window above to play the video clip.)

If you cannot see the video, you can use the following link to view the video on screencast.com
http://www.screencast.com/t/45Nxakmgo

Licensing Screencast


http://www.screencast.com/t/45Nxakmgo

© Instructions

A step-by-step outline of the licensing and activation procedure with screenshots is available
here: Licensing

(Click on the video window above to play the video clip.)

If you cannot see the video, you can use the following link to view the video on screencast.com
http://www.screencast.com/t/FGOKh1Mi6Nw

Data Logging Screencast

© Instructions

Detailed instructions for session data logging along with screenshots can be found here: Session
Data Logging

(Click on the video window above to play the video clip.)

If you cannot see the video, you can use the following link to view the video on screencast.com
http://www.screencast.com/t/Am9IXGQBZ8

Web Update Screencast

© Instructions

Step-by-step instructions of the web update procedure along with screenshots are available here:
Web Update

(Click on the video window above to play the video clip.)

If you cannot see the video, you can use the following link to view the video on screencast.com
http://www.screencast.com/t/lus3SngYg

Data Converter Screencast

© instructions

Detailed instructions of the data converter tool with screenshots are available here: Data
Converter

(Click on the video window above to play the video clip.)

If you cannot see the video, you can use the following link to view the video on screencast.com
http://www.screencast.com/t/ZarDOR5b



http://www.screencast.com/t/FG0Kh1Mi6Nw
http://www.screencast.com/t/Am9XGQBZ8
http://www.screencast.com/t/Ius3SngYg
http://www.screencast.com/t/ZarD0R5b

Advanced Send Commands Screencast

© Instructions

Detailed usage instructions for this feature can be found here: Advanced Send Commands

(Click on the video window above to play the video clip.)

If you cannot see the video, you can use the following link to view the video on screencast.com
http://www.screencast.com/t/9PWIJbVUyWz

Terminal Emulation Screencast

© instructions

The terminal emulation options and listing of supported emulations are referenced here: Terminal
Emulation

(Click on the video window above to play the video clip.)

If you cannot see the video, you can use the following link to view the video on screencast.com
http://www.screencast.com/t/QajgydYTYoj

Quick Connect Screencast

© instructions

Instructions for the Quick Connect Toolbar along with screenshots are available here: Quick
Connect Toolbar

(Click on the video window above to play the video clip.)

If you cannot see the video, you can use the following link to view the video on screencast.com
http://www.screencast.com/t/aXOlzL DGy

Split Data View Screencast

© Instructions

Instructions for the Split Data Window along with screenshots are available here: Split Data
Window

(Click on the video window above to play the video clip.)

If you cannot see the video, you can use the following link to view the video on screencast.com
http://www.screencast.com/t/adBgcvI5IB

Session Data Byte Representations


http://www.screencast.com/t/9PWlJbVUyWz
http://www.screencast.com/t/QajgydYTYoj
http://www.screencast.com/t/aXOlzLDGy
http://www.screencast.com/t/adBgcvl5lB

© Instructions

Detailed instructions covering session data conversion with screenshots are available here: Sess
ion Data Formatting

(Click on the video window above to play the video clip.)

If you cannot see the video, you can use the following link to view the video on screencast.com
http://www.screencast.com/t/tRKKUTTO



http://www.screencast.com/t/tRKkUTT0
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